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THE MACINTOSH 

Care and 
Maintenance 

Tum the screen intensity down when 
you're not using the machine. This 
prevents images from burning in to the 
video tube. Using a program like Screen 
Saver accomplishes the same thing. 

Don't block the vents on the top or 
sides of the Mac, since it interferes 
with the circulation of cool air to the 
inside. Without adequate ventilation, 
the Mac might crash. 

Never touch the peripheral connector 
plugs, since the static electricity in 
your body can sometimes generate a 
short-out when the equipment is 
hooked up. 

Cleaning Your Disk Drive 

A strange, but effective, way to clean 
a disk drive is to use a Black & 
Decker DustBuster to vacuum out lint 
and dust. The nozzle fits perfectly, 
and the drive can be cleaned with two 
to four seconds of vacuum power. Just 
be sure the nozzle is clean when you 
insert it into the drive. 

Possible Problems: Screen 
Wavering 

If the Mac screen shimmers or seems 

MACINTOSH CARE AND MAINTENANCE 

to look unsteady, one of the ground 
wires on the CRT could be loose. Don't 
try to tighten it yourself, because CRT 
voltages are highly dangerous, even 
after the computer has been 
unplugged. Still, this is a pretty easy 
problem for an Apple dealer to fix, so 
the Mac shouldn't spend too much 
time out of commission. 

If you have installed a fan to cool the 
Mac and then experience screen 
wavering problems, remove the fan 
and then check to see if the screen 
looks any more stable. Some owners 
of the Fanny Mac cooling fan have 
reported some screen instability 
problems. If this is the case, don't 
reconnect your Fanny Mac. 

Frozen Cursor 

After an electrical shock to your Mac 
(possibly caused by dragging your feet 
on the carpet, or even petting the cat), 
the cursor may freeze on the screen. 
Try disconnecting the mouse, then 
reconnecting it after a few seconds. 
Sometimes this will restore your 
cursor's functionality. If it doesn't, use 
keyboard equivalents to save your 
work in progress, then reboot the 
Mac, even if it seems to restore itself 
to normalcy. 

Keyboard Repair 

Even careful users can have accidents 
with keyboards. If a cup of coffee 
accidentally spills across your 
keyboard, chances are the keyboard 
won't work at all. Replacing it costs 
about $250. But there's another way: 

1 
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Take oft' the cover and the key caps 
and give your ruined keyboard a 
warm bath. After drying it thoroughly 
(a hair-dryer works well and doesn't 
leave any cotton residue), spray the 
board with the kind of contact spray 
used for curing automobile engines of 
moisture. When you reassemble it, 
there's a good chance the keyboard 
will function properly. 

Silencing the Mac 

If you're annoyed by the way the Mac 
beeps when it wants your attention, 
there's an easy way to get some peace 
and quiet. Pick up a Walkman-style 
mini jack (we recommend Radio 
Shack's mono-to-stereo mini jack, part 
number 27 4-368, about $1.98) and 
plug it into the music socket on the 
back of the Mac. From then on, the 
menu bar will flash to get your 
attention-in silence. 

Changing the Screen Color 

Another "standard" Mac feature, the 
blue screen, can be easily changed to 
soft green by adding a sheet of yellow 
acetate. You can find them sold as 
see-through book report covers in 
many office supply stores. Just cut 
the acetate to fit and tape it over the 
screen, or make it removable by 
attaching some string to the top 
comers and sliding it over the top of 
the Mac. 

The Programmers' Switch 

You'll find the Programmers' Switch 
in your Mac box. To install it, snap it 

in between the air vent bars on the 
left side of the Mac so that the two 
spines on the switch touch two 
buttons on the Mac's circuit board. 
One of these buttons resets the 
computer, and one interrupts it. Press 
the front part of the switch and the 
Mac resets itself, much like it would if 
you turned the machine oft' and then 
back on. Press the rear part of the 
switch to interrupt, which stops the 
program currently running and puts 
up a bomb message. This can help 
programmers interrupt their 
programs as soon as a bug appears, 
and it also comes in handy if you run 
into a bug on a commercial program. 

The Programmers' Switch resets the 
System, but it doesn't automatically 
clear all memory or invoke the Mac 
ROM's self-diagnostics. To start with 
a completely clear memory, turn the 
power oft' for a few seconds and then 
restart. 

If your Programmers' Switch gets 
jammed when you press it, remove it 
and check the mold marks for excess 
plastic that wasn't removed during 
the molding process. Use a razor 
blade or X-acto knife to remove thin 
plastic slivers, then reinstall the 
Programmers' Switch and you should 
have no further problems. 

General Information 
Freeze the Screen While a 
Document is Open 

Many Mac users leave documents up 
on screen while attending to other 



business. But when something bumps . 
the keyboard (or worse, the backspace 
key), documents can be changed 
accidentally. You can freeze the 
screen just where you want it, and 
make sure it can't be altered, by 
calling up the Alarm Clock desk 
accessory. As long as the Alarm Clock 
window is active, you.can't make 
changes to any other window on the 
screen. 

Close Without Saving to 
Restore to Last Saved 
Position 

In situatiol).s where you've lost 
important data (through mistakenly 
cutting, backspacing, etc.), close the 
file without saving and then reopen 
it~ Your document will be exactly as 
it was the last time you saved it to 
disk. 

Why Your Menu Bar or 
Apple is Flashing 

If your menu bar (or the Apple icon at 
the top left of the screen) is flashing 
and you don't know why, chances are 
it's because someone set your alarm 
clock. Choose Alarm Clock from under 
the Apple menu and click on the tiny 
flag at the far right side of the 
window. From there, choose the alarm 
clock icon (in the far right comer). 
Look into the middle section of the 
window-see that small· switch m.tage 
on the left? Set it to the Up position 
by clicking on it, and your alarm 
should stop flashing. 

GENERAL INFORMATION-MAC PLUS/HFS 

When Your Calendar And·c 
. Clock Aren't Working 

The alarm clock and calendar ·. 
functions are regulated by the Mac's 
internal battery~ Its. compartment is 
located in the upper right side on the 
back of the machine. After about two 
years, the battery will give out .. 
Replace it with. an Eveready .523BP, 
Ray-0-Vac RPX21, Duracell·RX21 or 
Panasonic PX21, all of which are .4.5 
volt batteries. You can find them at 
an electronics specialty stQre and 
through some Mac mail·order hous~s. 
Don't pay more than $5 for a 
replace~ent.battery. 

The Keyboard Remembers 
What You Type 

. The Macintosh has a very effective 
keyboard memory buffer. So, when 
you launch an application, you only 
have to wait about four seconds before 
starting to type, even if the 
application isn't fully set up on the 
screen yet. 

l!2) The Mac Plus/HFS 
Incompatibility With Older 
Software 

Older software may have problems 
running on the Plus. One solution is 
to boot the software using the older 
Finder 4.1 with the old System file. 
This will disable the new HFS 
(hierarchical filing system) until the 
Plus is booted off the newer. System 
and Finder. 
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Some programs are completely 
incompatible with HFS. Among them: 
Neon 1.5; Quick & Dirty Filer; and 
SkipFinder 5.3. 

At first glance, Microsoft Fortran 
appears incompatible with the Mac 
·Plus. It will run, though, if your disk 
is formatted with the flat filing 
system. You can format a double­
sided disk .as: flat by erasing it with an 
old,· MFS system file, which results in 
an BOOK MFS disk. You can also use 
this technique with the first version of 
TMLPascal. 

Recovering From a System 
Crash 

You might be able to recover from .a 
system crash. When a System error 
occurs~ press the Interrupt button (it's 
behind the reset button on the 
Programmers' Switch). Sometimes, a 
dialog box appears with a ">" prom.pt 
appears. Try. typing in the following 
debugger routine: 
G40F6D8 
Then hit Return. You'll probably be 
returned to the Finder. 

RAM Caching 

When you activate RAM caching with 
the control in the new Control Panel 
DA, remember to reboot the machine. 
Only then will the RAM cache 
activate. The same applies to turning 
the RAM cache off. 

The disk cache on the Mac Plus is 
controlled from the Control Panel DA. 
Some older games will not operate 

properly when the cache is set. Games 
are a major problem, as are HFS 
Backup and TML Pascal. Make sure 
the disk cache is off if you have 
problems running older programs. 

If you use the disk cache, choose Shut 
Down from the Special menu before 
powering off the Mac. The diskcache 
doesn~t write changes back to the disk 
immediately after they're made, and 
if you power down without using Shut 
Down to tell the cache to save recent 
changes, you may lbse some of the 
changes made from the Finder. 

The New Control Panel: 
How to Set the Alarm Clock 

The new Control Panel doesn't have a 
provision for setting the. system clock. 
To set the clock now requires the use 
of the Alarm Clock DA installed in the 
System on your startup disk. Click 
the flag icon on the right side of the 
clock display to bring up a sub­
window that shows you the icons that 
reset the clock. 

Desk Accessories Under 
HFS 

Desk accessories may not work when 
they're first installed. If this is the 
case, make sure all the DAs support 
files or data is placed inside the 
System folder. 

Selecting File& In the 
Minifinder 

While selecting files from the Select 
File dialog, press tilde·(') to scroll to 



the bottom of th~ file li..s~. and :select 
the last file. 

Moving Through the HFS 
· ·Hierarchy · . · . 

·After entering afolder through the 
standard OPEN and SAVE dialog 
boxes, you can step back ·through ·the 
tree by clicking on the disk .or volume 
icon in the upper right side of the 
dialog· box. Each click steps back one 

.level in the· tree. 

If you're using a hard drive· and want 
to make a floppy or another volume 
your startup, hold down- the OPI'ION 
key while launching an :application. 
The. disk the application resides on· 
will become your startup disk. 

If at least two volumes are mounted, 
to get to the top level of any mounted 
disk, use the tab k~Y• -F~r example, if· 
you have one hard.'di~k mounted and 
one floppy volume and you're deep 
into the folders and want to get back 

-~ tot}te top, hit the tab.key twice. The 
rule for reaching the :toP level ofJhe 
currently-active disk is to quickly tab 
X+l times. X=the number of disks 
mounted, including floppies. So, if 
you have two hard disks chained and 
have mounted three floppi~s, tab six 
times to reach the top of the current 
disk. 

... ·The New SCSI.Ports 

That SCSI port might look liP-a ·. 
; ; standard RS-232 port, but 

unfortunately it isn't. If you put ·in a 
cable that isn't configured for a SCSI 

MAC PLUS/HFS 

device, you can cause serious internal : 
damage to ·the Mac. . 

Some Mac Pluses with ,early ROMs 
can have problems powering up when 
.~;S.CSI device is;~ttacll~d. If .. t1u.,: 
looks like a problem, tum the device 
on before powering up tbeiMac. 

,; 10o 

Plus and Minus Keys 
Reversed· on Some;Plus ·: · 
Keyboards .· _! ·''n"r 

If you're the proud owner of a very 
early Mac Plus, you undoubted~ . 
know by now that the.plus and. minus 
keys can be reversed .on,· the keybct~. 
If you don't want to go to the trouble 
of arguing With your dealer about.it, 
just use the plus key to subtract -and 
the minus key to add. 

; • ~, , r ~: 

Replacem.ent.Parts ·. ,,, _, 

·If you seem to be having troqbl~. ,. · 
finding the right ImageWriter1 ~f: '"' 
connector cables for the Mac Plus, .a' 
your dealer_ for. an Apple//~ modem 
cable (A2C0311). I. • 

A good substitute· Mac·;Plus/Hayes- ~ 
compatible modem cable_ is //e prin~r I 

cable A9C0313. 
: ~-i ' 

Spacing Problems Wi. tJ1, New· 
Apple Fonts .. ···:~·· . 

!'"!; : 

The fonts Times, HelvetiCa and , 
Courier have~ ~lightly altered~ 
improve spacing w}le~.p~~-on the 
LaserWriter from a Mac Pl~.l~s 
might cause some ~ spacWI~r 
problems in existing older d:ocuments. 
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\ Unfortunately, there's no fix except to 
recreate the document with the new 
fonts or to edit the documents to 
include them. 

6 

IJ:sing the Keyboard to Move 

The Mac;PlU.S keyboard's arrow keys 
can be used to move around the disk 
menu. Hit: the down arrow~once to 
select the:1irst available folder in the 
menu. Hit it again to scroll down to 
the next available folder. 

Hit.the.up ·arrow to quickly highlight 
the·last'available folder. Press it 
again to move up to the next folder. 

I ' 

COMMAND-UP ARROW moves you 
one level up in tbe disk hierarchy. 

COMMAND-DOWN ARROW moves 
you one level down in the hierarchy. 

Wheh· you're looking at the disk menu 
within an application, use the up and 
down artows to scroll through the 
menu offiles~··either·in a folder or on 
the root level ofthe·disk. 

Numeric K,eyboard 
· PrOblems··· · 

When_ you use the original external 
numeric keypad with. the new ROMs 
in the Plus, you'll find that the first 
char~cter typed on the regular 
alphariumelie keyboard won't register 
in the computer. Also, ifyou type the 
first ehara.cter on the numeric keypad 
it will-repeat that character 
contiriu~usly until another key is 
pressed: 

The New ROMs 

INIT resources :are procedures that· 
automatically execute when you start 
up your computer. INITs usually 
reside in the System. file-if they don't 
they have to be put there with an 
installer or else pasted in using 
ResEdit. But with the new ROM chips 
resident in the Mae Plus and higher 
machines, there's a way to get them to 
work without permanently installing 
them. Take the INIT file you want to 
run, then use Fedit or ResEdit to 
place the file into the System folder. 
Now it will execute without actually 
being installed into the System file, 
meaning that it's easy to remove. An 
example of an INIT is the clock that 
installs itself upon startup. 

Screen Dumps From the 
New ROMs 

Screen·dumps behave differently with i 
thenew·ROMs than they did on the 
original,Mac. They are queued 
instead of executed immediately. That~ 
means, pending .actions Oike releasing 
the mouse button) take place before 
the FKEY action Oike creating a 
screen dump) .. Unfortunately, that 
means you can no longer take a 
screen dump that shows menus pulled: 
down. The only possible solution. 8s-of I 

this writing is to use the public 
domain DA Camera, which waits a 
specified time interval before taking a 
screen shot. Queuing applies to all . 
FKEYs, 0 to 9. ~ ·~.· 



Save Time By Avoiding 
Self•Diagnosties '· 

The Mac .Plus conducts a self­
diagnostic procedure every time it's 
started up. You can:save a little time ' 
by holding do'Wn the mouse button 
until just after the beep, which skips 1 

the procedure. Don't hold the button 
down too long, though, or all disks 
will be ejected. Don't use this 
technique every time, since memory 
problems should be caught before 
they cause .too much damage. 

About Folders 

Your.HFS Mac will perform at its best 
if you use a lot of folders, each 
containing a few files, instead of. a few: 
folders containing a lot of files. 

~~] The Mac SE 

Access .the Hidden Slide 
Show : 

· There's a hidden four-frame slide 
show built into. the SE's ROM which 
shows members of the SE 
developrtient team. To see it, ·boot the 
Mac and press the interrupt button on 
the programmers' switch. (Make sure 
any co1_1nected modems are tUflled 
ofi.) Then type G41D89A into the 
debugger ~c;Iow and hit Return. The 
sijde show will" continue until you 
reboot th~ ~hine. 

-FJ~~g ~ks on_the SE 

,:Si:nce the SE can have two built-in 

MAC PLUS/H~ACINTQSH,XL 

·disk drives and one external drive, 
the COMMAND-SHIF-l'!keyboard 
commands for ejecting disks.-are,a . 
little different than usUal: 

COMMAND-SffiFT-1 ejects the 
bottom internal drive. 

COMMAND-SmFT~2 ejects the top 
internal drive. 

COMMAND-SHIFT-0 ej~ the 
external disk drive~ _ 

' ., 

Ill The Macintosh X_L 

E•yBoo~g. 
:. I 

Reboot the XL easily byh()ldiDg down 1 

CO:MMAND and pushing the power 
button. 

When you hold down OPI'ION while 
pushing' the power button, it feboots 
the-:XL and prompts it.to'ask for a ' 
floppy disk~. "· · · :> .. 

If you hold down OPTION after th~ 
memory test, you' can boot from a 
floppy. · -· · 

To restart the XL from the ha'ra~disk 
and return to the desktop, hold:aoWn. 
the Appl,e·key while pushirigthe~~ 
power switch. This helps 'you avoid 
having to reload MacWorks 'into· ·· · 

•'.;. 

mem~ry. 
; ; .. -. 

Exporting Excel llOcmllents · 
to Standard Macs · :. ~ · · 

When you move an Excel d~ent 
:_ ' ' 
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from a· Mac·n·:to a "normal" Mac,; the 
window will be larger than the new 
screen, display. Click twice on the 
window title and the screen reduces 
to more manageable proportions. 

Incompatibility 

ExperLisp and ExperOPS5-have 
compatibility problems when running 
on an XL under Mac Works. Don't use 
them with this configiJrationiunless 
you have a lot of patience for system 
crashes and power shutdowns! 

l. ': 

~ The.Mouse 
How To Tell If Your ·Mouse 
Needs a,JJath; .Cleaning the 
Molise : · l--- •• 

_,.- - '· 

If you've been using your Mac for 
. x.nonths in ap environment prone to 
"'d~st and lirit, cleaning the t;now,;e 
according.to Mac manual instructions 
may not be thorough enough to keep 
the mouse performing like new. If 
you've bee~ havin-g probl~ms moving 
the mouse in ~.fluid, smooth motion, 
it prob&bly needs a heavy· duty 
cleaning. Take the mouse apart 
ac~'ding to ~e directions in the Mac · 
m.ap~. Then, remove the two · 
Phillips-head screws (on the base of 
the _mo~~)n~ the cord~ -With the 
base do.WI;l,_gently remove the top half 
of the mouse case, pushing the cord 
gently out of its socket in the upper 
~ Insi~~. you'll see three rollers 
that transmit. the instructions from 
the mouse to the Mac. DO NOT 
REMO~ THEM! But you can use 
the tip of a-toOthpick to remove hair 

or lint that's become tangled around 
the rollers (don't use metal tools to 
work inside the mouse). Then, clean 
the rollers with a cotton swab dipped 
in denatured alcohol. Finally, clean 
the rubber ball with a soft, dry cloth 
and reassemble, making sure the 
button and spring are properly, 
seated. Then, carefully reinsert the 
cord into the upper half of the case 
and replace the two screws. 

Another good cletqrlng solution is 
stylus cleaning fluid, like the kind 
used to remove dirt from diamond 
needles of record players. Use·the 
brush that comes with the fluid (it's 
about the right size for cleaning 
mouse innards) and let dry before 
reassembling the mouse. 

Getting Rid of a Sque*-

If your mouse develops a squeak not 
unlike that of the live mouse, you can 
correct the problem by removing the 
ball roller and spraying the inside 
casters with a small amount ofWD-40 
lubricant.: Let tbe lUbrieant dry and 
replace the roller. Not only will the 
sq~eak sJlhside, but your m,.ouse will 
glide as_smoothly ~it did when new. 

~ -. j 

Mouse Foot 
Protectors/Replac~ments 

Peel and stick felt pad~ (buy them in 
a hardware store) prevent mou~ foot 
wear and make mousing smoother. 
Wh~~ they wear out, you can.a_lways 
replace them with new felt pads. -

Another good mouse foot protector is 



the fuzzy side of peel and stick velcro, 
cut into small circles. 

Yet another good mouse foot protector 
is a thin sheet of soft leather. Glue on 
small circles, and you'll find the 
mouse will glide well. Don't use 
suede, since the tiny grains can get 
inside the mouse and clog it. 

If your mouse feet are already worn 
out, use BBs (as in air gun 
ammunition) to replace the feet. Just 
put a tiny drop of Crazy Glue on the 
slanted edge of the mouse directly 
above the original mouse foot and 
glue a BB in place there. They'll work 
better than the original mouse feet 
because they're round, and they won't 
wear off, even with heavy usage. 

The Poor Man's Mouse Pad 

Mouse pads work well because they 
keep you confined to a given area 
instead of mousing all over your work 
surface. If you haven't got one, try a 
hardcover book instead. Time-Life 
books work particularly well because 
they're smooth, have more room to 
move around than standard mouse 
pads, and can be bought cheap at 
used book stores. 

A.,AppleTalk 
Use the Same Printer 
Drivers on a Network 

When using AppleTalk on a network, 
make sure all drivers have the same 
version of the print driver (this 
includes the LaserWriter and 

MOUSE-APPLE TALK 

·AppleTalk Image Writer Drivers and 
Laser Prep). If your System finds 
several different versions active on 
the network, it will often stop to ask 
for all printers on the network to.be 
reinitialized. 

Update Mac 128K and 512K 
Systems For the Network 

If you have a Mac Plus on the 
network with a 512K or 128K Mac, 
you'll have to update the sy$tem disks 
on the older Macs with the Installer 
utility found on the Mac Plus' System 
Tools disk. The older Macs won't be 
able to save to folders from within 
applications, but other than that, 
they'll work just fine. 

Choosing a Printer 

Always use the Chooser DA-not the 
old Choose Printer desk accessory -­
when printing on AppleTalk. If you 
run the Choose Printer DA while in 
an application on AppleTalk, your 
system could freeze. Use the HFS­
compatible Chooser, or else remember 
to run the Choose Printer DA from 
the Finder. 

When You Disconnect 
AppleTalk. •• 

After you have physically 
disconnected your Mac from 
AppleTalk, always tum off AppleTalk 
on the Control Panel. If you try to 
print on a non-AppleTalk 
Image Writer connected to your Mac, 
the printer will get confused unless 
you change the setting on the Control 
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Panel. Reset the system by turning off 
the.Mac's p.ower. 

Making a Quick Break From 
the Network 

The reset button on the Programmers' 
Switch does not break the AppleTalk 
connection. If you need to disconnect 
fast, tum off the Mac's power. 

Don't LaserPrint MacWrite 
and MacDraw Documents 
Simultaneously . 

If you try to laser print a Mac Write 
document from one Mac and a 
MacDraw document from another 
while on AppleTalk, the Mac Write 
document will print fine, but the 
MacDraw document won't be 
completed. To be on the safe side, 
print only· one type of document at a 
time. 

RAMdisks Can Cause 
Ap~leTalk· Printing 
Problems · · 

RAMdisk programs can cause 
printing problems on AppleTalk. Try 
not to use them when printing on the 
network. 

Causes of a System Crash 

Many programs, especially games, 
initialize the printer port when they 
start up, causing crashes. Either 
disconnect AppleTalk before booting 
the disk, or don't use it on the 
AppleTalk-connected Mac. If you do 
crash, eject the disk and shut down 

all nodes in the system .for at least 30 
seconds. When you P.ower back up, 
you should have no further problems. 

If the Network Isn't 
Working 

If your network doesn't work, the first 
thing to do is shut down all nodes 
connected to AppleTalk and check to 
make sure all connections are correct. 
Then restart the system. 

If that doesn't work, turn off each unit 
and disconnect them all, reconnecting 
them one at a time,· starting with the 
machine closest to the LaserWriter on 
the network. You could have a loose 
wire, a bad wire, a faulty port on a 
Mac, or a piece of hardware or 
software that's incompatible with the 
system. As you reconnect machines to 
test theui, you'll have to tell the disks 
that the Laser Writer is connected 
again. 

Printing Problems 

Sometimes your disks can forget that 
the LaserWriter is connected to the 
network.. Try going to Choose Printer, 
and select the printer port, choose 
APPLETALK CONNECTED, and 
wait to see if the Laser Writer icon 
appears in the scroll box. If not; select 
APPLETALK DISCONNECTED and 
hit OK. Then, go back to Choose 
Printer again, and go through the 
whole process until you see the 
Laser Writer appear (it will 
eventually, if your machine is 
properly hooked up. to the network). 



!-~~~~~~~The lmageWriter 

Storing Image Writer 
Ribbons 

Keep Image Writer ribbons fresh by 
storing extras in plastic zip-lock 
storage bags. 

Replacement Ribbons 

If your store doesn't carry 
Image Writer ribbons, try NEC 8023, 
C. Itoh 8510 or DEC LA50 ribbon 
cartridges. 

Image Writer Maintenance 

It's a good idea to lubricate the 
carriage-bar once a year or so. 
Although the manual clearly says, 
"Do not use electric motor oil or any 
lubrication that contains rust 
inhibitors," you can use sewing 
machine oil, even though it contains 
rust inhibitors, or just about any 
other type of oil. Apple says that the 
metal used to make the carriage-bar 
is not the same one that was specified 
when the manual was written. 

Don't Leave Disks On the 
Image Writer 

Never leave disks sitting on top of 
your Image Writer. The printer has a 
magnet embedded in the left side of 
its cover that can blank a loaded disk 
in the blink of an eye. 

IMAGEWRITER 

Quick Printing 

You can cut down on the time the 
Image Writer pauses before it prints 
the last line in a document by 
pressing SELECT once. This makes 
the printer immediately print the 
line. Press SELECT again to advance 
the paper forward enough to tear off 
the page. 

Smoothing Lines In Gray 
Areas 

Large areas of black or gray can often 
be marred by horizontal lines. Try 
using higher grade fanfold paper or 
high quality single sheets. 

Another way to smooth out gray areas 
is to use an older ribbon while 
printing these sheets. 

Creating Smaller Top 
Margins 

The Image Writer II automatically 
assumes you have the paper 
positioned in the printer for a one­
inch top margin. If you want a 
smaller top margin than that, leave 
the previous sheet of tractor feed 
paper in the printer, set the top 
margin to one inch, and roll the paper 
through the printer to the exact 
starting location for the print. 

Solutions For Squished 
Printouts 

You might find that the first line of a 
page is slightly squished or distorted, 
especially when printing in high 
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resolution. There's nothing wrong 
with your ImageWriter ... chances are, 
the paper was slightly wrinkled. 
In standard printing, the 
Image Writer's print head makes two 
passes to create a line of text, and in 
high quality mode it makes four. It 
prints the top portion on the first line 
of text first, filling in the other parts 
with each successive pass. If the 
paper isn't fixed firmly in position, it 
can shift so that the print head passes 
over the first line again-causing 
squished letters. A good solution is to 
leave an extra blank line at the top of 
documents, or to buy thin paper that 
clings to the platen. 

Another solution when using tractor 
feed paper is to feed through a blank 
sheet first. This acts as an anchor for 
the rest of the paper, minimizing 
squished first lines. 

Avoiding Paper Jams 

If you use tractor feed paper, the top 
sheet of paper might curl back into 
the top of the platen, especially if the 
paper was left in the printer 
overnight. Get around this by putting 
a piece of masking tape over the slot, 
fixing the tape only at the front so 
that the back cover can still be 
removed. 

Don't Overheat the Print 
Head By Printing Too Much 
Black Space at Once 

If you do a lot of printouts with large 
amounts of black space at one time, 
the printhead might overheat and 

need to be replaced. Graphic images 
with dark backgrounds are more 
likely to cause problems. If you're 
doing multiple printouts with a lot of 
black space, avoid using more than 
25%-30% solid black on a page, or 
print your documents a few at a time 
to give the print head a chance to cool 
oft' between printouts. 

When A Blank Page Prints 
At the End of a Document 

Sometimes you'll find an extra sheet 
scrolled through at the end of your 
printouts. Try selecting the To and 
From boxes in the Print dialog box. If 
your document is five pages long, fill 
in From 1 To 5. If it's a single page, 
fill in From 1 To 1. 

Printing More Than One 
File at a Time 

Several files in a row can be printed 
with a single command. Just select 
them on the desktop with the 
selection rectangle, then choose Print 
from the File menu. 

When printing multiple files, no 
matter how many copies you select in 
the Print dialog box, only one copy of 
each file printed after the first will be 
made. 

When printing multiple documents, 
you can select the order in which 
they'll be printed. On the desktop, 
press SHIFT-CLICK while selecting 
documents. When you choose Print, 
they'll be printed in the order in 
which you selected them. 



Stop Printing Quickly 

A few commercial programs don't 
work properly when you press 
COMMAND-period to stop printing. If 
the program doesn't seem to be 
responding to your click on the 
CANCEL button, or if you need to 
stop printing immediately (if, say, the 
printout starts winding around the 
roller), just flip the Image Writer's 
power switch off. The Mac will still 
think it's printing and continue until 
it's finished, but your printout time 
will be shorter than usual. 

What You See Isn't Always 
What You Print 

When you print, the Image Writer 
(and Image Writer II) uses a font twice 
the selected size (if it's available in 
the System) and then scales it down 
to produce high quality output. Fonts 
usually don't change from one size to 
the next. But Geneva is the exception 
that proves the rule: its lower case 'Y' 
in 12-point has a distinctly different 
descender than the 9-point 'Y' and 
both have different fonns than the 24-
point character. That means, when 
you print High quality in Geneva, 
you'll often get some characters that 
print quite differently than they 
display on-screen. 

An Image Writer Extension 
Cable 

If you need a longer Image Writer 
connector cable, try using a Radio Shack 
joystick cord (part number 276-1978; 
about $3.99). It often does the trick. 

IMAGEWRITER-IMAGEWRITER II 

1
_1i1li!IJJ The lmageWriter II 
What To Do When Your 
Printouts Are Smudged 

If you've been having problems with 
smudging while you print, try 
adjusting the paper thickness lever 
(see your Image Writer II manual for 
details). Your print head and ribbon 
could be too close to the platen. 

The next thing to try is cleaning the 
print head, since ink buildup is bad 
for paper and printer. Remove the 
print head by pulling upwards on it 
while moving the white print head 
holder to the right. You may have to 
shift the print head from side to side 
to loosen it. Now, clean it using a Q­
tip soaked in alcohol. When you're 
done, carefully reinsert the print 
head, making sure it's placed straight 
into the slot. 

If neither of these quick fixes helps, 
there's a possibility that the Paper 
Guide is dirty or broken. The Paper 
Guide is that plastic piece that wraps 
partially around the platen to 
surround the print head Remove this 
by first removing the print head and 
then using a small Phillips head 
screwdriver to unscrew the two 
screws holding the Paper Guide in 
place. Once it's out, check to be sure 
that the metal attachment isn't 
ripped or cracked. If it is, you'll need a 
new Paper Guide (available at Apple 
retailers for $10 or so). But cleaning 
the Paper Guide might just work. Use 
a Q-tip soaked in alcohol. Remember, 
though, to re-lubricate the pins with a 
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small amount of oil on the felt pad or 
pins just behind the tip. Then set the 
pins on a paper towel to let the old 
ink run out. When they're dry, 
carefully put the Paper Guide back in 
place and feed three sheets of paper 
into the printer. When that's done, 
screw in the Paper Guide so that it 
presses against the paper. If this last 
resort doesn't work, your printer 
needs a trip to the printer doctor. 

Another reason for smeared printouts 
is a tear in the foil on the print head. 
Remove the foil if it's tom (you don't 
have to replace it) to correct the 
problem. 

A Solution For Scrunched 
Top Lines 

Does the top line of your printout 
often look "scrunched"? This is caused 
by slackness in the paper feed. When 
you're using tractor-feed paper, one 
solution is to feed through an extra 
sheet of paper, which acts as a leader 
sheet and anchors subsequent pages 
in place. 

Avoiding Paper Jams 

Paper jams can result from the 
reverse-forward motion of the 
Image Writer II just before it begins 
printing a page. This usually doesn't 
happen on the first page after the 
printer has been turned on because, 
when printing the first inch of the 
first page, the print head moves to the 
center before the paper advances. So, 
before printing a new document, tum 
off the printer and then tum it back 

on again, and you should have no 
problems. 

Printing Letter-Quality 
Fonts 

It's easy to get good, letter-quality 
fonts printed Use the Laser Writer's 
Courier font and print your text in 
high quality. (Make sure you have 
installed a font twice the size of the 
one you'll be printing in your System 
file. For example, install 24-point 
Courier to print in 12-point.) 
Unfortunately, this won't work with 
all word processors-including 
Mac Write. 

Image Writer Driver 2.0 
Problems 

Image Writer Driver 2.0 prints 
occasional m.isformed letters. If you're 
using this driver, get the 2.2 upgrade. 

Bidirectional Printing 
Decreases Printing Time 

When using the Image Writer Driver 
2.1 or 2.2 with the Image Writer II, 
you can get bidirectional printing and 
therefore decrease your printing time 
by nearly 25%. Just go to the Print 
dialog box and hold down SHIFI'­
OPriON-CAPS LOCK while clicking 
OK 

Faster Quality Can Result 
in Darker Picture 

When using Image Writer Driver 2.2, 
picture quality is darker for Faster 
quality than for Best quality. 
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Has AppleTalk Lost-Your 
Image Writer? 

- Sometimes, driver,2.2forgets how to 
recognize an ImageWiiter. II, and 
assumes it has different paper 
handling routines than it does. Get a 
newer driver if.this. causes:you 
problems.· ' .. · 

Don't· Use ·Print Spoolers 
With Image Writer ll 

The Image Writer II shoUldn't be .used 
with a ·print, spooler. It confuses .the 
spooler by :sending.a-.message back to 

·- -the Mac telling the machine that it's 
an Image Writer II .. The spoolers most 
likely to be affected usually simulate : 
printing .. to a hard disk, which in turn 
sends the data stream to the printer. 

Printing Medium-Quality Is 
Slower With New Driver 

If you're printing. from Microsoft 
applications, you'll find that printing 
is slower in the medium-quality mode 
than it was on the Image Writer I. 
Speed up the printirig process by 
using an old version of the 
Image Writer driver,. although this 
means giving up some Image Writer II 
benefits for the time being. 

Use Two Sheets While 
Printing, If Possible 

For best results, adjust the clear 
plastic paper thickness guide so that 
it allows two sheets of paper to pass 
through. The paper thickness lever is 
located under the Image Writer II 

cover to the. right of the platen. 

How· To Access the Self-Test 
Mode 

The Image Writer II can tun self-test 
S$111ples ·of all three printing: modes. 
To do· this, tum the printer off and 
hold down the Form Feed.buttop 
while turning it back on. This starts 
the draft mode self-test. While it's 
printing, deselect the printer by 
·pushing the Line Feed button and 
then push the _Print Quality ·butt()n to 
select a new mode. Then reselect the 
printer by pushing Line Feed. When 
the print head begins a new line, it 
will print in standard quality. Repeat 
Step Two to enter high quality mode. 

rn==ll The LaserWriter/ 
~ LaserWriter Plus 

Solve Uneven Toning By 
. Shaking Printer Cartridge 

When working with a brand-new 
toner cartridge, you might experience 
some toning difficulties. If your 
printouts seem to be unevenly t;oned, 
remove the cartridge and gently­
shake it from side to side. (Be careful 
not to spill the ink.) Then reinsert the 
cartridge and print about 30. sheets to 
break it in. 

Should You Refill Empty 
Cartridges? 

Empty LaserWriter cartridges can be 
refilled, but they don't always produce 
great quality-printouts. Thafs . 
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because the cartridge contains parts 
that get a lot of wear, such as the 
drum coating. If you need the best 
quality printouts, don't use a refilled 
cartridge. 

You Must Have LaserWriter 
Printer Driver and Laser 
Prep to.Print 

When you print on a Laser Writer, it's 
crucial that both the LaserWriter 
printer driver and the Laser Prep .files 
ate resident on your printing disk. If 
the, Image Writer driver is on disk 
instead, you'll find that your 
document will not print the way it 
looks on-screen. 

Turn Off Smoothing To 
Print Textures 

When printing textured graphics on a 
LaserWriter (dots, for example, 
instead of lines), use the Page Setup ... 
menu to tum oft' the smoothing effect. 
This tells the LaserWriter not to play 
connect-the-dots with your textured 
graphics. 

Use LaserWriter Fonts For 
LaserWriter Printing 

For the best results on printouts, 
make sure your font is written in a 
Laser Writer font. If it isn't, it's a good 
idea to manually change the fonts 
instead of using the Font Substitution 
option in the Page Setup menu. When 
you change fonts by hand, remember 
to turn otrthe Font Substitution and 
Smoothing options. When you use 
Font Substitution, the LaserWriter 

changes all characters from 
Image Writer to Laser Writer fonts. 
But the original spacing between the 
characters remains the same as it was 
in the Image Writer fonts, resulting in 
sloppy printouts. 

Resource Im.ageWriter 
Fonts to Laser-Print 

If you use ImageWriterfonts with the 
LaserWriter, they have to be properly 
resourced to print in the right size as 
bit-mapped characters. If you create a 
font in 36 points, you have to give it 
the proper resource number, 36, when 
you create it, since a resource number 
error won't show up on an 
Image Writer, but the LaserWriter 
prints it out in the point size specified 
by the resource.number. You can 
correct this problem if it occurs by 
changing the resource number in 
FONTastic. 

Use Largest Image Writer 
Font for Substitution 

If you print Image Writer fonts on the 
Laser Writer, always keep the largest 
available font size of each in the 
System file, since the LaserWriter 
uses the largest size and then scales it 
down. using the largest font size to 
scale from, you'll get much smoother 
printouts. 

Font Substitution Better 
With Later LaserWriter 
Drivers 

Laser Writer Driver versions 3.0 and 
higher do a better job of font 



substitution (in the· Page Setup menu) 
than previous 'drivers. The spacing 
still won't come out-quite as well as it 
does if you convert your document to 
Laser Writer fonts, but:it does improve, 
spacing considerably.-- ::··· - ' 

LaserWriter Driver 3.0 Can 
Crash When It Deinstalls '· 
Cblcago12 

~. ' ' ' 

When you're working on a 'Mac:Plus, 
the LaserWriter Driver version 3.0 
can sometimes uninsta111:2~point 
Chicago. The next,time your Plus 
tries to access this· font, it crashes 
becau.se it can't find ·it. U se.:tlie 
Font/DA Mover to put a ri~w 12~point 
Chicago·· font into the,System .. 

.Style·ChaDges Can Make 
LaserWriter Driver'S.O 
Reset While Printing 

When LaserWriter Driver 3.0 
encounters a style change and then -a 
change.back·in ·a document printing 
in a downloaded font. (or a bit-mapped 

. font), it re-downloads the-original 
styl~; :Slling ·up the printer's memory 
very quickly. When this,happens, the 
LaserWriter resets in the middle of 
the print job. 

Having Trouble Collating? 

When you use the new driver with 
some software, the LaserWriter 
doesn't always collate pages 
automatically. If this happens to you, 
try moving the printer to·the edge of 
th~ftable and remove the paper 
output tray. Attach a little basket . 

LASERWRITER/LASERWRITER PLUS 

with an edge 'slanted away fromithe 
printer to create a V -shaped device. 
Each page that rolls out of the printer 
should fall upside down, face down, 
allowing the next page to.fall behind 
it. Just pull out the stack and you'll 
find collated page&. .~ " · ·' 

Why Optional Characters~· 
:Might Printlricorrectly · · 

Sometimes the .Laser Writer Plus.16ses 
track of the Apple to Adobe character 
mapping on the new fonts, meaning 
that s.ome optional characters will). 
print incorrectly-and some won't 
print at all. To correct :this, stop: · 
printing and tum· the Laser Writer off 

:and then back on.· 

·-Use PAGE ·SETUP If You 
Switch Printers 

If you will be using .more than one· 
printer, always select PAGE SETUP ; 
during printinglf you bay~ changed 
printers since the last printing .. Your 
application remembers the imaging 
rectangle it can print to, and the 

· printer determines the size of:this. 
rectangle~ That's why letter-s~ are 
sometimes cut off at the edges of, a, 
.rectangle. · 1 . 

' ~· ~ , :. 

Print Multiple Copies of 
Multiple· Documents · · 
One:ata Time 

'-'if,' . 3 

lfyouwant to print. multiple copies:of · 
multiple documents, select them one 
at a time. Otherwise, ifyou~·choose .to 
~print, say, 3 copies qffive5documents, · 
the first document: printed:. will be. 
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made three times. Each successive 
docUm.ent will be printed only :once. 

You Have 90 Seconds To 
Feed Paper Manually 

When using the Manual Feed 
printing option, you have about 90 
secQnds~ wb,l.ch t9:putyour·papei' in 
the ff;!~d slot. lf:th~ PAPer ~asn't been 
inserted by the time 90 seconds has 
elapsed, the·LaserWriter will cancel 
your job. 

Avoiding ~nvelope Jam 

To print envelopes without having 
_themjautin the LaserWriter.during­
manual feeds, place a little down.curve ' 
on to the envelope. Do it by drawing 
the.envelope~over the·edge of a des~~r 
table. Also, run your.fingernllil along 
the upper edge, which makes the 
envelope-a little smoother. 

Creating-Envelope 
:Templates 

\":' 

If you print envelopes with return 
addresses and/or standard addresses, 
try preparing a text block in your 
word processor, finding the right 
position on the page. To do ~s,. trace 
the outline of an envelope on the 
right-hand side Oength\\!ise down the 
page) of some blank sheets~d then 
run them through: in the landscape 
Page Setup mode (manual feed) until 

; the text, appears correctly placed on 
·the "envelope". Leave a good_-sized -
margin for the printer, too. When 
you've gotten a good layout, save the 
document as a template·to.use in , -
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envelope, creation, or else run. off a , 
batch of envelopes with return · ~ 
addresses in advance. 

•• :t ; • • -=· ' ' 

,r,m,ghten Up Bit-Mapped 
Graphics For Laser 
Prhiting 

Bit-m~pped graphics can be tig~te~ed . 
up before printing on the LaserW:riter 
by drawing the graphics as large as 
possible{then copying the design·to 
the Clipboard and-importlng,.them, 
into MacDraw. Once the image is 
pasted in, GROUP the graphic and 
shrink it by seleeting any comer · 
handle. ~It m.ay look muddy Qn the 
screen~~ but it will print. scale.d down 
with most ofthe, original detAil •. 

LaserPrinting.Acetates ~d 
Color:Seps · · : · · .·. 

The LaserWriter can be used to 
produce acetates for:overhead 
projectors and to prepare ... color 
separations .. Some acetate can't :_: 
withstand- the Laser Writer's internal 
heat, though, and can tn'elt ins~d of 
print.- Use Clear Acetate,for Plain, 
Paper· Copiers (try 3M's # 503) to do 
the job. 

Protect Your Printout and 
Seal Its Surface 

Artists who apply "fixer.s" to laser 
printed pages are usually 
disappointed with the results. That's 
because many fixes are .made with a 
·solvent-based solution!which· dissolves 
toner, bleeds'it into· the paper, or 
causes tbe.paper to becom~; 



transparent. But try sprayiqg Key,lon 
Matte Finish# 1311 to perman~~tly 
protect your printouts while ~ · 
enhancing their ·black&. Unlike 
nonQal fixes, this seals the surface. 
Use it in a ventilated area. 

rl6iJ r · Digitizers 

SC&JiVertical Lines 
Sid.ewliys r • • 

If you're scanning an image that 
contains a lot ·of vertical lines, you'll 
get be~r results by putting the 
image· on its side in the Image Writer. 

· Th~ .rotate the image back to a 
vertical position. 'If you scap this soit 
of.image normally~ the resulting 
vertical lines will be choppy. ·' · .: ! : 

Fr~yecl Tape Stri~t Ca~ses 
a9~Z~ntal D~tortion Line 

'...,; ~ ~ .. 

When using ThunderScan, sometimes . 
a thin Ilorizontalline ot dist;ortion 
appears· across your scarined image. 
This has been ·attributed to the white 
tape strip that's supposed to be · 
wrapp~d around the left end otthe 
Image Writer's' platen. After extended · 
USe~ the end of the strip can curl or 
fr~y, cohfus~gthe scanner. Try ~ ·. 
gluing the strip back into place, or 
replaee it altogether, to correct the 
problem. · ·' · 

Using ThtP1derScan On a 
MacPlus.orSE · 

ThunderScan was designed to deriye 
its power from the serial ports on,-~e ' 

LASERWRITERILASERWRITER PLU8-DISKS 

Mac. But when Apple changed tb~ .. 
po~ configuration for ~ewer machines 
like .. tbe Mac Plus, they temoved the 
power supply pins from the serial 
ports, so Th~derScal) n~s a special . 
adapter to run on th~ J>lus. Order this 
adapter from.'J'hunderware, Inc~, 21 
Orinda Way, Orinda, CA 94P63, or 
call (415) 254-6581. 

·.~. 
' ~- ' 

Disks 

If You Can't Erase· a DiSk . 
- . ·~·;I . 

You·inight occasiori8lly have trouble 
erasing disks. If ybu corltiriuo1181y·get 
a "Will not erase" ot: "Cannot initia~e ~ 
disk" message, try ~lng a b1t-eopi~:r : 
like ·Copy IlMac tO cqpy '& bliirlk disk j 

on to your troUble disk. This ~howef 
wri~ over the. propl4!m. area, malqng 
·it possible to erase'the disk~' · .":,·; · 

Always· ·Work'On..~ackups.,of! 
Applicatio11 DiskS) · · , .... 

. I 

Never do- work with an original 
application· disk. Make a backup copy, 
and only insert the original as the key . 
disk when the application' It copy . ' 
protection asks for it. Keep all 
original disks stored in a safe, dUst~ 
free environment.' · · 

Cheap, Safe .. Disk Storage 

A good, and inexpensive, place to 
store disks is in a Sterling plastic 
check file. It's about 9 inches wide, 8 
inches deep,· and 41/2 inches big~ 
when closed It holds up to 100 disks, . 
and you can keep your original io-

1$ 
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pack disk 'box to use as a divider to 
keep things :ne·at. The check· box-holds 
up to eight 1 0-pack boxes in two rows 
of four each, and it has a lid that 
closes tightly and a handle for easy 

· transportation·. It costs about 
$5 .•. much less than you'd pay'for a 
similar disk storage bOL 

Eject Disks Before Turning 
OffPower "'~'' 

Alway$ eJ~ct all disks before turning 
thtpower off on the Mac. This 
protects iJlem from damage in the­
i:ase of arp~:wer s;urge. . . .... 

'Never l~ave '-· Ai~k .in the drive while 
the powe~ is off on_ the Mac. You risk 

--pos~ible_ data d_amage or Joss. 
' ,.., -£ I o o 

ltow t9 LocWplock a Disk 1 

When. the small plastic square is set 
· ·to the Up posipon (so that you cari see 

through the bole if you try) your disk 
cannot accept any pew data or 
modifications .. .In other words, it's 
.locked. To unlock it, slide the plas#c 
square tQ th~ Down J?O~ition.· 

This wri~-protect tab isn',t totally 
foolproof. The square tab isn't a 
mechanical lock, but rather a slot in 
which a sensing finger can ~ inserted 
to flip a switch. Before writing to a 
disk, the, Mac checks to see if the 
switch is ~:ri or off. But if you have a 
bug-prone program that ~ashes, 
occasiot:J.ally the Mac will bypass the 

. ,tab setting and write bad information 
to the disk. ~ere's no ~r~ except: 
work on a backup of your application! 
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HP.Disks Can Sug In Your · 
Disk Drive 

If you use Hewlett;.Packant diskettes, . 
you'll notice they have a little plastic 
hook on the case's surface to hold the ' 
metal shutter back. This hook can_ 
become lodged in a Mac disk drive 
and prevent you from removing the 
disk. If you'll be using_IW dis~s, use 
an X-acto knife to remove the book.: 

_; ··-·., . -' 

Magne*" Are Lethal to Disks 

Never expose your disks to any 
magnetic force, since it can wipe your 
data clean off the disk. If possible, · 
store disks away from metals such as 
file cabinets. 

Protect Your Disks From·.:· 
Airline Security Scanners · 

Airline security scanners have )ong 
been held r~ponsible for data Joss on 
disks that have been passed thrpugh 
the X-ray. One w~y to. s~y safe is to 
carry the disks in your hand and pass 

. ~em aroun~ the s~ner, telling the 
se,curity guard that they're magrietic 
media. While you may be the 
recipient of a strange look, it's better 
than ~ding your dis~~ ·have been. 
bulked accidentally. · 

Anoth~r way ofbringing disks 
through airline security, scanners .is to 
put them in a lead laminated pouch 
desigt)~d to hold photographic film . 
You can find these J,ouches at camera 
supply stores. · · 



Don't Touch the Actual Disk 

Don't touch the brown magnetic 
media that shows when you slide the 
metal sleeve aside on a disk. A single 
fingerprint is enough to render the 
disk unusable. 

Disks Aren't 
InfaJJible-Back Them Up! 

Make sure to back up your disks 
periodically. While this might sound 
like a waste of time and money, losing 
a crucial file or disk due to damage or 
magnetic interference will cost you a 
lot more in the long run-especially in 
terms of aggravation. 

Noisy Disks Signal Trouble 

If your disk makes more noise than 
usual upon being inserted into the 
disk drive, it might not have been 
aligned properly by the Mac. Eject it 
and try to boot it again. If a certain 
disk consistently makes unusual 
noise, back it up as soon as possible 
and don't save new data to it-the 
data could get lost or scrambled by 
the misalignment problem. 

If A Crucial Disk Bombs ••• 

If your disk bombs (sad Mac, black 
screen) when you try to boot it up, try 
rebooting it while holding down the 
COMMAND and OPTION keys. You'll 
lose folder titles and window sizes, 
but your data remains intact. 

DISKS 

Overwrite Sensitive Data 

Erasing sensitive data off a disk does 
not necessarily remove the 
information from the disk. To keep 
your erased information permanently 
erased, write another file on top of 
where the data used to be. 

Many Games Can Only Boot 
From the Internal Drive 

Some disks, especially commercially­
produced games, can only boot from 
the internal disk drive. Sometimes 
the machine will tell you that a 
heavily copy-protected disk is 
unreadable if you run it off the 
external drive. 

Disk Labeling Tips 

Always label your. disks with clear, 
individual names, and if they contain 
important files, mark the$8 on the 
labels as well. There's nothing more 
time-consuming than thumbing 
through a hundred or so disks looking · 
for the one that contains your most 
recent work. 

If you change the labels on your disks 
fairly often, you might find that sticky 
glue residue builds up on the label 
end. The easiest way to remove it is to 
dab a little rubber cement thinner on 
a Q-tip to clean the plastic without 
damaging it. 

Another trick for people who often re- . 
label their disks is to place Scotch 
Magic Transparent Tape over the disk 
labels. Then, mark all disks using a 
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Number 2 pencil. When you want to 
change the label, just erase the tape. 
Remember to brush upwards, ·so no 
eraser residue slides toward the disk's 
sliding ·cover. 

Yet another trick for people who 
change disk· labels frequently is to try 
Scotch Post-It Cover-Up tape. It can 
be written on easily, and it adheres 
and comes: off.disks easily. 

Th'e·ink from pens on labels often 
smears while disks are handled. To 
prevent this, apply a coat of clear nail 
polish over inked labels. 

You can use the Mac's printer dump 
feature to make disk labels right 
from your desktop. First, open the 
window for the disk you want to 
label. Then, choose BY NAME from 
the View menu to display the file 
names. Now, use the size box to 
shrink the window to the size of a 
disk label and type COMMAND­
SHIFT.;.CAPS LOCK-4 to dump the 
active windo~s image to your 
printer. Use tape to attach the 
labels, or else print out on a page­
sized disk label and trim the edges. 

Don't Use Caps Lock When 
Formatting 400K HFS Disk 

When formatting a 400K disk to have 
HFS (hierarchical filing system, used 
by the Mac Plus and newer 
machines), make sure your Caps Lock 

· key is not depressed, or the disk won't 
format properly. 
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Having Trouble~ Formattillg 
SOOKDisk? 
Sometimes you might have trouble · 
formatting a double-sided disk on the 
first try. If you do, one solution is to 
insert the disk, then format it as a 
single-sided disk. When the icon-. 
appears on the desktop, select it and 
choose ERASE DISK from the Special 
menu. Now, choose double .. sided · 
formatting, andyou.should be·~le ~ , 
initialize the disk without any further 
problems. 

Save Room By 
Defragm.enting Disks 

Sometimes you can clear .some extra 
disk space by using the Finder to .copy 
the disk to a different one. It could 
free up fragmentation of the files on 
disk, and sometimes results ·in a few 
extra K of disk memory. 

......_--JI Hard. Disks 

Unplugging A Hard Disk 
Erases All Its Data 

Never unplug a hard disk without 
backing it up, unless you really enjoy 
completely recreating all your files! 

Shut Down Before 
Powering Down 

Always use the Shut Down command 
before powering off. This decreases 
the time it will take to reboot; and 
virtually eliminates the possibility of 
data loss. 



Easy To Find Hard Disk 
Extension Cord 

Hard disks that use non-SCSI serial 
ports can be placed reasonably far 
from the computer by using a Radio 
Shack joystick connector cable as an 
extension cord. 

Solution For Slowed-Down 
Hard Disk Operations 

If your hard drive seems to have 
slowed down in its operations, it's 
probably because your System file is 
spread throughout the disk, 
requiring more time to access specific 
files. This happens when you modify 
the System file often. If the file is too 
spread out, you dramatically 
increase your chances of crashing. To 
restore the hard disk to optimum 
running order, back up the entire 
hard disk to floppies and then 
reinitialize it, creating a new System 
file. 

To avoid having your System file 
spread all over your hard disk as you 
add and delete fonts and DAs, create 
a few small dummy files, or a dummy 
volume, right after creating the 
System file. Give these dummies 
names that show the order in which 
they were created. Then, when you 
want to modify the System, delete 
some of these files to make room for 
the modifications. Hard disks run 
better if the System file is contiguous 
on the disk. 

HARD DISKS 

To Use a Floppy As the 
Startup Disk 

If you run on Apple's Hard Disk 20 
and want to use a floppy as your 
startup disk, hold down the mouse 
button while starting the machine, 
and the system will default to the 
floppy as startup disk. 

Paradise Hard Disks 

If you own a Paradise Hard Disk and 
are having radio and television 
interference problems, minimize it by 
placing the Paradise drive close to the 
Mac, coiling the cable that connects 
the units. 

Don't use disk caching when working 
with the Paradise Manager program. 
If you must use it, contact Paradise 
for software that allows it. 

Although Paradise hard disks include 
a replacement serial port for the one 
they use, this port won't support a 
modem. Instead of getting frustrated, 
connect the modem to the Mac's · 
modem port and connect the hard 
disk to the printer port. The 
Image Writer can be hooked up 
through the port on the Paradise hard 
disk. 

If you set the Paradise print spooler 
to zero, you'll find that you can't print 
at all. If you don't want to use the 
spooler, set it to the smallest size 
possible, greater than zero. 

You'll get faster Best quality 
Image Writer printing by not using 
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the spooler function. 

Closing a volume with the volume 
mounting desk accessory does not 
update the volume's desktop, which 
can result in loss of position 
information for your icons. Drag the 
volume's icon to the trashcan to Close 
it and update its desktop file, and 
your icons will be updated. 

Hyper Drive 

When you use a slash (/) in a drawer 
name, you can load that drawer on to 
the desktop by pressing the Command 
key and the character that 
immediately follows the slash. For 
example, to load the "PaintJDraft" 
drawer, press COMMAND-D. 

~~) RAMdisks 

DASCH RAMdisks 

Excessive heat can blow your 
RAMdisk. If you're using a DASCH 
external RAMdisk, be sure to keep it 
resting on its right edge, so that the 
power cord comes our of the top of its 
back. Also, put the four rubber feet 
shipped with the DASCH on the right 
edge to give it enough clearance for 
air to get into the cooling slot. 

If your DASCH external RAMdisk is 
connected to a 512K Mae with the old 
ROMS, you can keep the RAMdisk 
organized under the MFS file system 
without giving up the capability to 
useHFS: 

A Mae with the old ROMS and no 

hard disk can only be booted from an 
MFS floppy, but if the Hard Disk 20 
file is on the boot floppy, it will try to 
initialize any disk BOOK or 
larger-including an external 
RAMdisk-as HFS. When it does this, 
you'll lose the folder information, 
since files are copied from MFS 
floppies to the HFS DASCH during 
the bootup procedure. But there is a 
solution. 
Keep the Hard Disk 20 file off the 
boot floppy, so the Mac doesn't know 
HFS is there and initializes the 
external RAMdisk as MFS (keeping 
track of all folder information) on 
bootup. After you've filled the 
RAMdisk with everything you want 
from MFS disks, push the 
Programmers' Switch and reboot with 
a different floppy containing all the 
files you need for the Mae and 
external RAMdisk plus the Hard Disk 
20. Since the RAMdisk is already 
loaded, it won't copy any more files, 
but the HFS file system automatically 
gets loaded into memory, not on to the 
RAMdisk. It will now be available 
until you Shut Down, reset, or crash. 
Now, create HFS floppies to your 
heart's content. 

" ··-·-· .. Modems 

Quiet Dialing 

If you're using a Hayes-compatible 
modem and don't want to hear all 
those beeps and clicks during dialing, 
tum off the speaker using the ATMO 
command. To tum it back on, type in 
ATMl. 



If You Can't Connect, Tell 
Your Modem to Wait Longer 

If you have trouble connecting to an 
on-line service, ac:ijust the length of 
time the modem waits for a carrier 
signal before it hangs up and redials. 
The command ATS7=x sets the 
number of seconds the modem waits 
for a carrier. The default value for x is 
20 seconds, but you can substitute a 
new number of seconds for x. 

Don't Put Your Phone On 
Top of Courier 2400 

The Courier 2400 may look like it was 
designed to have a phone on top of it, 
but looks can be deceiving. If placed 
on top of a Courier 2400, your phone 
blocks the cooling vents and may 
result in overheating problems. 

If Your Courier 2400 Has 
ROM 241 or 242, Get a Free 
Replacement 

A few early Courier 2400 models were 
shipped with slightly defective ROMs. 
Check your version by issuing the 
ATIO command. If your ROM version 
is 241 or 242, call USRobotics at 1-. 
800-DIAL-USR for a free 
replacement. 

fn On the Desktop: 
~ TheFinder 

Label Your Application 
With Its Vers1on Number 

To know at a glance exactly which 

MODEMS.DESKTOP: THE FINDER 

version of a program you're working 
with, get in the habit of including 
the version number in the 
application's name, for example, 
Mac Write 4.5. The only files you 
can't do this to are system files like 
Finder, System, and Laser Prep. If 
you rename a system file, it won't 
work properly. 

Rename File, Folder or Disk 

You can rename a file, folder or disk 
by clicking once to highlight it, then 
typing in the new name. 

How Large Is Your Folder? 

The size of a folder isn't displayed in 
the directory window under any View 
mode. The way to find out how large a 
folder is is either to open it or to select 
it and choose GET INFO from the File 
menu. 

Put Minifinder Icon Into 
System Folder 

If you work with a MiniFinder, make 
sure its icon is put into the System 
Folder or it might have problems 
displaying installed application icons 
in its window. 

Finding Windows In a 
Hurry 

If you work on a cluttered desktop, 
sometimes the piles of folders and 
files make it hard to find a particular 
open window. Just double-click on the 
folder's dimmed icon to make the 
window active. 
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Express Route to Root 
Directory L~vel 

Close all open folders and return to 
the root directory level by holding 
down OPTION until the menu bar 
appears after you Quit an application. 

Moving Window Without 
Making it Active 

There's a way to move a window 
Without automatically making it the 
active Window. Press COMMAND 
while dragging the window by its title 
bar. 

Rebuild the Desktop · 

After receiving a "This disk needs 
minor repairs" message, you might 
have to rebuild the desktop file. Hold 
down OPI'ION-COMMAND while 
booting the disk to do this~ 

Get Info Comments Lost 
· When You Rebuild Desktop 

Any comments entered into the Get 
Info dialog box are stored in the 
desktop file. If you have to rebuild 
this file, your Get Info data will be 
lost permanently. 

Don't Use Colons in a File 
Name 

Never use a colon in a filename. 
. That's because colons are used to 
separate filenames from volume (disk 
names), and when you use one the 

· Mac looks for the file on the volume in 
front of the colon. If there's no volume 
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by that name, you'll get an error 
message. 

Ejecting Disks 

Need to eject a disk quickly? Drag its 
icon into the trash. This ejects the 
disk, eliminates any windows it was 
displaying, and ensures that the Mac 
won't ask for it again if you open 
another file. 

Another way to eject is to press 
COMMAND-SHIFT-1. However, this 
leaves the ghost of your disk icon on 
the screen, and you might be asked to 
reinsert it when you launch another 
file. 

The fastest way to eject a disk from 
the external d;rive is to press 
COMMAND-SHIFT-2. 

Eject both disks simultaneously by 
pressing COMMAND-E, without 
selecting any icon on the desktop. 

If you really get stuck and have to eject 
your disk, turn the power off on the 
Mac. Then, holding down the mouse 
buttonl turn the power back on. Don't 
release the mouse button until the disk 
has popped out. This only works with 
the internal disk drive. 

When all else fails-and only when all 
else fail&-you can free a trapped disk 
by unbending a large paper clip and 
inserting the straight end into the 
tiny hole to the right of the disk drive. 
Wiggle it (carefully!) until you feel it 
push the inner mechanism to eject the 
disk. This method doesn't work as 



well on BOOK disk drives as it does on 
older 400K drives. 

With One Disk Drive, 
Opening Files On Non­
System Disk Is A Drag 

If you're using a single-disk system, 
try not to open a file on one disk with 
an application on another, since it can 
mean interminable disk-swapping 
... and eventually, a sore wrist! 
Instead,.bring the file over on to the 
application disk before opening it. 

Games Access Disks 
Frequently 

Many games access the disk 
frequently during play, creating a lot 
of wear and tear on your disk drive. 
You can save a lot of disk access by 
placing the games and their System 
files on a RAMdisk, using the original 
disk as the key disk to allow the 
program to verify its copy protection. 

When the Macintosh spits a disk out 
at you, the disk needs a System and 
Finder on it in order to be read by the 
machine. Access the machine through 
a different disk, then, on the desktop, 
drag the System and Finder icons to 
the other disk to copy them on. 

When You Get the Dreaded 
"Sad Mac" ••• 

When the Macintosh adds insult to 
injury by making a "sad Mac" face 
{complete with funeral-black screen) at 
the·same time, take note of the number 
code displayed underneath the Mac. If 
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you call Apple Technical Support to find 
out what's wrong, that number can help 
staffers pinpoint the problem. Again, 
you can probably still access the clisk by 
booting another one first. 

When the "sad Mac" face is 
accompanied by the code OFOOOD, 
chances are that your Programmers' 
Switch (the plastic tab on the left side 
of the Mac) is jammed or improperly 
installed. Tum the power off, then 
reinstall the switch using your 
Macintosh owner's manual 
instructions. 

When the "sad Mac" is accompanied 
by the code OF0064, the startup disk 
is missing its System file, ot: the 
System has been corrupted. Copy a 
System file onto the disk by booting to 
the desktop with a different disk. 

If you get an immediate bomb with 
ID = 26 when you launch an 
application, chances are that your 
application is damaged. Use your 
master copy to create a new backup 
and try again. 

Take a MacPaint "Photo" of 
Your Screen: Screen 
Dumping Made Easy 

Want to take a MacPaint 
"photograph" of what's on your 
screen? Press COMMAND-SHIFT-3 
to make a "screen dump." When you 
go back to the desktop, you'll see a 
document entitled "Screen o·." You can 
open, modify or print it using 
MacPaint, or any other program that 
recognizes a PICT file. {Note: This 
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may not work if you're using game 
software, or other applications in 
which the System has been modified.) 
You cail take up to 10 screen dumps 
per session with a single disk,· if disk 
space permits. 

You- can delay a screen dump from 
taking place by holding down the 
mouse button until the exact screen 
action you want is taking place. Then, 
release the mouse button and the 
screen automatically dumps to a PICT 
file. 

If the Macintosh beeps while you're 
trying to create a screen dump, it's 
because there isn't enough room left 
on the disk ·to create a PICT file. 
Empty some files from the disk and 
try it again. 

If you want to send the image in the 
active window on your screen straight 
to the Image Writer printer, press 
COMMAND-SHIFT-4. 

The entire Mac screen contents can be 
printed by pressing COMMAND­
SmFT-CAPS LOCK-4. 

Get the Time (and Date) of 
Day In Your Document 

To put the time and/or date on your 
document, choose Alarm Clock from 
the Apple menu and select COPY 
from the Edit menu. The current time 
and date will be placed on the 
CUpboard, from which you can paste 
them into the document. 

Unlock Files and Folders 
For Disposal 

Press the Option key while dragging a 
locked folder or file to the trashcan to 
automatically unlock the file for 
disposal. 

Duplicating Files With 
Finder5.4 

If you're using Finder 5.4, try holding 
down OPI'ION while dragging a file 
into a folder. Instead of moving the 
file, the new Finder duplicates it and 
places the copy (with the same name) 
into the folder. 

Launching Applications 
With Multiple Open 
Windows 

A number of applications allow 
several windows to be open 
simultaneously (although you can 
only work in the active window). Start 
those applications with windows 
already open by selecting multiple 
documents in the Finder and then 
clicking Open on the File menu. 

How Long Do Files Stay in 
the Trash Can? · 

Files thrown into the trash can remain 
there until you launch and application, 
choose Empty Trash from the Special 
menu, or take any other action that 
requires you to leave the desktop. A 
good rule of thumb is: if you aren't sure 
whether you want to throw a file away, 
don't put it in the trashcan unless you 
back it up on another disk. 



Superfast Cleanup on the 
Desktop . . 

·;i 

Ifyou~te using Finder 4.l·or higher · 
(and if you aren"t, get ·down to yow·, 
Apple dealer and get·one!), bolCi' down 
the Option key whih~ ·selecting Clean 
Up Window for a superfast .cleanup 
that places icons near the top of the 
window. 

Organizing Files Under 
MFS 

1 ! , 1 , r 

If you aren't using the new· ROMs and 
have no desir~' to-liSe1 the n~w HFS 
system, there~~ an easy way :to 
organize related groups of files for 
easy access from~ Within an 
application. Give a common prefix to 
each·eategory (su~h' as INV -to denote 
invoices). In an Open dialog box, all 
the files with the same prefix will be 
listed together. 

lrista1ling:HFS on a·400K 
Disk } f ·.· ·• 

HFS can be installed on a 400K disk, 
although the instructions in the Mac 
Plus manual's original printing were 
wrong. Put the disk in the internal or 
external drive and choose ERASE 
DISK from the-Special menu. Hold 
down the OPriON key during the 
entire initialization process .. 
Remember th·at 1&n HFS directory 
takes up more room than an· MFS 
'eqUivalent, so you'll have less work 
space on your 400K disk than you 
would Wider MFS. · i · 
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Use View By Date ~to Know 
Which Flles Should Be:· · 
Backed Up 

When you're backing up floppy disk 
data, use the View by Date· mode on 
the desktop to figure out· which files 
have been changed: and th.~refore '· 

· · have to be backed up. : ·., . 

:·-Different:Des~GkView ·. 
Modes'Behave · e 

.r ··, 

.If you choose~:tO\tiew Y.Ou,r~de$ktop_by 
another mode than large~ieon.~.~-~you'll 
find you can work with these the 
same. way you can with latrger icons. 
You canmove.them~ re~ame ·them, 
copy them, and double-clic!Q to:.op_en 
them. I .-. 

I I 1 ,~ . 

Alphabetizing Your.Des~top 
Icons ~.. . ·. · 

. ' 

. There's a relatively easy way to 
arrange all the icons on your desktop 
alphabetically. Start by bringing the 
window you want to sort to the front, 
and choose BY NAME from ·the View I 

menu. Then choose SELECT ,ALL 
from the Edit menu and drag all th..e 
files to the desktop. Once;this~is-done,: 
select BY ICON front the View:menu. . 
Now, close the window you want 
sorted and drag all the files back over · 
to the icon that represents,the closed : 
disk or folder. The next time you open 
that, disk or folder, you'll~eth~t all 
the files have been alph~ijcally 
arranged. 
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Viewing· Folder Sizes in 
Different:View Modes 

When displaying the contents of a 
disk using.any View option other than · 
the icon or. small icon, :folder sizes 
aren't shown. Only a pair of dashes 
are ·displayed. Opening-any folder 
within that window·reveals the size of ' 
the folder where the dashes appear. 
By organizing these windows 
efficiently, yo;q;c;au~easily see the ~es 
of any of yQur~folders without.bavitJ.g 
to constantly choose Get Info. 

·Has SOmeone €hanged'. Your 
'DefaulttPont?· I ~ . 

lfyou'r.e not the· only one. ~ing your 
Mae, you might boot up the machine I 

one:·day tO find that"your desktop font · 
looks· strange. The default font might 
have been changed with an 
application such as the Change 

· · ApPJ.ieationfRont desk accessory or 
application, or PRAM2. The best 
solution is to remove the Mae's 
battery for· at:least 30:iseeonds to clear I 

rits memory£ ·1 · 

. If·that· doesn't work, your System 
might{have•been .. modified to. remove 
an "unremovable" font. Try' starling 
up1 With ariother disk that contains ·a 

. ::·complete. System ·file (you can use any 
.commercial disk for this purpose)~~·· 
Finally,. if you're still having 
problems, replace the,·Mac's battery. 
Iteould'have·,wom out. 
.. _;.·. '<' " ; j I 

:The ·Fast~way to Switch 
Startup~Disks · 

30 

You can switch startup disks to. make 
a newly-inserted disk the startup by 
opening the new disk while on the 
desktop. Then epte;r ~e Syste~ file 
and,.holding down COMMAND- } . 

· OPI'IO.~, double-click on the Finder 
icon. After -the disk drive stops 
whirring, the ne~w dislt will occupy the 
startup positi~n -on ~e qeskwp .. 

Tips on Copying Files 

Avoid having file.s.: called ~copy of (X)" 
by copying files to· a dif¥erent dis~·:: . : 
Just drag the file icon to the · · .. · · 

· destination disk icqn. When the.; · · 
destination diek j~ -highlighted black, 
release the mou.se button. The file will 
copy to)thttnew disk, and you'll:still 
keep it on-y()u.r- :old 'disk. 

.. 
If you want-to copy:eve~gon. a. disk . 
ex~pt a few files, put the unwanted .. 
files .on the desktop, out of~e windQw, 
before dragging your S:Ource di~s ~eon 
to the destination disk. 

Remove the Find~:r. tQ Say~ 
Disk Space 

If you find yourself running out of 
disk space .on a constantly us.ed 
application, removing the Finder, . 

:from: the disk.saves about 47K. Do 
this~by starting up with another 
disk, thep put~ing i_n the -disk yo11 
want to, doctor .. an~ ~r~gging it$ 
Finder ~eon to .the t.rf1shean .. Then 
click once on ·t~~ appJi.qatioq you 
want to run ;apd select a~t Startup 
from the File menu. When you Quit 
the _application, you'll be greeted· 
with an ominous Bomb dialog box, 
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but don't worry-the only thing you'll 
lose is the contents of your 
Clipboard. The way to stop Bombing 
when you leave the application is, 
simply, copy a new Finder on to your 
disk and choose .the Set Startup 
routine again. 

Bypass··the Minftnder and 
'Return to the ;Desktop· · · 
. • 'I . . 

If you have aMinifinder installed on ' 
your disk, you know~-that when, you 
Quit an application, you'll default 
back to the Minifinder, not the 
desktop. But hold doWn OPTION·~ 
when you quit an application, and 
you'll bypass Minifinder and go 
directly back to the desktop. Just be 
careful not to hold the COMMAND 
key as well, since if you do the Finder 
will rebUi\d yoUr Desktop tile and all 
your folders will be renamed 
"Unnamed ## ••• " 

Cut, Copy and Paste are 
Univers~ll: · . 

Cut, copy and paste functions are an 
integral part of the Mac. If the 
application you're running doesn't 
have these options in the Edit 
menu-or if it doesn't have an Edit 
menu atall-- the cut, copy and paste 
functions shoUld stiU be there. Use·A 
the command key equivalents 
(COMMAND-C\c) copy, COMMAND­
X to cut and ~coMMAND-V to paste) 

· to~ aceess these functions. 

[m::!) General Information. 

Command Key: Equivalents 
Work-in Dialog. Boxes 

Each button in the dialog boxes 
responds to-a Command key; Among 
commands that work: COMMAND-D 
to switch disk dtives;. COMMAND. E 
ejects disks;,COMMAND-period · . 
cancels commands. 

Templates.S~ve .. Time.-- · 

lt's~easy~to~create document templates. 
that 3'QU~an.--use again and again. 
Make yourJilank- document.in , 
whichever application y.ou choose · 
(MacWrite, MacPaint, MacDraw,-
ete~): 'fhen,. each time you till in the 
form, choose. Sav.r-As .•• instead Of !. 

Save. The:.original document remains 
pristine and ready to be filled out , 
again, and you'll have an on-disk copy 
of the completed.fonn for your -
records. 

~. t. 

'"). 

Keyboard-Buffer Stores 
Typing' .•. •, ; I 

., .. 
When saving a new document or,., .. 
using Save As ... , you can type ;_the ·, 
name of the document before the Save 
dialog appears, since the keyboard 
buffer stores the characters in-. , ~~ 
memory. If you're a good typist, you 
can· type the naine and'press Return, i 

and yc;>u11 begin the Save alm.ost _ .'/! 
immediately~ . · ::_: . ~:: 1• -
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Caps Lock Doesn't Disable 
Numbers or Punctuation 

When typing something in all caps, 
you don't have to.:remove the caps lock 
to type numbers, commas, periods, 
apostrophes or slashes. The Mac 
automatically-assumes you want 
these characters, not the symbols 
above them. If you want to use a· 
symbol while in-.caps-lock mode, press 
SHIFI' while typing the appropriate 
key. 

Lock Your Flle To Prevent 
It From Being Altered . 

· You can protect a file from ~g. 
mistakenly altered by~.selecting.it on 
the desktop,·chodsbig. Get Info, and 
clicking in the box next, to the word 
"Locked.~ The docliment .will not.be 
able to be changed again, until the 
Lock box is clicked on again, to 
deselect it. This does not,affect any· 
other tiles or applieatioiis on the disk. ' 

;;- , )- .. .-f j (. I 
Is This Ffie.LOcked? 

There's an easy way to check whether 
a file is locked or not on the desktop. 
Just select·the file and move the 
cursor over its filename. If th~.~le 
isn't locked, the cursor changes ·shape 
to an I.;beam./Ifit is locked, the cui'sor 
remains ·an aTrow. ..<· · 

. Y:( : . ~ 

Be Cllreful About Naming 
Files d·. , ; . 

. Don't name tiles using words that the 
Mac could mistake a8 part.of your 
operating system (such'-as 
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"Minifuider"). This can confuse the 
machine and· result in lost or 
damaged files .. 

Superceding Alphabetized 
Minifinder Names 

Sometimes you might want to access a 
file or folder quickly, without having to 
scroll through the alpruilieti~ 
Minifinder listings to find it. Add a bullet 
(OPI'ION-8) as a prefix to the filename, 
and that file or folder will always appear 
at the top of the list of. files. 
Numbers also take precedence over 
alphabetical titles. 

Take the Express Route 
Through Mini finder Box 

There's .a faster way to find files than 
scrolling, through a minifinder box.. 
Just press the first letter or, two of the 

(file name you want to find to take the 
express-route to your selection. 

Open Files The Easy Way 

Once your file !)ante has be~n 
highlighted iD bia~k in the muufinder 
box, you can just press Return and 
the file will open. 

Another way to open a file in the 
minifinder scroll box is !to sjmply 
double-click on its name. 

,: :-: -

When You Launch an 
Application By:Mistake 

At.one time ~r another, just about 
everyone launches1an applica.tion by 
double-clicking it by mistake. Instead 



of waiting for the program to launch, 
then quitting, try pressing 
CO:MMAND-period to go right back to 
the desktop. This command also can 
stop multiple file transfers from 
within the Finder, once the file it's 
already working on has been 
completed 

Finder 4.1 Lets You Cancel 
Dialog Boxes With 
Command Keys 

You can use COMMAND-period to 
cancel all standard dialog boxes 
(those are the ones you get when you 
choose Open or Save) when using 
Finder 4.1. This works for all 
applications. 

Close Desk Accessories 
Before Shutting Down 

When you issue a Shut Down 
command, Finders 5.1 and 5.2 both 
fail to close desk accessories, and they 
don't send a GoodBye-Kiss. This 
causes DAs with open files to glitch in 
more ways than we can mention. 
When using either of these Finders, 
make sure all DAs are closed when 
you shut down. 

Don't Duplicate Files in 
Trash Can 

Finders 5.1 and 5.2 crash if you try to 
duplicate a file in the Trash can. 

Re-File What You Rescue 
From the Trash 

In any of the Finder 5.x series, if you 
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drag a file out of the Trash and on to 
a different volume, the file will be 
permanently removed from the Trash 
and the destination volume. When 
you want to remove something from 
the Trash, be sure to put the file back 
in the folder you took it from .. 

Save Disk Space by 
Removing Fonts 

If you find that disk memory is a 
problem (as it often is for single drive 
users), slim down your System file as 
much as possible by removing all but 
the most necessary fonts. 

Reduce Clipboard Size U 
Memory Is Short 

To preserve memory while working in 
an application, reduce the size of the 
Clipboard by copying a single letter 
into it. 

Dialog Boxes Allow Flexible 
Responses 

You can answer standard questions 
like "Save changes before closing?" by: 
clicking on the button displaying the 
answer you want; or hitting return to 
select the b9x with the heavier border; 
or typing iri Y for yes or N for no. 

The Hidden Character in 
Most Fonts 

There's a secret key combination 
that's not shown in the Key Caps desk 
accessory. Press OPriON-SHIFl'­
(the key just to the left of the 1) to 
access it. Depending on the point size 
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and font selected, you'll come up with 
interesting, and maybe useful, 
shapes~ For example, in 12-point 
Geneva, the combination results in a 
silhouette of a rabbit. 

Use Calculator to Paste In 
Equations 

If you do a lot of mathematical 
calculations, there's a faster way to do 
it than just working the problem out 
with the calculator DA and typing it 
in. If you're typing a mathematical 
formula into a document, just type it 
in up to the = sign, then choose the 
Copy option from the Edit menu. 
Summon the calculator desk 
accessory and choose Paste from the 
Edit menu. As soon as this is done, 
the calculator automatically presses 
the right keys and arrives at your 
answer. Then, just select Copy again, 
close the calculator, click the cursor 
right after the = sign, and choose 
Paste. Your equation result will 
appear where you want it, although it 
will always appear in Geneva font, so 
you may have to change this. 

SOFTWARE 

~ Airborpe! 

34 

A Christmas Present for 
Gamers 

There's a special Christmas gift 
embedded in the program. On 

December 25, the cactus turns into a 
Christmas tree. To see this on any 
other day, just use the Alarm Clock 
DA to set the Mac's calendar to 
December 25. 

EiJ Ancient Art of War 
When Taking A Fort, Back 
Up Archers With Second 
Squad 

· Using archers alone to overrun a fort 
can inflict a lot of casualties on your 
army. Try sending two or more groups 
(barbarians or knights) with a few men 
to occupy enemy archers. Then send in 
your regular units, so.that they can 
sneak over the wall while the enemy is 
already engaged. This means the 
battle takes place in the courtyard and 
not at the base of the wall. 

The Coward's Way to Inflict 
Casualties 

If your squad of archers is fighting 
another squad of archers but you're 
outnumbered, fire a barrage of arrows 
and then retreat. The arrows still 
move when you're not on screen, and 
you can therefore whittle down enemy 
forces without any casualties of your 
own. 

Let Non-Archer Squads 
Attempt to Take Your Fort 

If an enemy squad containing no 
archers attacks your fort, don't zoom in 
to take a closer look at the battle. The 
attackers won't be able to retreat then, 
and they'll eventually all be killed. 



Screen Dumps Don't Work, 
But •.• 

If you try to make a screen dump 
using the standard COMMAND­
SHIFT -3, it won't work. But 
COMMAND-ENTER takes a PICT. 
file screen snapshot, which you can 
edit in any graphic program. 

You Don't Need An Army To 
Capture a Flag 

To capture a flag without moving a 
full squad to do it, detach and form a 
new squad with only one man. Then, 
just send him to the flag. It doesn't 
matter how many men are in a 
squad-to capture a flag, one is 
sufficient. 

LID Alarm Clock 
(Desk Accessory) 

How To Keep Alarm Clock 
Active While You Work 

You can keep the Alarm Clock in 
sight while you work in an 
application. Just open the DA and 
move it to the highest possible 
position on the screen, then move 
your active work window down. Even 
though the Alarm Clock window won't 
be active, it still continues to work. 

~Chart 
Widen the Window Before 
Starting Work 

Always widen the window, chart area, 
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and plot area to their maximum 
settings before you start ·working. To 
access the underlying series of · 
windows, use COMMAND-L (List) .. 

Extra-Long Text in Headers 
and Footers 

It's possible to create text in a header or 
footer entry J;>ox that's longer than the 
box itsel£ To edit the longer text, get at 
it by placing the cursor in the visible 
text near the right end of the entry box 
and then dragging off the end to scroll 
the text left and display the extra text. 

Embedding Formatting 
Commands in Headers and 
Footers 

You can embed formatting commands 
and other instructions in the text of 
the header or footer. These co~mands 
can be inserted in the Page Setup 
dialog by typing the & and a letter 
simultaneously: 
&L: Align the characters that follow · 
at the left margin; 
&C: Center the characters that follow; 
&R: Align the characters that follow 
at the right margin; 
&P: Print the page number; 
&D: Print the current date; 
&T: Print the current time; 
&&: Print a single ampersand (&). 

Use White on Labels That 
Overlap 

When using labels that overlap other 
parts of the chart, select a white 
background to avoid having pixels from 
the overlapped lines show through. 
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Add Legends Before 
Formatting 

If you'll need a legend on your Chart 
document, add it before you start 
formatting, since Chart rearranges 
everything to make room for the 
legend. This rearranging can make a 
mess of your best-laid plans. 

When You Link Chart Files 
to Multiplan 

When linking Chart files to 
Multiplan, choose the type of data 
first or else each series will be out of 
step and categories and values will be 
transposed. Also, changing the 
typeface of a linked series can 
sometimes un-link the two programs 
without warning! 

Margin Settings Determine 
Printed Size of Charts 

Chart uses the margin settings 
established in the Page Setup dialog 
box to determine the printed size of a 
chart. If you want to change the size 
of your printout, just change the 
margin settings. 

Let Chart Do Your Math For 
You 

When you're creating a pie chart, let 
Chart do the math for you. Just enter 
the actual figures and let it calculate 
percentages. Otherwise, you won't be 
able to use percentage labels on your 
sectors, and you'll find that other 

statistical functions will be disabled 
as well. 

Modify Chart Files to 
Create Sequences of Pie 
Charts 

You can modify Chart files with 
MacPaint or MacDraw to create a 
sequence of pie charts on a page. Use 
the Plot Area grab handles from 
Chart to resize each chart before 
positioning and deselecting them. 

Exporting Charts to 
MacPaint 

When copying charts to MacPaint, 
choose the option to copy "As it 
Appears on the Screen." Otherwise, it 
won't fit into your drawing window 
after it's pasted in. 

When You Can, Modify 
Chart Files in MacDraw 

MacDraw works very well to enhance 
Chart files. Its main advantages over 
MacPaint are that it can accept a 
chart in its full printed size, and after 
Pasting, the elements of the chart 
remain individual elements that can 
be manipulated independently of each 
other. 

Intersecting Gray Areas 
May Print Blurred 

Intersections of gray areas that are 
easily distinguishable on-screen 
might print a bit blurred, especially 
on the ImageWriter. Use dark 
outlines to emphasize each figure, or 



else alternate light and dark colors for 
best results. 

Tips For More Effective 
Charting 

Dark patterns are much easier to 
understand, so as a general rule of 
thumb, use the darker patterns to 
display the most important figures. 

Horizontal column charts are best 
suited to comparisons of series with 
few numbers and wider, less ordered 
variations. 

Line charts are best used for 
displaying trends in time, where the 
relationship between two date figures 
is more important than the 
relationship between the target and 
actual figures. 

Pie charts can only be used when your 
data adds up to 100 per cent. Plus, 
each sector must exclude all members 
of the others. 

In designing charts, as in any other 
graphic, remember that when in 
doubt, simple is best. A chart 
cluttered with too many labels and 
patterns will be too distracting to be 
effective. 

Create Templates to Save 
Time 

Whenever you create a new kind of 
graph or chart, keep a copy in a 
library folder, since modifying an 
existing chart is a lot easier and 
faster than creating a new one from 

CHART-CHOOSER 

scratch. In creating a template, avoid 
using non-automatic text areas, since 
these will remain even after you've 
entered new data. When you use the 
template, remember to Save As ... and 
then name it, to keep your original 
template clean and clutter-free. 

Save As You Go to Prevent 
Confusion, Mistakes 

As you work, save a number of 
versions along the way, since the 
formatting commands can be complex. 
This helps you avoid confusion, or 
worse, time-consuming mistakes. 

LID CheapPaint 
(Desk Accessory) 

Opening Multi-Scrap Files 
From CheapPaint 

This program can access multiple 
Scrapbook files, much like the 
shareware DA Multi-Scrap. 
Unfortunately, files created with 
Multi-Scrap can't be opened directly 
from CheapPaint. Fix this by using 
ResEdit or other editing program to 
change the TYPE from SCRP to ZSYS 
to access Multi-Scrap files in 
CheapPaint. 

LID Chooser (Desk Accessory) 

Embedded Message 

You can find the Chooser author's 
name embedded in the program by 
clicking in the version number on all 
Chooser versions 3.0 or higher. 
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Only Use Chooser With 
Recent Printer Drivers 

Only use Chooser with Image Writer 
Driver 2.1 or higher and 
LaserWriter Driver 1.1 or higher. If 
you are working with lower version 
numbers use the Choose Printer DA 
instead. 

Making Semi-Permanent 
Printer Setting Changes 

Upon startup, the Mac loads the 
contents of the battery-supported 
Parameter RAM (PRAM) into a low 
memory portion of RAM. If you use 
Chooser to make changes to printer 
settings, the changes will be made 
only to the copy of PRAM residing in 
·RAM. The Mac doesn't alter the 
PRAM settings when it's turned off. 
But you can trick the Mac into 
changing the PRAM settings to make 
the changes you want in Chooser, 
then closing its file. Then select 
Control Panel and make a change on 
any control, either leaving it changed 
or resetting it back to its original 
setting. Now, close Control Panel and 
the Mac alters PRAM settings for 
both Control Panel and Chooser, 
retaining them in battery-supported 
PRAM. 

38 

Auto Disk Cache Only 
Works With 128K ROMs 

The Control Panel shipped with 
Finder 5.0 and higher includes a 
panel which sets an automatic disk 
cache for your Mac. This only works 
with the new 128K ROMs. 

Some Older ROMs Have 
Trouble With Key-Repeat 
Setting of Zero 

The startup ROM misinterprets a 
Key-Repeat setting of zero. Although 
this setting should turn off the key 
repeat function entirely, the Mac 
interprets it instead as a message to 
repeat as fast as it can. The problem 
has been fixed in the newer 128K 
ROMs. 

[l!l:lj ConcertWare 
Keep Instruments In Same 
Folder as Player File 

If you run Concert Ware under HFS, 
keep all your instrument files in the 
same folder as the Player or the 
program might tell you it can't find an 
Instrument. 

LID Control Panel 
(Desk Accessory) 

Accessinl the "Secret 
Message 

If you use Control Panel version 3.0, 
there's a "secret message" embedded 
in your program. When Chooser is 
active, click on the "3. 0" to see it. 

You Don't Need Control 
Panel on All Your Disks 

Settings changed with the Control 
Panel are recorded in the Parameter 



RAM maintained in the battery. That 
means, when you change from one 
disk to another, control panel settings 
carry over to the disks you put it after 
the change. Unless you have to 
change settings according to the disk 
you're using, remove the Control 
Panel from most of your startup disks 
once it's set to save about BK. If the 
battery goes dead, you'll have to reset 
the Control Panet · 

The one exception to the rule above is 
the desktop pattern on your startup 
disk. This is saved to the particular 
disk you're using. If you want to 
change the desktop pattern on a disk, 
make sure the Control Panel is 
installed. 

[m:J)copy II Hard Disk 
Installing Copy-Protected 
Programs to a Hard Disk 

You can use Copy II Hard Disk to 
install copy-protected programs to a 
RAMdisk. This prevents you having 
to go through the key disk routine 
when ·running some applications,. and 
also allows· some applications to run 
on a RAMdisk if they normally 
wouldn't. 

Moving Copy-Protected 
Programs From 400K to 
.SOOKDisks 

Copy II Hard disk should be used to 
move copy protected applications from 
400K to BOOK disks. First, format an 
BOOK disk with a System folder ·that 
contains System files, Finder, printer 

CO_NTROL PANEL-CRICKET·D~AW 

drivers, and the desk accessories 
you'll want. Then, treat the external 
drive like a hard disk and use Copy II 
Hard Disk 5.2 or higher to install 
your copy protected appli~ation on 
your disk. 

[f:lj Copy II Mac 
Use Copy ll Hard Disk to 
Transfer to Double-Sided 
Disks 

Some versions won't transfer a 
protected program from a singl~sided 
disk to a double-sided one. Use Copy 
II Hard Disk, included with Copy II 
Mac, and set the target double.;~ided 
disk as the hard disk voliline to write 
the protected program to.-The 
protected program shoul~ then run· 
from the double-sided disk, but this 
doesn't always work. 

ltllcricket Draw 
Use Align Objects ·to Control 
Object Placement 
Completely 

This program_contains alittle~known 
trick that allows users to gain total 
control of object placement using the 
Align Objects command. The ordering of 
objects drawn does not depend on their 
creation order or positioning, but rather 
in their layering. That means selecting 
an object and choosing Bring to Ff9nt 
from the Arrange menu will_later make . 
that object the point of reference for 
future Align commands. For example, 
when you have an object you would like 
to align other objects with, select the 
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item and choose Bring to Front from the 
Arrange menu. Then, SHIFI'-CUCK 
the other objects you want aligned, and 
choose Align Objects from the Arrange 
menu. Regardless of the alignment 
done, the object on the top layer will 
remain in its original position. 

Ungroup Objects For Faster 
Printing 

When you work iq documents that 
contain a large number of grouped 
objects, you can save some printing 
time oti the Laser Writer by ungrouping 
your objects just before printing. 

§t;i~Crunch 
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Cells That Once Contained 
Values Always Occupy 
Memory 

This program doesn't allot space to 
cells in memQry until you enter a 
value. Once a cell has contained a 
value it occupies memory, even if you 
remove the value later. That means 
you should avoid opening cells unless 
you intend to use them. Also, organize 
and limit the shape of your work area 
before entering values for best results. 

t Cyborg 
Run Cyborg on a Mac Plus 

While this game program isn't 
supposed to work on a Mac Plus, don't 
throw away the disk just because 
you've·upgraded. First, make a coy of 
the master, then use any .file utility 
like Fedit or HFS Locator Plus to 

rename the Finder on the Cyborg disk 
to anything other than "Finder." 
Then, reboot the Mac Plus with the 
current System and Finder, and 
insert Cyborg in the external drive. 
Double click on the icon and you're off 
to the adventure. If you only have an 
internal drive, use a RAMdisk to load 
the current System and Finder. 

jf Dark Castle 
Experts Can Track the 
Number of Times They Win 
ina Session 

If you want, you can keep track of 
how many times you've toppled the 
throne. When typing your name into 
the Hall of Fame, type OPI'ION with 
any other key. This produces a Dark 
Castle symbol Use the number of 
castle symbols to represent.how many 
times you've finished the mission. 

Unlimited Shields 

The shield usually lasts for 3 seconds 
or so. Butyou can keep wearing it 
indefinitely. When you use the shield 
key, hold it down for about 2 1/2 
seconds. At the last moment, release 
the key and then press it again 
quickly. Experiment with this to pick 
up the rhythm. 

How to Walk on Air (In the 
Game, Folks, In the Game) 

It's possible to "walk on air" in this 
game program. Press the duck key 
with either the up or down key as you 
go up or down a staircase or ladder, 



and when-you reach the top or bottom 
your character will walk on air. Once 
there, it's fun to experiment with 
different commands~ You'll get 
unusual results! 

Express Route to the 
Trouble Room 

To get to the Trouble Room quickly, 
push Door Number Three. You'll go 'to 
the Black Knight's first chamber. If 
you wait, the platform will slip out 
from·under you,. dropping your . 
character down to Trouble #3-saving 
the .trip through the first two rooms, 
and possibly saving a few game lives. 

..li. Deluxe Music · .. 
IP: Construction Set 

Hook Up to Your Stereo 

There~s' a way to get really great 
sound from the 128K or 512K Mac 

· .. when working with music creation 
programs. Hook it up to your stereo 
With- a cable that has a mini phone 
plug on one end and a pair of phono 
plugS on the other. Put the phono 
plugs into the equivalent Atnejacks 
on your stereo, and then fit the mini 
phone plug into· the back of the Mac, 
near the modem port. Then, use the 
Control Panel DA to turn the volume 

· slider ·a11 the way down, since if you 
don't the music will distort. Then just 
turn the stereo on (set it to Mono) and· 
compose to your heart's content. 

When running the Mac through an 
audio system,:select the External 

DARK CASTLE-DESK ACCESSORIES 

Speaker option to remove the . 
software "filter" that equalizes-the 
sound especially for the Mac. 

Incompatible With Hard_ .. · 
Disk ,I 

DMCS doesn't work with a hard disk. 
When the copy protection would 
normally prompt you to insert your 
key disk, it will bomb instead. 

Don't Modify the System 
Fonts 

.. Never modify the system .fonts in . 
D.MCS, since it uses special musical 
notation fonts . 

Only Save When-You Have 
Enough Room On-Disk 

Make sure you have plenty of room 
before saving a file. If you don't have · 
enough memory on the disk, the 
program could destroy the file instead 
of prompting you: to insert a new disk. 

rJjJ Desk Accessories · 
(Also look under specific. 
DA names) 

Use Up to 15 Desk ·: :_ 
Accessories 

You can place up to 15 d's~ .. -. 
accessories under the Apple menu in 
each System file.. ,.. ., 

.. 
Always Leave One:DA On· 
Disk 

• • • !~ • 

If you want to remove a~ -many)~~ 
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as possible to save room, remember to 
leave ·at least one on the disk. If you 
remove the· only desk accessory in a 
System, you'll inadvertently destroy 
the.System;file. The only remedy for 
this is to reinstall one DA to the . 
corrupted System. .. 
How Much Boom Does Your 
Desk Accessory Fill? _ _.. 

The following chart shows the disk 
space .required for standard desk. 
accessories: 
Accessory 
Alarm Clock 
Calculator 
Choose Printer 
Chooser 
Control Panel 
Key Caps (old) 
Key Caps (new) 
NotePad. 
Puzzle 
Scrap~ok (empty) 

Bytes 
1·• 4069 

2505 
5802 
8311 
7457 
1645 
2641 

·' 2595 
963 

3256 

Close DAs At End of· Work 
Session 

Close desk accessories tha~ ~Y be 
open before quitting an application or 
shutting down. Otherwise, you can 
damage files. · 

Link DAs Directl to ~. y 
Applic•tions ' ~ : . . . \ ~ . -. 
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You can attach desk accessories 
directly to the applications you use 
them with, instead of to the System 
file. This lets you exceed the 
maximum of15 DAs recommended by 
:Apple. JUst· launch the FontJDA 

Mover and you'll see the fonts and 
DAs from the System file in theJeft­
hand window. and. a blank window 
with an Open button in the right­
hand window. Hold down OPTION 
while clicking on the Open button and 
the disk window that appears allows 
you to Open any file on the disk to.· 
install fonts or DAs. 

Set the Alarm From the 
Keyboard 

You can set any section of the AlariD. 
Clock from the keyboard Just select 
the ·element you want to change, and 
type in tb.e ·setting you want. Move 
from one element to the next by 
hitting the Tab key. You can't change 
the AM. or P.M. settitlg by typing, 
but you can type in :the time in a 24-
hour format instead. For example, use 
13:00 to denote 1:00 P.M. 

Keeping Multiple Note Pads 

If you use your Note Pad a lot, you may 
run out of room. Keep multiple Note 
Pads on disk by renaming the Note Pad 
data file in the System folder. J~ ' 
rename the Note Pad from the Fi:zlder. 
Wh~ you ask for the Note Pad m>m 
the· Apple menu, a new System file 
called Note Pad will be created. To 
substitute your old Note Pad for the 
new one, just change the!new one's 
name to Note Pad A and change the ~ld 
one's name back to Note Pad 

Note Pads Remember Fonts \ 
and Styles 

The Note Pad only displays text. in 12-



point Geneva. But it does retain the 
font and formatting information from 
text pasted in, even though it isn't 
displayed. When you copy information 
from the Note Pad and Paste it into 
an application, the original font and 
formatting shows up in the document. 

Keeping Multiple 
Scrapbooks On Disk 

As with the Note Pad desk accessory, 
you can work with several Scrapbook 
documents on one disk. After the first 
one has been filled, quit to the 
desktop and rename the Scrapbook 
file. Then, when you re-enter your 
application, you'll have an empty 
Scrapbook waiting to be filled. To 
access the first Scrapbook, rename 
the second one and change the 
original's name back to Scrapbook 
File. This method allows you to keep 
specialized Scrapbooks on a single 
disk. 

Keep Scrapbook Open While 
YouWork · 

If you use the Scrapbook constantly, 
save accessing time by leaving it up 
as you work. Leave a small portion of 
it visible behind your document 
window, so you can call it up by 
clicking on its window. --t@l Dinner. at Eight 
Dress Up Menu Printouts 
With Graphics Application 

This program is limited in its 
handling of menu printouts. If you 

DESK ACCESSORIES-DISKTOP 

want to enhance your printout, use 
COMMAND-SHIFT-3 to take a 
MacPaint snapshot of the menu, and 
then modify the image in MacPaint. 

Clear Before Selecting N~w 
Category in Silver Palette 
Edition · · 

The Silver Palette Edition has so 
many categories that it's impossible to 
cross-reference between them all. 
Remember to click on the Clear 
button before selecting a new category 
on a different Browse screen. 

SDisk Express 
Run This Program From 
Original Disk 

To ensure that this program runs 
properly, boot and run it from its 
original disk. Also, make sure that 
any RAM cache is off, or you· could 
experience some time-consuming 
problems. 

. LID Disktop (Desk Accessory) 

Perform Commands On .. 
Multiple Files · 

While vie~g a list of files, you c~ 
make multiple selections to perform 
commands on many files at once. Just 
SHIFI'-CLICK to select individual. 
items, or SHIFI'-DRAG to choose a 
continuous list of files. 

When. a number of files are selected, 
the Sizes button tells you the total of 
all files. Clicking on the Delete button 
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(when multiple files are selected) 
gives you.the option of deleting each 
file in the sequence without having to 
confirm each one. 

Older Versions Are 
Incompatible With New 
Macs 

If you used this program on an older 
Mac and are upgrading to a Mac Plus 
or other HFS system, beware: older 
versions of Dollars & $ense don't work 
under HFS. Make sure you print out 
all of your files before making the 
change. 

Only One Screen Dump Can 
Be Saved At a Time 

To create screen dumps, use 
CO:MMAND-SHIFT-CAPS LOCK-4. 
This sends a screen dump to the 
Image Writer and creates a MacPaint 
file at the same time. However, only 
one screen dump can be saved to the 
disk at a ,time. 

0Excel 
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More Than a Megabyte's 
Wasted · 

Excel accesses only the first megabyte 
of memory. If you have more than 
that installed in your Mac and use the 
program under Switcher, be sure to 
install in in the first memory slot to 
give it the lowest possible memory 
allocation. 

Select Commands by Typing 
First Letter .of Selection , 

You can quickly select commands 
within most dialog boxes by typing 
the first letter of a radio button 
command. That often selects the 
command, without you having to 
actually click the mo~se on the 
button. 

COMMAND-A Selects .Entire 
Worksheet 

You can select an entire worksheet 
without using the mouse by typing 
COMMAND-A This is the equivalent 
of clicking in the upper left comer of 
the worksheet. 

Show or Print All 
Worksheet Formulas 

To show or print all the formulas in a 
worksheet (rather than the data), 
open a new macro sheet, copy the 
required cells from the worksheet, 
and paste them into the macro sheet. 
If you don't include all related cells, 
the cell references within the macro 
sheet may be incorrect or misleading. 

Quickly Reopening Linked 
Documents 

It can be annoying to reopen several 
linked documents and constantly be 
presented with the "Update Reference 
to Non~ Resident Sheets" message. 
Clicking on either choice will update 
the worksheet or chart automatically, . 
but it takes time. One solution is to 
use the Resume Excel document. 



(These are created each time you Quit 
Excel. They contain information on 
which documents were open, and 
where they were placed right before 
you Quit.) 

Before starting, you have to 
remember which documents reference 
others, including worksheets, macro 
sheets and charts. Enter Excel and 
open all the related documents. 
Activate (either by clicking or using 
the Windows menu) documents in the 
following order: all charts, then all 
worksheets, and finally all macro 
sheets. Now Quit. After you're 
returned to the Finder, in the same 
folder as Excel you'll see a Resume 
Excel document. Rename it, so the 
next time you Quit it won't be 
replaced. The next time you want to 
open your linked documents, double­
click the renamed Resume document 
instead. 

Insert New Row/Column 
Without Using File Menu 

You can select INSERT to insert a 
new row or column without going 
back to the file menu every time. Hold 
down OPI'ION while clicking on the 
row or column in which you want to 
add a new area. 

Automatic Dates In Column 
Heads 

There's a way to make Excel 
automatically fill in the dates at the 
heads of columns. For example, to fill 
in months, select the cells you want to 
till in with the months (12 m this 
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case). Then, choose NUMBER from 
the Format menu. Type "mmm" into 
the dialog box for abbreviated 
months, or "mmmm" to have the 
month names spelled out. Then, 
without deselecting the cells, enter 1 
in the first cell and press ENTER. Go 
to the data window and choose Series. 
Then, in the dialog box, select Series 
in Row, Type Date, Month Date Unit, 
and increment of one without a 
stopping point. Finally, go back to the 
spreadsheet, type 2 in the second cell, 
and press ENTER. The dates should 
appear in the columns. You can 
experiment with this method to see 
how it works for other time 
increments as well. 

You an also use the NOW() function 
to enter the current date or time into 
a cell. Define which part of the 
information should be displayed by 
selecting DAY(), HOUR(), MINUTE(), 
MONTHO, WEEKDAYO or YEAR(). 
The formula for entering the current 
month in a cell would be 
=MONTH(NOWO). 

Displaying/Printing 
Columns Beginning With 
Zero 

Some zip codes have leading zeros (for 
example, Woodstock, Vermont's zip 
code is 05091). If you always want 
Excel to display and print these zeros, 
select the row/column in question and 
select Number ... from the Format 
menu. Type in five zeros at the bottom 
of the dialog, then click OK. The 
selected area will now allow for zip 
codes with zeros as their first digits. 
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Copying Spreadsheet As a 
Graphic Image 

Excel has a feature that allows you to 
copy a portion of a spreadsheet as a 
movable graphic, instead of having to 
copy only the numbers. Select the 
area of the spreadsheet you want and 
choose Copy Picture from the Edit 
menu. (In order to get this option to 
appear, hold down SHIFT before 
clicking on the Edit menu.) The 
selection, along with the row/column 
headings, will now be in the 
Clipboard, where you can later place 
it in a word processor, page layout or 
graphics program. The item is copied 
to the Clipboard in PICT format, so 
you can manipulate it in MacDraw. 
This also allows you to resize and 
reshape it proportionately for 
Laser Writer output, if your graphics 
application allows for it. 

Bigblii~~Dg Multiple Cells 

Highlight a large number of cells by 
clicking on the top left cell of the 
range and choosing the GOTO ... 
command from the Formula. Then 
specify the l<twer right cell of the 
desired range and press smFr while 
clicking OK or pressing Return. 

' Cursor Key Movement With 
Mac Plus or SE 

When a group of eells is highlighted, 
you can't move the cursor outside the 
selected ·al'ea if you're using the 
keyboard to •control it. But if you're 
using a Plus; or SE, use the cursor 
keys to move around within the 

s_elected cells. When the cursor hits 
the bottom or edges, it will wrap to 
the other side. 

The Easy Way to Name Cells 
in Columns 

If you find yourself entering a column 
of labels only to have to manually 
name each cell in the column just to 
the right of the labels for use in 
formulas, here's an easier way: Select 
the first cell that you want to have 
the same name as the contents of the 
label cell to its left. The use 
COMMAND-L (or choose DEFINE 
NAME in the Formula menu) and hit 
return before the dialog box appears. 
Excel will automatically assign the 
contents of the label cell to the left. as 
the selected cell's name. 

Command Key 
Combinations to Select 
Page Setup Options 

This program provides command key 
combinations for almost all the 
choices in page setup and print 
dialogs. In both, COMMAND-O or 
COMMAND-period selects Cancel, 
while COMMAND-O or pressing 
Return/Enter selects OK. 

For the Image Writer Page Setup ... 
dialog box: 
COMMAND-U activates "US Letter" 
COMMAND-A activates "A4 Letter" 
COMMAND-I activates "International 
Fanfold" 
COMMAND-T activates "Tall 
Atljusted" 
COMMAND-5 selects "50% reduction" 



COMMAND.:.N marks "No Gaps 
Between Pages" 
COMMAND-P marks "Print Row ,and 
Column Headings" 

For the Image Writer Pririt ... dialog: 
COMMAND-B activates,"Best" 
COMMAND-F activates· "Faster" 
COMMAND-D activates "Drafi" 
COMMAND-A activates "All" 
COMMAND-H activates "Hand Feed" 
COMMAND-P marks~"Preview" _, 

For the LaserWriter Page Setup ... 
dialog box: 
COMMAND-U activates "US Letter" 
COMMAND-A activates "A4 Letter" 
CO:MMAND-B activates "B5 Letter" 
CO:MMAND-F marks "Font 
Substitution" 
COMMAND-S marks "Smoothing", 
COMMAND-P marks "Print Row and 
Column Headings" 

For the LaserWriter Print ... dialog: 
COM:MAND-A activates,"-All" 
COMMAND•F activates "From .. ~ To" 
COMMAND-M.activates·"Manual 
Feed" 
COMMAND-P activates "Paper 
Cassette" 
COMMAND-N activates "No" (for No 
Cover Page) ~ 

COMMAND-L activates "Last Page" 
(for. cover page) 
CO:MMAND-H activates "Help" .· 

Formatting Commands in: 
Headers' and Footers 

To embed. formatting commands or, 
other instructions in the header or 
footer of an -Excel document, insert 
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the formatting commands in the Page 
Setup dialog box. The keyboard 
equivalents are: 
&L: Align the characters that follow 
at the left margin; 
&C: Center the characters that follow; 
&R: Alight the characters that follow 
at the right margin; 
&P: Print the page number; 
&D: Print current date; 

. &T: Print current time; 
&F: Print the document name; 
&B: Print the left, center, or right 
side of the header or footer in 
boldface; 
&1: Print the left, center~ or right part 
of the header or footer in italics; 
&&:·Print a single ampersand. , 

Extra-Long Hea'der or . 
Footer Text 

You can enter header or footer text 
that's longer than the box. can display. 
If you need to edit this text later, vi_ew 
it by placing the cursor in the visible 
text near the rightmost end of the) 
entry box and then dragging, off the 
end The text will scroll to the left and 
the extra text, already highlighted, 
will appear. 

Protect Sensitive Data By 
Hidiilg It From View 

Using the Cell Protection command 
only hides formulas from being 
viewed. To really protect data, . 
eliminate the column that the data is 
in from view. Select all of the columns 
you want to hide, choose Column 
Width ·from the Format menu, and set 
the width to zero. (Although hidden, 
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the values will still be used in 
computations.) Now, protect the 
document with a password. No one 
will be able to view the hidden data 
without knowing your password and 
unprotecting your document. 

Protecting Sensitive Data 
While You Work 

To protect your document from prying 
eyes while you work on it, open a new 
document before opening the sensitive 
one. Then use the new document's 
size box to make it as small as 
possible, and move it to the bottom of 
the page, so low that only its title bar 
shows. Finally, open the classified 
document. If you're intruded upon, 
double-click the new document's title 
bar and it will ins~tly cover your 
private one. 

Centering Tables With 
Borders 

To center a table with a border, 
increase .or decrease the left margin. 
Cheek your centering by viewing the 
page with the Preview option {on the 
Print dialog). Both left and right 
margins will appear if the table is 
centered. Only the left margin 
appears in the reduced view if it is 
not. 

Trim Document :Fa~ce by 
Removing Form . 

When entering a formula into a cell, 
hit Enter or Retum to confirm the · 
formula. The results will appear in 
the cell, but the formula is saved with 

the sheet. Press COMMAND-={equal) 
instead and the results of the formula 
will be entered into the spreadsheet, 
while the actual formula is lost. {If a 
new value is entered into a variable 
cell in the formula, the results cell 
won't .change.) Use this method to 
trim a few K from your saved 
document. 

Some Text Strings Should 
Be Entered As Formulas 

You might find that entering some 
text strings into a cell can sometimes 
produce odd results. For example, 
pasting lOA into ,a cell results in 
Excel displaying 10:00 AM. Work 
around this by .entering the· text as a 
formula. Instead of lOA, type= "lOA", 
and the cell will show 1 OA 

With a Single·400K Drive, 
Make a RAMdisk 

If you're using.Excel on a single 400K 
drive, 512KMac, create a 215K 
RAMdisk that contains the System, 
Finder, and Image Writer files. Excel 
works fine·with the remaining 
memory, although you'll have to do a 
little disk shuftling when work files 
are saved to a data disk. 

Copying Cell Groups For 
Page Layout Applications 

When copying_.a group of cells to be 
used in a page layout appli,cati.on, 
highlight the cells and then press 
COMMAND-SHIFI'-3 to copy cells, 
divider lines and any other 
information. It .will be converted into 



QuickDraw, so when you paste it into 
a page layout or word processing 
program, it can be easily resiZed while 
retaining its full·resolution. 

Recompute Macro · 
Functions By Reopening 
Macro Sheet 

You can only use macros from open 
macro sheets when building your 
spreadsheet. If you Close a macro 
sheet containing a macro that a cell in 
your open spreadsheet refers to, the 
value of the affected cell will change 
to "#REF!". The way to recompute 
your functions is to re-open the macro 
sheet. 

Use XMODEM to Import 
Lotus 1~2-3· From PC. 

If you import Lotus 1-2-3 worksheets 
from a PC by modem, use XMODEM. 
If the terminal program on your Mac 
has selectable MacBinary, turn it off. 
If you use XMODEM, only·7,ofthe 8 
data bits per bite comes through, so 
the transfer is useless. IfMacBinary 
is used, the first 128 bytes of data will 
be lost. 

~Fedlt 
ONLY Work on a Backup 

Never use Fedit to modify an original 
application disk. This is a 
programmer's tool, not a toy, and a 

; mistake could cost you more than you 
think· in time, money, and 
aggravation.· 
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Removing the Trash Can 
Dialog 

When you throw an application into 
the Trash, the message; 'fAre you sure 
you want to remove the application 
X?" always appears. If you're always 
sure, and you find this annoying, you 
can disable the feature easily. If 
you're using Finder 4.1, use Fedit or 
another disk editor, search for the hex 
string"3F05 4EBA266C 4A1F 660A" 
and modify it to "3F05 4E71 4E71 
4A1F 600A" For Finder 5.2, see the 
tip under ResEdit. 

Fedit/MacDraw 

Current versions ofMacDraw can't 
address more than 11 fonts under the 
Font menu. If you're proficient with 
Fedit or MacTools you can remove the 
limitation. Open·_a copy·ofMacDraw t 

and change the following: 
Find: ·Change to: Occurrences: 
41ED FAD6 41ED F360 9 
0000 OC60 0000 OCAO 1 
OOOB FACE 0016 FACE 2 
0014 6F02 7Cl4 001F 6F02 7C1F 1 
70E1 709B 3 
0001 OOE1 0001 009B 3 
10E1 109B 1 
OC47 0015 OC47 0020 1 
4E56 FFBE 4E56 FF9E 1 
Now you should be able to see all 
fonts in the System, with their size 
selections appearing at the bottom of 
the menu. If there are a lot of fonts, 
you may need to scroll down the menu 
to see sizes. Files created with this 
modified MacDraw might not be fully 
text compatible with future MacDraw 
editions, so be warned. 
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FeditJMultiplan 

If you've accidentally forgotten an 
important spreadsheet password, use 
Fedit to open. the spreadsheet 
document,. and find block 3, part A,· 
position 0079. ·If the spreadsheet is 
pr~tected,- this location will contain a 
01. Change it to 00, save the changes, 
and now the spreadsheet.will open 
with no password. 

File 
Generating Line Fields At 
Insertion Points Lets You 
Create Lists 

Type OPTION-Return in.a field to 
generate a line feed at the insertion 
point, which allows you to create lists. 
This embedded character acts like a 
normal Return when copied and 
pasted into a word processing or 
spreadsheet application. 

Quickly· Select the Entire 
Field 

SffiFr-CLICK selects the entire field,: 
so you don't have to scroll to highlight 
it. 

Generating Exportable Tab 
Characters 

Hitting the Tab key usually moves 
the cnrsor to the next field. But you 
can generate Tab characters by 
holding down OPriON when you 
press Tab. If data with, embedded tabs 
is exported to a word processor, for 
example, the tabs will respond to the 

tab settings in the word processor, 
making it easy to format. tables. Be 
careful about using that same data in 
another database program, because 
the receiving database may confuse 
the Tab characters for field 
deli~eators, ruining the transfer's 
format. 

Display Box is-·Bigger Than 
It Looks 

If the display box you've chosen for a 
field in your form design isn't large 
enough for the data you've entered, 
don't worry: while the box only 
displays the first part of the data, File 
saves the rest. You can see whaf~ in 
the rest of the field by clicking a few 
characters before the end of the box 
and dragging off its e1,1d. This scrolls 
the text through the box for viewing. 
This only works horizontally in .single 
line fields, and .won't work vertically 
with multiple line fi~ld$. 

Changing Field Formats 
While Preserving Your Data 

There's a way to: preserve data and · 
still change the Format of a field. 
First, open your form design and 
move the hide line so that all your 
fields are showing-remember-to- -
show even hidden fields, since if you 
don't you'll lose the data they contain. · 
Now, return to the data entry window 
and SHIFr-Click to select· all the 
records in your database and copy 
them to the Clipboard. Then, use_ 
Clear from the Edit menu to. empty all 
your records and quit. When the 
dialog appears asking how to sav~, ~he 



Clipboard, choose "Unformatted." 
Then restart File by double-clicking 
on your data file's icon and choose 
Show Form from the Form menu. 
Now reformat the fields, clicking OK 
whenever File warns you that you'll 
lose data. After changing the field 
formats, save the changes and return 
to the data entry window. Select a 
New record and Paste in your data 
from the Clipboard. Then, choose "By 
Name"· when the dialog box comes up. 
This only works if the database 
contains no pictures. Graphics are 
lost during reformatting in this way. 

Enter Data Fastest in 
S~allest Database Window 

To enter data quickly, don't leave the 
database window open to the default 
screen size setting. Close it as far as it 
will allow, to display only two lines. 
Since File redraws the screen after 
completing an entry, keeping the 
window small requires the program to 
draw less. Hit the Enter key to go to 
the first field of the next entry. 

If Your Select Bar Pushes 
Your Form Aside 

The width of the select bar on the far 
left side of the screen in the datafile 
display varies to accommodate the 
number of digits in the record 
numbers. If the bar becomes so wide 
that it pushes your form partly off the 
page, fix it by Opening the Form 
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window, picking up the line, and then 
moving it back to the left. This may· 
obscure some of your record numbers, 
and you'll have to re8et it every time 
you start a new work session. 

Mac Plus Keyboard. Cursor 
Movement 

If you're using a Mac Plus, File has 
provisions for using th61t arrow keys on . 
the keyboard. The right arrow moves 
the cursor to the next field, replacing 
Tab or Return. 

The left arrow moves the cursor to the 
previous field, replacing SHIFT-Tab 
or SHIFI'-Return. · 

The down arrow moves the cursor to 
the same field in the next·record, 
replacing COMMAND-ENTER. 

The up arrow moves the cursor to the 
same field in the previous record, 
replacing COMMAND-SHIFI'­
ENTER. 

Printing Solid Rules on the 
Laser Writer 

When you print reports on the 
LaserWriter, rules will print as dotted 
lines. To print them solid, select 
FONT SUBSTITUTION from the 
Page Setup dialog. FONT 
SUBSTITUTION also makes sure 
that any of your total and sUbtotal 
fields, and your headers and footers, 
are printed in Helvetica· instead of 
Geneva. 
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Don't Use Embedded Tabs 
Within Fields When 
Exporting to Other 
Database 

If you work on a file you'll want to 
transfer to another database manager, 
don't use embedded (OPI'ION-) Tabs 
and carriage returns within fields. 
When you try to transfer the file later, 
the other database manager could 
interpret the embedded tabs and 
returns as regular ones. In most cases, 
this will render the transfer useless, 
since the importing database manager 
will interpret the tabs as field 
delineators, and the returns as record 
delineators. This will mess up the 
order of your fields and records, 
generating so much extra work that 
you might as well create a new 
database from scratch. 

Creating File Records With 
a Word Processor 

You can create records in a word 
processor that will later be 
transferred into File. Don't type in the 
names of fields, since these will get 
Pasted in along with the data. .. just 
type in the contents of the fields in 
the same order as the fields on your 
File form. Follow each field with a 
Tab character, and mark the final 
field in each record by a carriage 
return. 
If you have blank fields in your 
records, enter an extra Tab character 
for each blank. If a blank field is at 
the end of your record, you don't have 
to enter Tabs, because the carriage 
return will make the database 

manager ignore any remaining fields 
in the current record and instead 
start with the first field of the next 
record. 
Transfer the data into File by 
selecting all of the data. Put the 
cursor in front of the first character of 
the first record and press SHIFT­
Click while placing the cursor 
immediately after the last carriage 
return. Copy the records to the 
Clipboard, quit the word processor, 
and enter File by double-clicking your 
file's icon. Go to the end of the 
database and select the whole New 
record by clicking on the selection bar 
to the left of the data window. Then 
Paste your records into position, 
choosing the "By Name" option. If 
anything doesn't look right, Undo the 
Paste and go back to the word 
processor file to fix the problem. 

Saving Changes to Page 
Setup Parameters 

If you change the page setup 
parameters of a report that's already 
been saved, use Save As ... instead of 
Save after you make the changes. 
Using the standard Save will save 
only the changes you've made in the 
report design, without saving changes 
to page setup. When the Save As .•• 
dialog asks you if you want to replace 
the existing report of that name, click 
Yes and the page setup is saved 
permanently. 

Saving Files in a Sorted 
Order 

To save files in a sorted order,,use 



Save Records As .•• before closing the 
file, after data has been sorted. This 
saves them as a new, sorted data file. 
If you want to keep the unsorted file as 
a backup, close and save it in the usual 
way. If you don't need the old file, 
delete it, since it won't reflect changes 
made to the sorted file while it was 
open·, and this keeps you from getting 
confused about which is which. · 

~ Filemaker Plus 
Solution For Label Peels on 
ImageWriter II 

When printing on the Image Writer II, 
you might find it peels labels oft' ;pages 
and backs up. Just before printing 
label layouts,. choose SET PAPER 
SIZE ·froin the File menu and set-the 
paper length extra. long. Then, in 
Page Setup, turn "NO GAPs· · ·. 
BETWEEN PAGES"· on and specify 
Hand Feed printing. ·If you use,·say, 
l-inch, one across labels and set the 
paper length to 36, the printer makes 
36labels, skips the next two labels, 
and then prints the next batch of 36. 

Embedded Credits 

A humorous credit screen is 
embedded in FileMaker Plus. To see 
it, hold down OPI'ION-SHIFT while 
choosing Abo~t FileMaker Plus from 
the Apple menu. 

Use OPTION-SPACE to 
Enter Multi-Word Phrases 
As Search Identifiers 

Use OPI'ION-SPACE instead of the 

FILE-FILEVISION 

space bar when you're entering 
multiple-word phrases that will be 
used as .search identifiers. That 
indexes both words as ·one, allowing 
searches by combinations or portions 
of all the words. For example, if"Land 
of the Rising Sun" is entered as 
separate words, each will be indexed 
individually. Buy when you press 
OPI'ION-SPACE between the words, 
the phrase can then be searched by 
"Land of' or "Rising Sun". or other 
connected words. 

Entering Copies of a Record 
Using COMMAND·M 

To enter a lot of copies of a record 
using the (new) COMMAND-M keys, 
it helps to execute a find on the first 
record entered Thereafter, the 
number under Found: will increase by 
one on each press of COMMAND-M. 
That allows you to keep track of how 
many·records have been entered. 

~Filevision 
Establish HELP Files For 
Other Users of Your:· 
Database 

If other people will be using your 
FileVision database~ establishing 
HELP files in addition to your 
drawings will make things convenient 
for them. In the a'ypes menu, add a 
type called HELP. Create one field in : 
your data form and name it .. 
Instructions. Then, in the NAME 
field, type in a message such as "For 
HELP screens, double-click the 
mouse." Take a rounded rectangle tool 
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and place a small·shape in an 
unobtrusive, but accessible, place on 
the screen. Then click on the 
rectangle and, with the SHIFI' key 
.depressed, select the text tool and 
type HELP into the rectangle. 
Finally, go back to the data form and 
type in your HELP text in the 
INSTRUCTIONS field. 

Controlling Object 
Sequence By Numbering 
Your Objects 

Control the sequence of objects when 
using the NEXT or PREVIOUS 
buttons by· numbering your objects in 
the NAME field. Numbers always 
take precedence over letters, whicb 
are alphabetized. So to move items to 
the top of the list, give them numbers 
as names. 

Another way to control orde~g is to 
use the same name, but put a 
number in front of the name. This:. 
also shows you at a glance which 
data is linked. It works well if you 
need to show a series of steps in your 
drawing file. 

Save Graphics For Use in 
Other Files 

If you create a drawing tile that 
contains object you want to use in 
other files, Cut and Paste the object 
between files. For groups, it's easier 
to duplicate the entire drawing tile, 
then modify it and save it to a new 

·'name. 
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Use Pre-Made Graphics, If 
You Need Them 

You don't always have to create 
graphics from scratch. Don't be afraid 
to copy examples on the Filevision 
Ideas: Disk, or public domain 
examples downloaded from a network. 
.rrhese pre~made graphics can be 
modified to your own needs, and you 
won't have to reinvent the wheel 
every time you create a graphic. 

m Find File (DeskAccessory) 

Use MOVE TO DESKTOP To' 
Put Files On the Desktop 

Version 1.1 of the Find File DA (it's 
part of the System 4.1/Finder 5.5 
update) lias an option on its menu 
called Move to Desktop. 
l\fter using Find File to locate a file, 
choQse MOVE TO DESKTOP from the 
Find File menu, and the file will 
appear on the desktop next to the. disk: 
icons. Later, select the file.and:choose 
PUT AWAY from the File menu and 
you'll see the file shoot back to its 
original disk or folder. If you're using 
AppleShare, the Move To Desktop 
option doesn't work. 

~ Flight Simulator 
Poster-Sized Screen Dumps 

You can create a huge, almost po$ter~ 
sized screen dump of a Flight 
Simulator screen by pressing 
COMMAND~SHIF1'~5. The program 



then prompts users to insert a 
formatted disk with at least 200K 
free. After inserting the disk, click on 

. the ·close box, and twelve large PICT 
files will be saved. Print the series 
and tape them together to create a 
poster, if you want. 

Access Five Hidden 
Situations· 

To activate five prere~orded 
situations that don't·normally appear, 
start by choosing LOAD RAM FROM 
DISK from the Situation menu. The 
Flight.Simulator disk ejects, and 
you'll be prompted· to. insert a disk 
containing a situation file. Don't. 
Reinsert the program disk. This will 
totally confuse the program, which 
will eject the disk yet again, 
prompting you to reinsert it. Now, try 
to access those hidden situations. 

~ ~1st.Base 

Chaining Fields To Create 
Mergable Paragraphs 

It's.possible.to chain several 50-
character fields together to form 
mergable paragraphs for form letters 
by using 1st Base and 1st Merge. Just 
put the number of 50-character fields 
you'll need in sequence in the form 
design. Then till in the fields, tabbing 
to the next field when the one you're 
working in is full. Use hard spaces 
(OPI'ION-Space) at the ends of fields 
to keep them from being stripped otr 
when 1st Base merges the fields. 

FUGHT SIMULATOR-FOND/DA MOVER 

Compatibility PrOblems : 
With Phone Pad DA 

1st Base has compatibility problems 
with Batteries Included's Phone Pad 
DA If you try to Cut or. Copy data. 
from a 1st Base field to Paste into the 
Phone Pad, the data disappears from 
the lst Base field completely~nd it 
doesn't show up in the Phone Pad · 
either! Don't use this feature with -­
important data. 

W FontiDA-iMover 
Open Directly lnto.Desk 
Accessory Mode 

,. 

.This application always defaults to 
font mode when you launch it. If you 
want to open directly into the desk 
accessory mode, hold down the 
OPI'ION key while launching t}le 
program. 

Fast Access to Other Disks' 
Systems 

You don't have to use the-Open :button 
to access the system of another disk. 
If you put a disk into the drive while , 
FontiDA Mover is open, it will 
automatically open the system of any 
other disk placed in the drive. 

Lock Disks to Avoid 
Accidental Erasures 

To avoid trashing a font tile by 
accidentally hitting the Remove 
button instead of the Copy button, 
lock the disk on which the original . 
font resides by sliding the plastic tab 
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to the "open" position. This dims the 
Remove button, which indicates that 
the command can't be done. 

Install Font or DA Directly 
Into Application 

You. can install a font or desk 
accessory directly into an application. 
This comes in handy if you need, say, 
a foreign language font only in the 
word processor. Accomplish this by 
holding down the Option key while 
clicking Open~ You'll get a choice of all 
files on your disk, not just systems or 
desk accessories. By installing fonts 
into applications you use them with, 
you'll always be able to keep them 
together when you move applications 
on to other disks. 

Display File Size and 
Resource Forks 

While in the main screen hold down 
OPI'ION while selecting a DA file to 
display the size of the file's data and 
resource forks in the lower left comer. 
This·also will indicate whether or not 
the DA has PICT resources, which are 
bit-mapped graphics. 

Quick Ejecting 

Hold down OPI'ION while closing a 
list of fonts or DAs and the disk 
they're on ejects itself. 

Hold down OPTION while quitting 
to eject all disks from all disk 
drives. 

Access Extra Information 
About Desk Accessories 

Hold down OPI'ION while clicking_on 
a ·desk accessory and the ·display will 
show how many bytes it·occupies by 
its code, pictures, and "other." : 

You Don't Always Have to 
Remove Old DAs 

If you're using ·Font/DA mover 3.2 or 
higher, ifyou are replacing a DA with 
another of the same name (possibly a 
newer version), you don't have to 
remove the old DA first. JuSt copy the 
new version over, and as long as the 
name is exactly the same, it will 
replace any existing version of the DA 
on the destination disk. 

·Store Small Custom 
Graphics As Fonts 

If you have frequent need of. small 
custom graphics, save trips to the 
Scrapbook by creating your own font 
that contains all your small custom 
graphics. Then, just install them in 
the System of the application you· 
need the characters in, such as your 
desktop publishing program. This 
comes in handy for making end 
'bullets, graphics used to lead into 
regular. columns or features, etc. 

(3)Fonts 
Designing Fonts the Easy 
Way 

Don't feel you have to reinvent the 
wheel every time you design a font. 



Browse through presstype and other 
catalogs available at art stores to find 
a font close to what you like. Then use 
a scanner or trace the characters of 
the font with the mouse. Then modify 
them until you have exactly what you 
want. 

Don't Edit LaserWriter 
Fonts With Image Writer 
Editors. 

Font editors designed for use with 
Image Writer fonts shouldn't be used 
to edit LaserWriter fonts. Use only 
PostScript-compatible font editors 
when designing for the Laser Writer 
or you'll get choppy, odd-looking 
printouts. 

AE~~e Symbol Is a 
C acter 

To get the Apple symbol as a 
character in a font, just install any 
Apple font. To reach the symbol, type 
OPI'ION-SHIFT-K, then go back and 
change the square box that appear in 
most fonts to that of a recently 
installed laser font. 

Accessing Accurate 
Quotation Marks 

Most Apple and Laser Writer fonts 
have very accurate quotation marks 
built into them. These fonts usually 
include marks for both beginning and 
ending a quote. These are usually 
accessible through OPI'ION-SHIFT-[ 
Oeft bracket) and OPTION-SHIFT-1 

· (right bracket). 

FONTS 

New Font Changes May 
Affect Document Spacing 
Created With Old Fonts 

Apple changed the Times, Helvetica 
and Courier fonts slightly for use on 
the LaserWriter IT. This may affect 
the spacing of your text in older 
documents. Make font acijustments if 
necessary to documents that don't 
seem to print correctly on the 
LaserWriter II. 

Mac Attack A Source of 
Special Fonts 

The game Mac Attack uses four special 
fonts to create some of its graphics. 
These are called Tank, Missile, 
MaTitle and Landscape. If you like the 
fonts and want to use them elsewhere, 
use the Font/DA Mover to put them 
into other System tiles. 

Accessing Diacritical Marks 

To use a diacritical mark, you have to 
type the command key combination 
for the mark first, then type in the 
letter you want to accent. 

Accessing Ellipses 

Most fonts contain true ellipses, 
which are the series of three periods 
used to denote a run-on sentence. 
Access the ellipsis by typing OPI'ION­
SEMICOLON in most fonts. This 
comes in handy when you justify text, 
because the ellipsis remains attached 
to the word in front of it, and the 
spacing between the periods isn't 
altered by justification. 
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Use Ellipses To Make Quick 
Dotted Lines 

Make a quick line composed of 
horizontal periods by typing OPTION­
SEMICOLON to get ellipses as you 
go. Just don't choose to justify the 
line, since the spacing will come out 
very strangely. 

If You Need A Heart. •• 

New York font (18-point) contains a 
heart character. Access it by typing 
OPI'ION-SHIFI'-Tilde (the top left 
character on the keyboard). 

The LaserWriter Symbol font contains 
a heart. Access if with OPriON -G. 

With New York Fonts, What 
You See Doesn't Always 
Match What You Get 

The New York font contains some 
mismatches between the diacritical 
marks you see on-screen and those 
you get in printouts. For example, if 
you use an uppercase E with an acute 
accent in 9- or 18-point New York, 
you'll see the proper mark on 
screen-but will see an umlaut on 
printout. 

Accessing "Secret" Font 
Characters 

OPI'ION-SffiFT-Tilde is the 
combination you should use to access 
any "secret" characters in your font. 
These vary from font to font. 

Keep Proportions When 
Designing Double-Size 
Fonts 

When designing double-sizes of fonts, 
make sure you keep the same 
proportions as you have in the smaller 
version. Geneva is a glaring example of 
a font that uses different proportions: 
just look at the 12-point lowercase Y 
against the 24-point version. If you use 
the font in Mac Write and select the 
high quality option when you print, the 
Image Writer will use the double-size 
version and reduce it to get the font 
you want. If the proportions or the 
baseline of the double-size font aren't 
the same as the one you're using, you'll 
get strange results from the printout. 

Mac Point Sizes Aren't 
Always Accurate 

The Mac uses different "standard" 
point sizes than those used by 
typographers. For example, single­
spaced Seattle 10 is about the same 
size as a standard 12-point typeface 
with 2 points of leading. Only the 
LaserWriter fonts-Times, Helvetica, 
etc.-are standard sizes, so if exact 
specs are called for, use only these. 

Not all fonts in the same point size 
are the same actual size. Experiment 
with different fonts in the same point 
size to see the difference. 

When You Assign A Font 
ID ••• 

The Mac has a total of 511 font ID 
numbers. Fonts 0-127 are reserved for 



Apple fonts, whilel28-383 are 
designated to outside developers 
approved by Apple. So, when 
assigning a font ID number, use 384-
511. However,. be careful and test 
things out on duplicate disks, since 
resource tools might not work with 
fonts numbered above 255. 

~Full Paint 

Creating Dashed Boxes or 
Lines 

You can easily create dashed boxes 
and dashed horizontal or vertical 
lines. Just create a checkerboard 
pattern of two diagonally opposed, 4 x 
4 solid boxes. Select this pattern, then 
hold down OPI'ION while drawing a 
square, or SHIFT-OP'I'ION. while 
drawing a line. 

Expanding Graphics·To Fit 
Entire Page 

It's easy to get a drawn gr~phic.to 
expand proportionally to fit the entire 
page. First, select the graphic (it 
works best with the lasso) and Copy 
it. Then, in .a new document, triple­
click the selection marquee and select 
Paste. The pasted graphic will expand 
to fill the entire page. You might want 
to touch up the new full-page gr~phic 
for cleaner display and printing. 

UNDO Remembers Last 
Mouse Drawing Action 

FullPaint's Undo command 

FONT8-FULLPAINT 

remembers the last mouse,drawing 
action. As long as you don't use 
editing functions like Cut, Copy and 
Paste, or if you· don't select anything 
from the tool palette, the last object 
you created with a drawing tool can 
be Undone, even if menus are 
opened, the preferences dialog is 
used, patterns and brushes are 
edited, etc. 

Creating a Custom Brush 
From On-Screen Pattern 

,. 
When you use the custom,brush 
feature, click the pointer on any part 
of the Mac screen and whatever is 
under the pointer will be turned into 
a brush and placed on the brush -
palette. 

Making Textures Match 
. Specific Areas ·. 

Create a texture that matches a 
particular area in your painting by 
selecting Edit Pattern from the 
Goodies menu and clicking the 
pointer on the ar~a you want to, .. 
match. This comes in handy when 
you've moved a painted graphic to 
another part of the page anci the 
texture you used before won't ~gn 
with the image the way it did in its 
original position. 

Create Your Own Paint 
Brush 

You can create your own paint bl11Sh 
by double-clicking the brush icon and 
selecting a brush while holding down 
the COMMAND key. 
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Randomizing Patterns to 
Look ~ashed" 

Hold down OPI'ION ·while selecting 
any paint brush to cause the pattern 
to randomize and create a washed 
effect. 

Forcing the Rectangle to 
Close As Tight As It Can 

Hold COMMAND before and while 
selecting an object with the selection 
rectangle to force the rectangle to 
close around an object as tightly as it 
can. 

Toggle Menu Bar On and 
Off . · 

Press COMMAND-A to toggle 
between the full screen with menu 
bar and the full screen without menu 
bar. 

Toggle Paint P~ette On and. 
Off · · 

To avoid having two palettes 
cluttering up the screen, press 
COMMAND-OPI'ION-T to toggle the 
paint palette on and otr.· This won't 
affect the•tool palette; ' 

Pasting to Upper Left 
Corner of the Active 
Window 

When you paste something it usually 
goes to· the center of the active 
window, which is the default area. 
You can paste ·an element into the 
upper left comer of the ·active window 

by holding down OPI'ION while 
Pasting. 

Grabbing Palettes 
Anywhere Within Their 
Windows 

To move the tool and pattern palettes, 
you usually have to grab them on the · 
upper part of the tool window. Press · 
the OPI'ION key to grab these 
palettes anywhere within their -
windows. 

Easy Access to Picture 
Fonts 

You don't have to· install pictorial 
· fonts like Cairo into your System to 

have easy access to them. Create a 
FullPaint document with the desired 
characters in the graphic fonts, and 
then, when you need them, open the 
file, copy the characters, and then 
paste them into your work. 

Creating Transparent Text 

Transparent text can be created while 
pressing COMMAND-OPI'ION while 
selecting the text insertion point. Any 
pattern beneath what you type in will 
show through the text. 

Putting White Text on a 
Black Background 

To create white text on a black 
background, press OPI'ION when 
clicking the text cursor on a black 
background. 



Fill Outside of a Shape 
Instead of Its Inside 

Hold down OPTION-SHIFT while 
filling a shape with the Paint Bucket 
to fill the outside of the shape instead 
ofthe.inside .. 

Cut or Copy All White Or 
Empty Space Within Lasso 

Press OPTION while l~soing an 
object to cut or copy all the white or 
empty space selected. It will then be 
cut or pasted along with the graphic 
image. 

QUickly .Creating a 
Borderless. Shape 

Create a borderless shape, without 
changing the border width to a dotted 
line, by pressing OPI'ION while 
drawing the shape. 

Selecting Objects Tightly 
Packed Among Other 
Objects 

Select an object that's stuck in a tight 
spot by double-clicking the loose end 
of the lasso directly on the object. 

Variable Eraser Size 

To create variably sized erasers, user 
the selection :marquee to define the 
size of the area, then press 
COMMAND-OPTION_to use the 
selected area as an eraser. 

FULLPAJNT-GRAPHICWORKS 1.1 

Game Within a Program 

.The old public domain mathematical/ 
cellular. game, Life, is built. into , 
FullPaint. You can create a Life form ; 
with either the paintbrush or the 
pencil tool, then select it with the 
selection marquee and press 
COMMAND-OPTION-L. Each .time 
you press this combination, the life 
form .will advance one generation.!' 

Recovering Corruptor 
Damaged Files 

Corrupt or damaged FullPaint 
documents can sometimes be 
recovered by changing the document's 
creator from PANT to MPNT. using a 
file editor. When this has been done, 
you can often open the document with 
MacPaint. Save it as a MacPaint file, 
then open it with FullPainL This can 
clean up corrupted files that cause 
System failures when opened directly 
from FullPaint. 

~ 
~GraphicWorks 1.1 
SJM!cify New Origins on .. 
RUlers 

You can specify the new origins {zero 
points) on either the horizontal or 
vertical rulers by dragging the cursor 
from the ruler's comer box. If you 
don't like your changes, it's not easy . 
to re-drag the zero point back to its 
original place. A quick way tO do this 
is to triple-click in the ruler's comer 
box, which sets both rulers back to 
th~ original zero poinL.. · 
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._ GrayPalnt 
GrayPaintJMacPaint Combo 
Lets.You Work on Entire 
Page At Once 

Gray Paint can't work on an entire 
page at a time. But you can work 
around this, and get some interesting 
results, by copying a selection of the 
active GrayPaint window and saving 
it as a MacPaint document. The 
selection will expand to fill the 
MacPaint page, and Gray Paint's gray 
scale information will be transferred 
with the image to give it an unusually 
smooth look. 

Turn Any Area Into a Fill 
Pattern 

A powerful feature not fully explained 
in the manual is the ability for any 
area to be turned into a fill pattern. 
To do this, select the desired area 
with the marquee, choose DEFINE 
FILL PATTERN from the Edit menu, 
and, holding down SHIFI', fill an area 
with th~ paint bucket tool. 

~Helix 
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Plan Function Before 
BUilding It When Using 
AbacUs· Icons 

To use one of Helix's abacus icons to 
perform complicated calculations, 
remember· you should plan your 
function before building it on the Mac. 
If possible,- try to break the 
calculation irito modules, then 
combine them in the ·final calculation .. 

This has the added benefit of letting 
you use the modules in other 
calculations without having to start 
from scratch again.· 

lfyou can't break a complex 
calculation into modules, plan it on 
paper before constructing it on the 
Mac. A quick flowchart now can save 
hours of confusion later. 

Viewing Entire Complex 
Calculation · · 

Seeing the entirety of complex 
calculations can be difficult, since you 
have to view portions of it by.scrolling 
the window. View the whole 
calculation by printing it out on the 
Image Writer by selecting Print Scaled 
Page from the File menu. This doesn't 
work on the LaserWriter. 

Avoiding Icon Confusion 

Complicated relations clutter your 
desktop with a lot of icons. To keep 
from getting confused, name your 
most important and frequently-used 
icons in all uppercase letters, which 
makes them stand out. Then, move 
less used icons off to the side of the 
window, and arrange your icons in 
logical groups for easier tracking. 

Save Time-Copy Old 
Calculations, Then Modify 
Them 

To· create a calculation with an abacus 
icon that only differs slightly from 
another one that's already created, 
duplicate the original calculation's 



icon and then modify the copy to 
create the new calculation. 

Save Time While Setting Up 
New Relation 

When setting up a Relation for the 
first time, several fields wiii probably 
have formats different from default 
settings. Save time by creating one 
field with each of the formats you 
plan to use, then replicate them as 
often as you11 need (one for each 
format) and name them 
appropriately. 

How To Move A Single Tile 

To move only a tile, click and drag 
anywhere on the tile, except in an 
arrow or blank space. 

Move A Single Arrow 
Segment 

To move an individual arrow 
segment, click on it and drag. 

Moving Groups of Segments 
or Tiles 

To move a group of arrow segments 
and/or tiles, use SHIFT -CLICK to 
select the individual elements to be 
moved, or surround the group with 
the selection rectangle. 

~Installer 
Selecting More Than One 
Script 

When you want to instaii more than 

HELIX-JAZZ 

one script on to a disk, Installer 
doesn't allow you to immediately 
SHIFT-Click to select multiple items. 
When you want to choose more than 
one, click on the first script, wait for 
Installer to do its calculations, and 
then SHIFT-Click 

~Jazz 
Power Off Before And Mter 
Work Sessions 

Before and after you use Jazz, tum off 
the power switch on the Mac for a few 
seconds. That's because the program 
adds its own embellishes to memory 
that can't be erased by the reset 
button. Turning the power off 
eliminates any leftover bits of 
program from the memory. 

Link a Copied Graph to a 
New Worksheet 

People who do a lot of graphics work 
will appreciate this shortcut, if they 
feel comfortable using a resource 
editing program: If copies are made of 
worksheets and graphics, Jazz keeps 
new graphs linked to old worksheets 
and duplicating the graph serves no 
purpose. But you can solve this by 
changing the reference board of the 
graph, linking it to a different 
worksheet. Use ResEdit or a similar 
program to edit #LFRF# and change 
the old file name to the new file name. 
Never use a resource editor on an 

, original application-only modify 
copies! 
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Trouble-Free SYLK File 
Conversions 

If you're converting a SYLK file from 
another spreadsheet into Jazz, make 
sure that none of the cells in the file 
are formatted. Otherwise the Mac will 
try to convert a file with formats but 
accomplish nothing except a lot of 
noise. Converting an unformatted file 
only takes a few minutes. 

How Much Memory Jazz 
Allocates To Each 
Application 

Jazz allocates specific memory sizes 
to each of its applications. If you close 
an application you aren't using, Jazz 
allows another application to use the 
extra memory to create larger 
documents. Jazz allocates: 
237K to the operating program 
70K to the spreadsheet (it requires 
only 3K if the database is already 
open) 
97K to the database (it requires only 
30K if the spreadsheet is already 
open) 
45K to graphics 
70K to the word processor 
26K to communications 

Printing Empty Cells 

When you create a database report, 
empty cells will print as zeros. Get 
around this by entering OPI'ION­
Spaee in any cell that you want blank 
in the printout. 

Cut And Paste In 
Communications Mode 

When using Jazz's communications 
option, cutting and pasting messages 
makes things work a little easier. 
First, store all the messages you have 
to transmit into a word processing tile 
on one side of the screen. Then cut 
them, one at a time, and paste them 
into the communications window. 

Loading Jazz Spreadsheet 
Data Into Excel 

Jazz can import data in a number of 
formats, but it can't export in 
anything other than text format. It's 
possible, though, to load Jazz 
spreadsheet data into Excel. First, 
save each column of data as a text 
file, then load each into Excel, pasting 
it into its own column. Formula 
information isn't transferred, though, 
so you'll have to re-enter it in Excel. 

When The Program Tells 
You It Can't Print Your 
Document 

Sometimes the program will tell you 
"This file can't be printed." There 
seems to be no specific cause of this, 
but it happens more often on a Mae 
attached to an AppleTalk network. 
This happens because sometimes Jazz 
gets confused and scrambles its port 
configuration memory. The most 
convenient solution is to make sure 
Jazz is told which printer it should 
use, and how that printer is 
connected, by selecting Chooser or 
Choose Printer. Install this quick fix 



in Jazz's System file, and use it at the 
start ·of each session. 

LIIJ Key Caps (Desk Accessory) 

Making Screen Dumps of -
Key Caps Special 
Characters 

If you use Finder 5.3 and System 3.2, 
there's a catch to taking screen dumps 
of the special characters that can· be 
displayed in the Key Caps DA. The 
dumps should be done in the Finder 
with no windows open. 

To get a dump of the characters 
shown when only OPTION is pressed, 
press the OPTION key than bold 
down the mouse button while the 
cursor is not over the active window. 
While still holding down the mouse 
button, press CO:MMAND-SHIFI'-3 
and then press the OPTION key 
again before releasing the mouse 
button. 

To get a dump of the characters 
displayed while SHIFI'-OPTION is 
pressed, use the same procedure 
described above, except instead of the 
two times you must press OPTION, 
press SHIFT-OPTION instead. 

~MacDraft 
Use MacDraft To Produce 
Laser-Printable Diagonal 
Dotted Lines 

You might find that diagonal dotted 
lines print poorly on a LaserWriter. But 
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you can use MacDraft to produce 
quality diagonal lines: Startby editing 
a pattern so that most of the pattern is 
black, with a one-or two-pixelcolumn or 
row being white. Now confirm that 
you're drawing with a non-dotted line, 
and choose that special pattern you've 
drawn as the ink for the line by holding . 
down OPriON while selecting the 
pattern. 
Try. drawing a few diagonal or dotted 
lines. Later, you can alter .the special 
pattern for better control of the pattern. 

Don't Name Documents The 
Same As MacPaint 
Document Names 

Be careful when naming your files. If 
you save with the same name as a 
MacPaint document in the same 
folder, the new MacDraft document 
will not be accessible from the 
application. To open the dpcument, 
you'll have to use a file editing 
progr-am like MacTools or Fedit. Open 
the file and change the creator to 
MDFI' and type to DRWG. This will 
allow MacDraft to acc~ss ~e file. 

Create Original Pa~ 
Easily 

Want interesting, original patterns 
in MacPaint? Create a patterned 
object in MacPaint, then copy an 
area of the pattern and paste it into 
MacDraft. With the object selected, 
experiment with choosi~g different 
patterns from the Fill menu. The 
MacDraft pattern will overlap the 
MacPaint pattern, with almost 
limitless different results. 
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Use Smoothing to Make 
Complex Arcs · 

MacDraw's arc tool is limited in the 
complexity and variety ·ofarcs·it.can 
generate. Butyou can make complex 
arcs by using MacDraw's smoothing 
functions. Use the polygon tool to 
draw ·a two-vector shape, then' select 
SMOOTH from' the Edit menu. After 
you've experimented with this for 
awhile, you'll be able to create very 
complex arcs. 

Creating Proportionally· . 
Spaced Text Lines 

Create lines of text with proportional 
spacing by creating each individual 
text object and then lining them up 
vertically. Now, select them all with 
the selection marquee and GROUP 
them. By stretching. the grouped· text 
with ·the comer and upper/lower 
resizing handles, the vertical spacing 
between the lines changes 
proportionally. 

Quickly Select the-Las~·Tool 
Used 

To automatically select the last tool 
you used, hold down the·COMMAND 
key while pressing the ·mouse button. 

Centering Items Perfectly 
in the Middle of the Page 

There's an easy way to ·center an item 
exactly in ·the middle of the page. 
Once the page is created,: type the text 

you want to center, approximately 
where you want to place .it. Then ; 
choose REDUCE TO FIT to create a 
rectangle wide enough to cover the 
entire width of the page. Choose · . 
NONE from the Fill menu, so you can 
see the objects behind the rectangle. 
Then, just select the rectangle and 
SmFI' -CLICK the text iteiJ). you want 
to center. Now, choose ALIGN 
OBJECTS from the Arrange: menu 
and click on L-R CENTER, then click 
OK You text will be centered on the 
midpoint of the box. Use this 
technique to center objects 
horizontally by clicking TOP­
BOTTOM instead. 

Grabbing Tiny Resizing 
Handles 

If you're working with very small 
objects, it can be hard to grab their 
resizing:handles, instead moving the 
object when you didn't mean to~ To 
avoid this; create a second, larger. 
object, and SmFI' -click on both, then 
group them and use the resizing 
handles on the larger element to 
shrink'or stretch both. When you're 
done, ungroup them and delete the 
larger element. 

Pro_portional Enlarging and 
Reducing 

To proportionately reduce or enlarge 
an object, draw a one-inch by one-inch 
square (with SHOW SIZE active). 
SHIFI' -SELECT this square with .the 
object to be reduced or enlarged Place 
the arrow cursor on the comer of the 
square and drag it to the size desired, 



pressing SHIFT to guarantee 
propo~onalenl~ementor 
reduction. 

Print Out a MacPaint 
FatBits Screen 

You can use MaeDraw to print out a 
MacPaint ·FatBits 'screen. First, copy 
the MacPaint image into the 
clipboard and quit MacPaint, then, 
without resetting the Mac, launch 
MaeDraw and paste the image down. 
Then press COMMAND-G: to ·group 
all the pixelir together (choose the 
Wide option from the Page Setup 
dialog box or. use the Drawing .. Size 
option to make the document larger, 
then Reduce To Fit). Click once on the 
·pixel group to giv~.it handles and 
then drag one of the comers 
diagonally to stretch the ilnage as 
large. as· you like. (Use the Normal 
Size option to see its real size.) When 
.you're finished, print the file. If you 
stretched it l~e enough, your 
collection of FatBits pixels. comes out 
much larger than MacPaint would 
print it. . 

Maintaining Fill Patterns 
When Transferring to Bit­
·Mapped· Program 

When transferring an object graphic 
to a bit-mapped prognun like 
MacPaint or FullPaint, you can 
maintain the original fill patterns 
ratio. Select the area that the object 
graphic will be pasted into by using 
the· selection marquee, and then paste· 
the graphic.' It· will scale itself to the 
size specified by the marquee without 
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distorting. If you resize it after it's 
been deselected, thougb,··you'll get a 
distorted stretch. 

Selecting Multiple Objects 
AtOnce . . .~ 

The SHIFT key allows you to select 
more than one object. · 

Duplicatilig Objects Easfiy 

Duplicate any single or group of 
objects by selecting them and 
choosing Duplicate frQm the Edit 
menu. If you move the fii·st copy you · 
made, and then duplicate the copy, 
your new duplicate will be placed in 
the same position tbat'the first copy 
was, in relation to the original. To 
make,a row of objects, put the first 
copy next to~ the original image,,_then 
duplicate copies until the row is : · · 
completed 

Toggling to· the .Grid Option 

When the Grid option is tumed off, 
you ean temporarily. call it up by . 
holding down the SHIFT key: -while 
you move an object. Press SHIFT 
after yolive pressed the mouse button 
to pick up the·objectyou w~tto· 
move. 

Redrawing the Object Most 
Recently Created ... ·.· · 

.. 
· If you have to redraw the same. eype of 
object that was most recently created, 
you .don't have to reselect the action 

, -from the icon panel .. J~st hold do}VIl r 

the Command key and click at~ the 
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place in .which the new object should 
be drawn. The previous action is 
automatically selected, so your image 
appears. 

Automatic Selection of 
Objects 

All the objects drawn -while 
CO:MMAND is pressed are 
automatically selected when. the . 
CO:MMAND key and mouse button 
are released. 

Creating Unusual Sizes of· 
Fonts 

To create an unusually sized font, 
type in text in MacDraw and copy it 
intO Microsoft Word, which can 
stretch or shrink itto any size· 
required. The new size font even 
prints out perfectly on ~e 
Laser Writer. 

Selecting All Text Witbin'.a 
Block 

To select all the text within a text 
block, triple cliCk on the text tool in 
the .teXt block. 

Always Use the Same 
System to Create, Display· 
and Print 

A MacDraw doeument·created with 
one System and called up on another 
might not show up, ·or might show up 
distorted. For example, if you create a 
MacDraw figure using a 14 'point font 
and bpen·the doeument with a System 
that only contains a 10 and 12 point 

font, the character spacing will be 
incorrectly computed. The solution 
is to be sure that any MacDraw 
System you use contains the same 
fonts and points sizes installed on 
the System that created the original 
document. 

Avoiding Default to Geneva 
Font 

If you'd like to use a specific font for 
all your MacDraw text, change the 
font before selecting the writing tool. 
If you don't change it, the font 
defaults to Geneva and you'll have to 
choose. a new font every ·time you 
switch into text mode. 

The Easy Way. to Sign. Your 
Name 

Y ou·can keep your own signature on 
file in MacDraw, ready to affix to any 
document. First, write your name a~ 
large as you can using the free-hand 
tool. Read that as Large. Use the 
Smooth, Unsmooth and Reshape 
commands until you're satisfied with 
it, then Group all the letters and grab 
the lower right handle to reduce it to 
the desired size. Finally, paste it into 
the Scrapbook. You can. save a· forf:,une · 
on pens and ink! 

Previewing Horizontal. c 

Layouts 
\ 

Preview how horizontal layouts will 1 

look when printed by selecting Wide 
from the Page Setup option in the 
Print menu. This will show you the 
-horizontal orientation ofyour_page. 



When You Can't Complete 
the Print Command 

Sometimes when you print a multi­
page document, you might get a 
message that says the print command 
cannot be completed. To work around 
this, print only a few pages at· a time. 

Laser Printing Small White 
Type 

If you have trouble laser printing 
small white type, try typing the text 
in Outline style, then fill in the 
background and stretc~ the object to 
double its size, horizontally and 
vertically. Then, specify 50% 
reduction in the Page Setup dialog 
box. Your white type should print 
much better. 

Enlarging or Reducing Can 
Clip Document Text 

When you laser print a document 
containing text, you might experience 
clipped text printouts if you use more 
than a 150% enlargement or more 
than a 75% reduction. 

See the Graphics, Not the 
Rectangle · 

To see a graphic image instead of a 
rectangle while moving images· 
around your page, press OPTION. 

An Easy Way to Make 
Perfect Hollow Lines 

If you use MacDraw to produce road 
maps, or have another need for 
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hollow lines, this procedure can raise 
the quality of the work: First draw 
the map, making all lines with the 
third line thickness on the menu. 
When you've completed the lines, 
group them all, duplicate the group, 
and set the line thickness of the 
duplicate lines to the second line 
thickness on the menu. Then, under 
the Pen menu, set the pattern of the 
duplicate lines to white~ Select both 
groups and align both centers. The 
white group will "carve" out the 
centers of the road, giving a high­
quality, elegant look to the finished 
work. 

Microsoft Chart Graph Cells 
Become Individual 
Elements 

When a graph created in Microsoft. 
Chart is cut and pasted into 
MacDraw, each piece of the chart 
becomes an individual element. You 
can add a lot of spice by dressi_ng up 
the chart lines to reflect whatever 
the chart is about ... for example, a 
dollar-figure chart could show stacks 
of dollar bills instead of dull bar 
lines. 

Wrapping Text Pasted From 
the Clipboard 

You can paste text from the Clipboard 
and have it wrap within an area. 
First, create the rectangle that you 
want to wrap the text within, and 
type any character (the space bar will 
do). Any text that you subsequently 
paste in will wrap to the size specified 
by the rectangle. 
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Centering Primitive Objects 

Center any of the primitive objects 
(circle, rectangle, etc.) on a page by 
drawing the object, Cutting or 
Copying it, and then clicking the 
pointer where the object's center of 
gravity should be. Then Paste. 

(k:S MacGolf 
Putt Like a Pro 

Here's a tip for professional-level 
putting: Once you get on the green, 
make sure the wind is at zero, face 
away from the hold, and then place 
·the swing indicator at zero. Click once 
on the up arrow and putt, recording 
how far the putt goes. Now, do the 
same thing again but click twice in 
the swing indicator's up arrow. Keep 
doing this, adding one click each time, 
until you reach a full-strength putt. 
This will help you figure out how 
many clicks you need to do to get the 
ball to move different distances. See 
you at the championships! 
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Less Disk Swapping 

Using this program with an internal 
and external disk drives means it's 
often necessary ·to insert the State or 
Business Forms disks. If you leave 
th:e disk with the System inserted 
and swap one of the data disks, you 
won't have to do as much disk­
swapping. 

~~J Maclightning 2.0 

Set RAM Caching to 128K or 
Less 

When using this program with a Mac 
Plus and RAM caching, set the 
caching control to 128K or less to 
enable the entire dictionary to be 
loaded into RAM. This gives you 
optimal functioning speed 

Don't Capitalize Non-Proper· 
Nouns In the Dictionary 

MacLightning recognizes capital 
letters that begin words. That means 
you should only add non-capitalized 
words to the dictionary, unless they're 
proper nouns. If you add capitalized 
words to the dictionary, they'll show 
up as misspelled words when they're 
not capitalized. 

Check Spelling Before 
Making Dicijonary Entries 

As with any spelling checker, always 
double-check word spellings before 
entering them into the dictionary. 
Otherwise, you'll have a program that 
replaces misspelled words with 
misspelled words. 

Spell-Checkers Can Be Used 
as Word Counters, Too 

MacLightning can be used as a poor 
man's spelling-checker. If your word 
count must be completely accurate, 
though, add about 20%-30% for 
single-letter words. 



~MacMoney 

Making an 800K Disk That 
Accepts Data Flles 

The ·manual doesn't explain how to 
use this program with only one BOOK 
disk drive. When creating a new 
"system," MacMoney won't allow the 
data files to be saved on the same 
disk as the program. Once the 
"system" has been created on a 400K 
disk, just copy it and the data files to 
an BOOK disk. 

Fit More Transactions On· 
Disk With Minifinder 
Instead of Finder 

If you use MaeMoney with a single 
BOOK disk, it won't allow for the usual 
maximum of 3000 transactions 
allowed on a 400K disk. You can fit 
more transactions on the BOOK disk 
by creating a Minifinder and 
removing the Finder, fonts and desk 
accessories. 

~MacPalnt 
Leave Enough Disk Room to 
Work 

MacPaint requires a lot of free space 
(about lOOK) on the disk in order to 
work properly. If you're creating 
several documents, save them to a 
different disk for the time being. You 
can copy them back to the MacPaint 
disk for fine-tuning work later. 
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Hints For Saving Disk Space 

Another way to free up space is to 
remove the Image Writer driver from 
your MacPaint system file. MacPaint 
doesn't use the driver to print 
documents. 

MaePaint documents take up a 
minimum of2K on the disk. When your 
disk is getting full, transfer lesser-used 
documents to a dift'erent disk. 

If you can, store several small 
MacPaint illustrations in a single file 
to keep the disk from filling up. 

Straight Lines in a Snap 

Drawing straight lines can be a drag. 
To make sure you don't wind up with 
a page full of jagged lines, hold down 
the Shift key while positioning and 
using the straight line tool. This 
constrains movement to 
vertical/horizontal only. 

Restraining Works 
Throughout the Program 

The same restraint can be applied to 
the paint brush, pencil, spray can, or 
eraser tool. Just hold down the SHIFI' 
key, then use the tool. 

You can even restrain the active 
window or the graphics elements in 
the Show Page mode by holding down 
the SHIFI' key. You'll only be able to 
drag them up, down, or to a 45-degree 
angle. 

The SHIFT key can also be used to 
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restrain movement to 
vertical/horizontal only while you're 
repositioning the page in the Show 
Page option. 

The Fast Route to FatBits 

You can take the express route to 
FatBits-and work on the exact area 
you want to, at the same time! Just 
select the Marquee tool and use it to 
frame the part of the picture you need 
to work on. Then, double-click on the 
pencil tool, and voila! You see a close­
up of the part you selected with the 
marquee. Just use the pencil to create 
or erase black pixels. And, while 
you're using the pencil in FatBits, 
pressing the Shift button changes the 
pencil into a hand ... so you can move 
the page easily, without having to 
switch tools. (As soon as you release 
Shift, the hand turns back into a 
pencil.) 

Another way to access FatBits quickly 
is to choose the Pencil tool, hold down 
the COMMAND key, then point to the 
spot you want to work on and click 
the button. Don't double-click, or 
you'll find yourself back in regular 
bits mode. Release the COMMAND 
key and the pencil behaves normally. 

Erasing Large Portions of 
the Screen 

Want to erase large portions of the 
screen fast? Select one of the shape 
boxes (choose the colored one, not the 
see-through version). Now, pick white 
as the fill color and select the dotted­
line (invisible) outline width. Finally, 

draw the shape directly over the part 
of the screen you want to erase. You'll 
probably have to clean up the edges 
with the eraser. 

Another way to eliminate large 
illustrations is to choose Show Page 
from under the Goodies menu. Move 
the page until the offending picture 
has disappeared from the screen, then 
hit the Okay button. When you 
reposition the page again, you'll find 
that the section you moved off the 
screen has disappeared for good. 

The lasso can also be used to erase 
large or irregularly-shaped objects. 
Outline the shape, then backspace to 
erase it. 

For large, uniformly-shaped areas, 
you can use the marquee to highlight, 
then backspace to erase. 

Customizing Erasers 

The eraser doesn't have to be a 16 x 
16 pixel square. You can make it as 
thin, thick or round as you like by 
selecting the paintbrush tool and 
choosing white as your color. 

The Fast Way to Get to 
Brush Shapes 

Take the express route to the Brush 
Shapes window by double-clicking on 
the Paint Brush tool. 

Edit Brush Shapes With a 
Font or Resource Editor 

The brush shapes can be edited 



through the use of a font editor. Use 
one that has the ability to access fonts 
stored as resources with applications. 
The font stored in MacPaint is "12." It 
contains characters with ASCII 
values 120-151 that make up 
MacPaint's brush shapes. Just use 
the font editor's edit mode to. alter 
these characters to the new brush 
shapes, then save the changes you've 
made. From now on, these brush 
shapes will be displayed in the Brush 
Shape dialog box. 

Trim MacPaint By 13K With 
ResEdit 

Another ResEdit trick lets you trim 
MacPaint by 13K. Delete two PICT 
resources (2401 and 2400), which are 
the Short Cuts and Introduction 
screens. 

Creating a Ruler to Keep 
On-Hand 

If you find yourself wishing you had a 
ruler whenever you need one, your 
wish can come true easier than you 
think. Open a word processor that 
contains a ruler, such as MacWrite. 
Take a screen dump of the ruler using 
COMMAND-SHIFT-a, then open the 
resulting PICT file, edit out all the 
other elements, and copy the ruler to 
your Scrapbook in MacPaint. You now 
have a ruler that's always accessible. 

Making Multiple Copies of 
an Image 

Make multiple copies of a MacPaint 
illustration by highlighting the 
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graphic with the lasso or marquee 
tools, then pressing COMMAND­
OPriON as you click and drag the 
picture around the page. 

Controlling Space Between 
Copies 

You can control the space between 
copies made by choosing a line width 
that corresponds to the amount of 
space you want between each copy. 
Choose a narrow line width for copies 
spaced closely together, and a wider 
one for more distance between the 
two. 

Creating Straight-Line 
Multiple Copies 

Multiple copies of an image can be 
created in a straight line by pressing 
SffiFl'-COMMAND-OPriON while 
dragging the image being copied. 

Avoiding Pattern Distortion 
in Multiple Copies 

Sometimes when you make multiple 
copies, the patterns can be distorted. 
Remedy this by choosing the Grid 
option before making copies, since it 
creates an automatic grid that's eight 
pixels apart. 

Stretching Images 

To stretch an image, use the marquee 
tool to select the entire picture, then 
press COMMAND while dragging the 
edges of the highlighted image. Drag 
from the edges and you'll find that 
one dimension of the image is 
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stretched. Drag from the comers and 
both horizontal and vertical 
dimensions of the image will be 
altered. 

Kee:ping Patterns Intact 
Dunng Stretching 

You an keep patterns from distorting 
while stretching by holding the 
SHIFT key doWn while dragging 
edges. 

·Proportional 
Stretching/Shrinking of 
Rectangular Images 

When working with a rectangular 
image, you can control proportional 
stretching or shrinking by holding 
down SHIFT-COMMAND while 
stretching from the edges. If you drag 
from the comer while holding down 
these keys. the proportions of the 
picture will remain intact. Drag from 
the sides a~d the horizontal stretch or 
shrink is limited in proportion to the 
vertical position of the cursor. 

Keeping Rectangle Patterns 
Intact While Resizing 

Keep the pattern of your stretching 
rectangle intact by holding down the 
SHIFT key while stretching. 

Merging Patterns in Shapes 

It's possible to place one patterned 
shape over another without obscuring 
the original shape. Press COMMAND 
while selecting the paintbrush, spray 
can, paint bucket or shape drawing 

tools. When you select this mode, both 
shapes' patterns will merge at points 
where they overlap each other. 

Change Fonts Without 
Creating a New Entry Point 

Changing fonts can be a problem, 
especially if you don't want to create a 
new text entry insertion point. But it 
can be done without changing the font 
of text you've already entered, by 
pressing the ENTER key and 
choosing the new font or style. Once 
this is done, though, you can't 
backspace past the point where the 
ENTER key was pressed. 

Changing Font Size of 
Entered Text 

You can change the font size of text 
entered by pressing COMMAND and 
both arrow keys(< and>). 

Changing Font of Entered 
Text 

Change the font of text already 
entered by pressing COMMAND­
SHIFT and the arrow keys. 

COMMAND-period changes the text 
to the next larger size. 

COMMAND-comma brings it down to 
the next smaller size. 

COMMAND-SHIFT-period changes 
the entire entered block of text to the 
next font shown on the Font menu. 

COMMAND-SHIFT-comma changes 



entered text to the previous font 
· shown on the Font menu. 

Grid Option Assists Tex~ 
Entry 

Use the Grid option while working on 
.documents requiring a lot of text 
entry, since it makes it easier to align 
new text inserts. 

Adding ·New Patterns to 
Patterns Palette · 

If you create or find a pattern that 
you'd like to add to the patterns 
palette, choose a pattern you think 
you can live without. Then choose 
Edit Pattern from the GOodies menu 
and just click the mouse on the part of 
the screen that shows the pattern you 
want. The new pattern replaces the 
old one, and you didn't have to create 
it pixel by piXel. 

Cataloguing MacPaint 
Doc1unents On a Different 
Disk 

You can print a·catalofN.e ofMacPaint 
documents on a different disk than 
.the MacPaint application is on. Just 
open any MacPaint document on the 
disk you want to catalogue, then 
choose Print Catalog from the File 
menu. 

Creating Ultrabold Letters 

You can create ultrabold text letters 
by entering your text in Bold and 
Outline from the Style menu, then 
use FatBits or the paint bucket's Fill 
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option to fill in space inside each of 
the letters. The Fill selection gives 
letters a shaded look. · 

Creating Psychedelic 
Letters 

Letters can be given a psychedelic feel 
by selecting text portions with the 
marquee and pressing COMMAND­
SHIFI'-E a few times. Each time you 
press, the letters become outlined 
more interestingly . 

. Shadowing Images 

Shadows can be added to MacPaint 
images easily. Select the drawing 
with the marquee. Now, hold down 
SHIFI' and select Trace Edges from 
the Edit menu. 

Lasso Tool Doesn't Have to 
Be Closed Loop . 

The lasso tool doesn't require you to 
completely encircle the object you're 
lassoing. When you release the 
button, the lasso automatically 
completes the loop in a straight line 
back to the point where it started. 

Don't Reinvent the Wheel If 
You Don't Have To 

You don't have to be a great artist to 
produce beautiful graphics. Either use 
a clip-art program or take a MacP&int 
snapshot of interesting graphics by 
pressing COMMAND-SHIFT-3. You 
can then customize the graphics in 
FatBits to suit your illustration 
needs. 
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Printing Multiple MacPaint 
Copies ' 

You can't specify how many copies of 
a MacPaint document to print. To 
work around this, go to the Desktop 
and duplicate the document with the 
DUPLICATE command from the File 
menu, copying once for each print 
you'll need. Now, hold down SHIFT 
while selecting the documents (or else 
drag a group selection), then choose 
PRINT from the File menu. Each file 
will be printed out, so you'll end up 
with multiple copies. 

~MacPascal 
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Running Multiple Programs 
Ina Row 

It's possible to run multiple programs 
in a row by first selecting them on the 
desktop, then choosing Open from the 
File menu. If you have an 
Image Writer attached and running, 
you'll get the added bonus of a log of 
the activities performed. 

Quick Debugging 

A quick way of debugging a program 
is to select it on the desktop and then, 
with your Image Writer turned on, 
choose Open from the File menu. Any 
errors will show up on both normal 
error messages and on the printout. 

Close Unnecessary Windows 

When executing a large program, or 
just a memory hog, invoke the 

command HIDEALL to hide all 
windows, and then SHOwrEXT to 
display the windows you'll actually be 
using while the program executes. 
Believe it or not, an open program 
window can consume over 20% of the 
memory in a 512K Macintosh before 
you even run the program! 

Hit Return Instead of Brace 
When Entering A Lot of 
Remarks 

When doing a large number of 
remarks one after another, hit Return 
after the end of each line, instead of 
using the right brace. Pascal 
automatically types the brace for that 
line, as well as the left one for the 
next line. 

Text-Only Files Can Be 
Read As a Program 

MacPascal can read text-only files 
created in word processing programs 
like Mac Write. That gives 
programmers an easy way to write 
and edit programs. When you save 
your document as text-only, choose 
the save option that puts returns 
after paragraphs, not lines. 

Warning on Possible 
Incompatibilities 

If you've been given MacPascal 
version 2.0, it's time to look a gift 
horse in the mouth. 2.0 contains 
major bugs. For example, running it 
on a Mac with old 64K ROMs, System 
3.1.3 and Finder 5.2 results in a 
pretty spectacular crash. 



~Mac Project 
Using MacProject ·to 
Estimate Hours· · 

When you're estimating a project; it's · 
often helpful to know the total hours 
needed, and when the most time will 
be required. You'can figure this 
within MacProject by entering a 
resource cost of $LOO per hour for 
each resource in" RESOURCE COST 
ENTRY under the Chart menu. The 
resulting CASH FLOW TABLE from 
the Chartmenu)vill sbow.both the 
monthly and the cumulative time 
requirements. ·. 

Incompatibility With New 
Macs 

The Guided Tour disk enclosed with 
·. :MacProject isn't fully compatible with 

new Macs (Plus, SE, etc.). Although 
the demos run, they can't find the 
files they're supposed to work with. ; 
The result is a cursor on an "Untitled" 
document. 

E Mac Publisher Ill •• 
No Free Space on Master· 
Disk 

The graphics palette won't function 
properly when you use the application 
on the original disks, since there's no 
free space available on the master·· 
disk. The solution is to use 
MacPublisher m on a disk which has 
been cleared ofthe sample files~ 

MACPROJECT~ACSERVE 

fill MacServe . 
Incompatibilities 

The archiver in version 2.0 is not HFS- ' 
compatible. To get around this, you'll 
have to use a backup utility provided 
by the manufacturer of your hard disk, 
back your hard disk up with a tape 
drive, or back your. files up~to disk~~tes. 
If your files are too large to back up on 
a single disk, copy them to MFS 
volumes and then i\lSe tbe ~hiver.; 

MacServe 2.0 has trouble with the 
RAM-based HFS released with ~., 
Apple's Hard Disk 20 prior to the 
introduction of 128K ROMs. Don~t run 
MacServe 2.0 with ~-based HFS. 

The .Font/DA Mover, version 3.0, 
shouldn't be used with MacServe,. 

· since it can cause .s:ome very unusual 
system crashes. U.se a later version. , 

. Problems.With,Early SCSI 
HardDisks ·~· 

Some support software provided .with 
early SCSI hard drives contains bugs ; 
that can causep~oblems with.reading: 
or writing to the disk. ~~ will. show 
up if you erase the disk and its name 
doesn't reappear in the Erase Disk. 
dialog box. If this happens, contact. 
the drive's manufacturer for ·a ·J 
corrected .support software. version~ 

Use· Only Applications,.That 
Don't,Have to Use ,Printer., 

.Port :··l. 

Some applications, espe~a}ly 
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terminal emulators, access the printer 
port directly. To ensilre that you can 
use these programs with MacServe 
(especially its print spooler), use only 
the applications that can be ·. 
configured to use the modem port 
instead. 

Enter Dummy Printer Name: 
When Disabling Spooler 

When you disable MacServe's print 
spooler,. enter a dummy printer name 
that is not closely related to the word 
"'mage Writer" in the ·Manager. dialog 
box. 

When Using Two Printer 
Drivers, ReiUime One 

Having both an Image Writer Driver 
and an AppleTalk Image Writer driver 
in your System file confuses the print 
spooler. When you use both, rename 
the Image Writer driver to a different 
name. If you won't be using the print 
spooler, remove the Image Writer 
Driver, leaving only the AppleTalk 
lmageWriter Driver. 

·MacServe Can Choose 
·Printers 

MacServe can take over all·the 
functions of the Chooser or Choose 
Printer desk accessories. Just install 
it using the MacServe Installer· 
utility. Then, to avoid confusion, tum 
off AppleTalk with Choose Printer or 
the Control Panel and use the 
FontJDA Mover to remove Chooser·or 
Choose Printer from your disk. You 
won't need them, even to print· 

through AppleTalk. 

Showing MacServe Where 
the Image Writers Are 

When you first install MacS~rve, it 
may not be able to locate AppleTalk­
connectedlmageWriters on the 
network. If this happens, reinstall 
Chooser and use·it·to select the 
Image Writer. Then, remove Chooser 
and let MacServe take over from·. 
there. 

If the System Crashes ••• 

If one of the users on a MacServe 
network has a system crash, don't 
select the MacServe DA or the entire 
network could hang. While this is . 
very rare, you can avoid potential 
headaches by waiting to choose 
MacServe until the crashed system· is ; 
backup. 

If your network crashes, try 
restarting your Server immediately. If 
no users have requested extensive 
disk operations, this will re-establish 
the links to your users' applicatio~. 
and document·tiles. You'll get best 
results if you ask your users to stop 
work immediately if the Server 
crashes. 

Causes of System Crashes 

When users are .logged on to the 
network, don~t modify your Server 
System files, since this is likely to 
cause a crash at the Server node, 

· ca1ising problems for all the other 
users. Very·standard modifications, 



such as moving fonts, should work 
well, though. 

Once you start initializing a disk, 
even MacServe can't interrupt the 
process. So, if'your system is 

-~,,functioning as the Server on the 
MacServe network, you can't initialize 
a disk or· the. system will crash, 

·· freezing the network. Use another 
system to initialize that-disk, or else 
wait until the network has been shut 
do'wn. If you have a· constant need for 
disks, pre-initialize them and then 
leave them by your Server Mac. 

When You•U_pdate the · : 
· System, U~date·MacServe· 

Immediately · 

When updating the System on your 
hard disk, MacServe files may be 
damaged. Avoid problems by· 
immediately-updating::MacServe.With 
its Installer utility after making · 
msjor changes (such as updating 

.. version numbers) to your System 
software. · _ 

Keep XIJServe Node Names 
Short' 

·If your network is connected to any 
XUServe nodes, keep the disk and 
print server names short, under 14 
characters each. 

Why Can't This Disk Be 
Erased? 

MacServ:e doesn't allow you to erase a 
·disk containing open files. If you're 
having· problems erasing a seemingly-. 

MACSERVE 

:-closed disk, check for a discarded 
Clipboard file, or other files that 
might remain open. 

· The.MacServe Manager won't allow 
you to erase the disk on which it 
resides. To erase a hard disk hold . 
down OPl'ION-COMMAND when 
starting the Manager from a floppy so. 
that.the Mac uses the-floppy's SYstem · 

. to start up. 

Formatting~olumes ~ HFS 

Volumes created with the MacServe 
Manager utility are always created in 
MFS. If you want to format in HFS, 
you have to:.erase the volume after 
choosing ·HFS in the Erase Disk __ 
dialog box. 

Plan Volume Sizes in 
Advance 

HFS requires that each volume on the 
hard disk be intemally contiguous, 
that is, not fragmented into several 
sections on the disk. If you use 
MacServe under HFS, plan the -
number and size of volumes before 
allo~ting any to th,_di •• You 
probably won't be able t.o make 
additions or changes until you 
completely restore your disk first. 

Leave Room For Volume 
EXpansion 

In creating volumes with MacServe's 
Manager, the application starts at the 
outside of the hard disk and wor,ks its 
way -in to the center. Your System 
files will be located on the outs~de 
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edge,:followed by your volumes. If·youi 
enlarge your System files by 
modifying them, they won't have room 
in the volume to expand. The hard 
disk will spread them into other ateas

1 

of the disk, slowing down hard disk 
and network performance 
considerably. To leave room for 
expansion, create an empty dummy 
volume containing enough space to. 
grow, and designate this as your first 
MacServe volume. When all the 
volumes have been created,·go back 
and delete the dummy volume, and 
you'll have- room for System 
expansion. 

Use· Subdividing Software 
Included With Hard: Drive 

When using MacServe on a hard disk, 
it's usually more -efficient to use the 
subdividing software that comes with 
the drive to create one large 
·subdivision. Then, superimpose 
MacServe volumes on top of the large 
subdivision. 

~MacSpell+ 
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Don't Use MacSpell+ ·With 
Boston II Font · · · 

MacSpell+ ·doesn't work properly on 
text containing lines of Boston n, 14-
point text. That's•because the 14-point 
size is actually a special. one-pixel 
underline font that fools Mac Write and 
Word into thinking it's text. But 
MacSpell+ won't be fooled. Instead it 
will crash or'lock-up the system. If you 
must use Boston n 14-point, insert it 
after·spell-ehecking the document. 

LID Mac•Speii•Right 
Fastest Way to Check 
Spelling 

Accelerate the spell checker by · , 
placing the cursor on the. first word of: 
your do~ment and opening , .. 
Mac • Spell• Right. Then, place the 
arrow on Change and:press Return to , 
activate the·spelling checker. If the 
word found in the Change To box .is 
correct. press return to go on. If it~s 
incorrect, click the mouse button to 
change it. When you've· finished spell­
checking your document, press 
Return, position·_the. arr()_w anywhere 
in the doCUD,lentt and click the mouse. 
That's it! 

'(A\?~acTerminal 
How to Use Cursor·-Keys 
Instead of Mouse 

If you prefer using cursor keys to mice 
while being connected to a remote. 
computer, hold down OPI'ION. This 
transforms the cursor into·~a four-way 
VT100-type arrow cursor tha.t can~be 
moved where you want. Then click 
the mouse~ The cursor key sequences 
will be·transmitted to the remote 
computer. 

Command Key 
Combinations 

MacTerminal contains a number of 
hidden command key combinations, 
which don't always work when you're 

- on-line, They always work off-line: 



COMMAND-H moves the cursor back 
one space; 

COMMAND-I moves the cursor to the 
right, stopping at the next tab 
marker; 

COMMAND-J moves the cursor down 
one line; 

COMMAND-K moves the cursor down 
two lines; 

COMMAND-M moves the cursor to 
the start of the current line; 

COMMAND-G tells the Mac to sound 
a tone. 

Use Hard Backspace When 
Correcting Mabiframe Data 

When you're communicating with 
mainframes, pressing Backspace will 
not correct data stored in the 
mainframe, though it may correct 
your screen display. To remove the 
character you backspace over on the 
mainframe as well, use COMMAND­
Backspace. 

Mac Plus Keyboard 
Substitution 

If using MacTerminal with a Mac 
Plus, hold down OPTION-ENTER 
instead of the ENTER you would have 
pressed on a Mac 512K. 

Create Replacement Mac-to· 
Mac Document 

The program supplies a Mac-to-Mac 

MACTERMINAL-MACTERMINAL 1.1 

document with preconfigured 
terminal settings. But if you 
accidentally trash this document, you 
can make a replacement: Start by 
pulling down the Settings menu and 
change the dialog boxes in Terminal, 
Compatibility, and File Transfer, in 
that order. In the Terminal Settings 
dialog, click New Line, Local Echo, On 
Line, Auto Repeat, and Auto 
Wraparound to On; in the 
Compatibility Settings dialog box, 
choose 8 bits per character, No parity, 
No handshake, and the baud rate the 
host computer will use; in the File 
Transfer Settings dialog, choose 
XModem, Retain Line Breaks, Word 
Wrap Outgoing Text, and Remote 
System equals MacTerminal. Other 
than that, leave default settings. 
When you've configured these 
settings, use Save As ... to save this 
document as "Mac to Mac." 

Avoiding System Hang 

Once in a while, MacTerminal will 
hang up after the host computer has 
answered the call. If you're using a 
Hayes-compatible modem, solve the 
problem by inserting a few commas 
after the phone number. Each comma 
causes the modem to wait two 
seconds, allowing MacTerminal to 
register the fact that a connection has 
been made. 

~MacTerminal1.1 
Why You Should Upgrade 

In this version, you don't have to tell 
MacTerminal to wait for a call you 
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want to answer, and if you use the 
Wait For Call option, MacTerminal 
won't answer the phone. Get the 2.0 
upgrade! 

Mt MacTerminal2.0 

Use ResEdit tO Correct 
Bundle Bit Problem in 
Transferring 

·This version prevents the Mac from 
setting the Bundle bit when you 
transfer files via the MacBinary 
protocol. This keeps you from getting 
the icons for the files you're 
transferring. To fix the problem, use a 
resource editor to CODE resource 15. 
Change 2F3C 0000 OOES to 2F3C 
0000 ESOO. Find both instances of this 
code and change it both times to solve 
the problem. 

~Mac 3D 
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Verify Selection by 
Rotating It 

Sometimes it's difficult to select part 
of a complex model and know exactly 
which part has been selected: To 
verify, choose ROTATE, and the 
currently selected object will appear 
in the Show Selection window. Once 
you've confirmed exactly what,you 
selected, click the Cancel button and 
you'll be back where you started-but 
with a better idea of what you're 
working with. 

~Mac3D2.0 

Creating Endmarks on Arcs 
and Curves 

Create endmarks on arcs and curves 
by attaching a small line to the end, 
then placing the endmark on that 
line. 

Importing QuickDraw 
Graphics 

Although the program has a Save as 
PICT function, a graphic saved that 
way comes through as a bit-mapped 
image when opened in MacDraw, 
PageMaker, and other graphic 
programs. To get a QuickDraw object 
from the program, copy the graphic to 
the Clipboard before copying it into . 
the graphics program. 

Adding Tiny Details to 
Drawings 

Add small detail to a drawing easily 
by increasing the sc~le of the 
document. This enlarges the objects 
and makes it easy to draw in small 
details. · 

Dimensioning Edges on 
Rotated Objects 

Dimension an edge on a rotated object 
by ungluing it down to its edges, · 
duplicating the edge to be 
dimensioned, and then moving the 
duplicate away from the object and 
choosing DIMENSION. 



Quickly Redrawing All 
Objects in a Window 

Click in the empty area on the tool 
palette, right underneath the tool 
icons, to redraw all of the objects in 
the window. 

Splitting Vertexes 

You can split a vertex into two 
vertices to get a new edge. Just enter 
the Bevel window, select the vertex, 
and bevel by 1 percent. 

~Mac Type 
Earning a Certificate 

This program requires that users 
achieve test results of 30 words per 
minute at 99% accuracy, or higher, to 
award a certificate. Or so it says. 
You'll have to do slightly better to get 
a hard copy of your achievement. 

Use Text-Only Option to 
Export Data 

Using the Text-Only option while 
saving deletes all fonts, styles, 
margins and other extras that are 
saved otherwise. Nonetheless, the 
Text format is easily transmissible 
over ASCII data lines, and is useful 
for transferring text data from the 
Mac to other machines, or from 
MacWrite to database programs. 

MAC3D 2.0-MACWRITE 

How Much Disk Space is 
Left? 

Check how much disk space is left by 
choosing About Mac Write from under 
the Apple icon on the menu bar. 

Text-Only Files Are Smaller 

Text files take up less space on the 
disk than Mac Write files, since they 
don't contain all that fancy formatting 
information. When you're backing up 
information to a crowded disk, save it 
in a Text file to free up about 30% 
more space. 

Defragment Large Files to 
Save Space 

Another way to save space while 
working with a large document is to 
periodically Save As ... instead of 
merely Save. Large documents are 
often highly fragmented as they're 
saved, and using Save As ... often 
shrinks the size of the file by as much 
as20%. 

You can also defragment a file by 
saving it to a different disk. 

Squeeze a Lot of 
Information into Headers 
and Footers 

Headers and Footers can contain up 
to 7 lines of information each. 

Numbering Pages With the 
Page leon 

The page icon automatically begins 
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numbering pages at 1. To eliminate 
the number on the first page, select 
Title Page from the Format menu. 

Changing Font Styles of 
Special Icons in Headers 
and Footers 

The special icons in headers and 
footers (date, time, and page number 
icons) don't change font or style 
unless you specifically highlight them. 
To do this, click at the beginning of 
the header or footer window and then 
select your font and style. 

Changing Font Styles in 
Headers and Footers 

Another way of changing an entire 
header or footer is to be sure the 
header ends with a carriage retum. 
Then click at the end, move to the 
beginning, and press SHIFT while 
clicking the mouse button. Now 
choose your style! 

Mixing Fonts and Styles in 
Headers and Footers 

It's even possible to mix fonts and 
styles between icon-driven and text 
entries in each window. Step one is to 
follow the procedure outlined above. 
Then type a space before setting the 
text's font and style. While different 
text information in headers or footers 
can be displayed in different fonts, all 
text produced by the icons will share 
the same font size and style. 

Mixing Text and Graphics 
in Headers and Footers 
You can't place text next to pictures 
in this program ... but you can move 
the special icons in the header and 
footer windows so it sits on top of any 
pasted graphics. Text these icons 
create will actually appear on pasted 
images. 

Making Larger Margins on 
a Page 

To get larger top and bottom margins 
in your document, insert a few blank 
lines in the Header and Footer 
windows by opening them and 
pressing Return. 

Using the Note Pad to 
Create Footnotes 

Mac Write doesn't have footnoting 
capabilities. But you can use the Note 
Pad to create them. Type your 
footnotes into the Note Pad as you 
write, then paste the text into the end 
of the document or at the bottom of 
your pages when you've finished the 
main body of the document. 

Clock and Calendar Icons 
Update Automatically 

The clock and calendar icons change 
automatically (they're controlled by 
the Mac's internal clock). So, when 
you print, you'll always get the date 
and time of the printing-not the date 
and time your file was created. 



Remembering Time and 
D~te a Document Was 
Completed 

If you want to know exactly what date 
you completed a document, keep it in 
the text portion of the page to avoid 
having it change with the calendar. 

Sometimes Printing Counts 
as Modifying 

Printing a document counts as 
modifying it in some versions of 
Mac Write. So if you want to check the 
date a document was completed, 
select it from the desktop and choose 
Get Info before you print it. 

Spacing Without the Ruler 

To add a space and a halfbetween 
paragraphs or lines without using a 
ruler, bit CONTROL-L (subscript) at 
the beginning of your new paragraph. 
When you reach the end of the text 
you want spaced that way, press 
CONTROL-L again to return to 
normal spacing. 

Create Exact-Sized Spaces 
lnMacDraw 

To add a space of a given size (for 
example, a three-inch space between 
test questions), you don't have to count 
out how many times to press Return. 
Instead, draw a line of the desired 
height in MacDraw, then make it 
invisible by selecting the dashed line 
or NONE in the pen menu. Now copy 
it, and when you need that space, just 
paste one into your document. 

MACWRITE 

Replacing a Single Word 

To change a single word, double-click 
on it to highlight it. Then, simply type 
in the new word It will appear in the 
space where the other word was. 

Highlighting Words Instead 
of Characters 

You can select by word instead of by 
character. Double-click on the first 
word, then drag the cursor, and the 
text will be highlighted word by word, 
instead of character by character. 
You'll find this especially useful when 
selecting text in scaled or small fonts, 
especially LaserWriter screen fonts. 

Carriage Return Signifies 
End of a Paragraph 

Never use a carriage return when you 
get to the end of a line, unless you 
mean to start a new paragraph. The 
text automatically wraps to the next 
line. When you hit carriage return, 
you'll find your next line indented as 
a paragraph, if you've used the indent 
marker on the ruler. 

Restoring the Last Text Cut 

If you mistakenly cut important 
information out of your document, 
press COMMAND-Z or Undo to 
restore the lost text. This will only 
work if you have made no other 
changes to the file in the meantime. 
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Use Cut Command When 
Moving Text 

If you need to cut part of a document, 
make sure you use the menu 
command Cut after highlighting the 
text to be moved. Pressing the 
backspace instead can lose the 
information permanently (unless you 
immediately Undo), especially if the 
text contains more than 50 typeface 
characters. When you edit with the 
Cut command, your data remains in 
the Clipboard until something else is 
cut or backspaced. To avoid losing any 
work, paste the cut data where you 
want it to be as soon as you've cut it. 

Restoring to Last Saved 
Position 

In a real emergency situation, the 
only way to restore data that you cut 
by mistake is to close the file without 
saving it. Then, reopen the file. It will 
remain the way it was as of your last 
Save command. 

Tab Key Ensures Laser 
Printouts Come Out 
Straight 

When printing on the Laser Writer, 
what you see on-screen isn't 
necessarily what you get on paper. To 
ensure that numbers and columns are 
lined up properly, use the Tab key to 
set them into place. Otherwise, you 
might find numbers or columns that 
lined up perfectly on your screen have 
printed awkwardly out of position. 

Decimal Tabs Override 
Regular Tabs 

Dragging a decimal tab on to a 
regular tab automatically changes the 
tab stop into a decimal tab. The tab 
marker may look like a regular tab, 
but it will behave like a decimal tab. 
To get a close look at the kind of tab 
you're working with, click on the tab 
marker or move it to reveal its true 
identity. 

Hidden Spaces Can Mfect 
Printouts 

If your text still doesn't print correctly 
after you've set up tabs for columns, 
cheek problem areas carefully for 
spaces that might have been 
inadvertently entered. Just erase 
them, and your printout should come 
out clean. 

Printing Problems With 
Long Documents 

If Mae Write says it can't print a 
document, it might be because the 
document is too long. Try printing it 
out a few pages at a time. 

Lack of Disk Space Can 
Cause Printing Problems 

Another printing glitch can result 
because there isn't enough space on 
the disk to save the document to the 
buffer. Either delete some files from 
the disk, or print a few pages at a 
time. 



Identifying Hookup 
Problems 

Another reason you might have 
trouble printing is because the printer 
isn't hooked up correctly. Watch the 
dialog box while trying to print. If the 
Mac first says "Looking for the 
ImageWriter/LaserWriter" and then 
can't print, check all connections. 

Finding the Printer in 
Apple Talk 

In AppleTalk printing, sometimes the 
printer doesn't show up in the Choose 
Printer dialog box. If this is the case, 
Quit the application and make sure 
the disk contains all the files you 
need. If it does, try this: In the Choose 
Printer dialog box, if the Laser Writer 
(or Image Writer) doesn't show up as a 
print option, disconnect AppleTalk 
and close the dialog box. Then, reopen 
the dialog box and select AppleTalk 
Connected. Your missing icon should 
reappear so you can highlight it. Now, 
try printing again. 

When Mac Write Says It 
Can't Print a Document 

If your bundle bit hasn't been 
properly set, you might also have 
trouble printing Mac Write documents 
directly from the desktop. If 
Mac Write says it can't print the 
document, and you have already 
exhausted the other possible problems 
discussed· previously, here's a simple 
thing to try: open Mac Write, then 
open the file. Now, try to print it 
again. 

MACWRITE 

Avoiding Image Writer· 
Delays 

When printing out MacWrite 
documents without a print spooler on 
the Image Writer, the program often 
delays unnecessarily while it sets up 
to scroll the last page out of the 
printer. The delay increases in 
proportion to how much scrolling will 
be done. Get around this by choosing 
the Cancel button as soon as the last 
line of output has completely finished 
printing. This causes the printer to 
take over and scroll the page out. 

Shortcut Past Page Setup 
Dialog · 

When printing on· the Image Writer, 
you can shortcut past the page setup 
dialog box by pressing Enter right 
after you select Print from the· File 
menu. This sets you up to print at the 
same density and paper type you last 
used, without the dialog box being 
drawn. 

Headers Can Cause Paper 
Feed Problems in Draft 
Mode 

When printing on the Image Writer 
using Draft mode, avoid using 
headers, substituting footers instead. 
When headers are used in Draft 
mode, the printer rolls the paper back 
after printing each page to print the 
header. That means the chances for a 
misfeed are dramatically increased. 
Put your important header 
information into a footer instead so 
that the printer doesn't have to wind 
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back. This. saves time-and paper. 

Printing Extra-Wide 
Image Writer Text 

With the Image Writer (not the 
LaserWriter) you can print Mac Write 
text up to a full seven inches wide on · 
the paper. First, complete your 
document. Then, without closing it, 
click the Title bar and drag the entire 
MacWrite window two inches or so to 
the left. Using the size box at the 
lower right comer of the screen, 
expand the window horizontally to 
the right, and you'll see that up to 
eight inches of the ruler have become 
visible. Reset the right margin to 8 
inches and let the text reflow into its 
new size. To view the text, slide the 
window to the left and right and· 
readjust sizing as needed. To save or 
print, just follow normal procedures. 
Reset to default margins by closing 
that document and choosing New 
from the File menu. 

You can accomplish the same thing by 
choosing the Wide box under Page 
Setup, but realize that if you do, your 
text will be printed out sideways on 
the page. 

If Italics Are Cut Off At the 
Margin 

Sometimes you'll find the last letter of 
an italicized word at the end of a line 
cut off during printing, especially if 
that line is justified to the right. To 
avoid this, insert an invisible "hard 
space" that the Mac recognizes as a 
character by pressing OPI'ION-

SPACE right after the italicized word. 

Avoiding Blank Last Page 
When Printing 

If you get a blank last page while 
printing, it's probably because there 
are extra spaces or carriage returns at 
the end. Solve the problem by going to 
the space after the last character in 
your text and scrolling down until you 
can't any more. You'll probably be 
able to·highlight a few lines of blank 
space. Just hit the back space (or the 
Cut command) and your blank last 
page should not appear again. 

Print on LaserWriter With 
LaserWriter Fonts 

If you're using the Laser Writer to 
print, make sure your font is not bit­
mapped, or the result will look · 
choppy. The LaserWriter 
automatically converts most standard 
fonts (Geneva becomes Helvetica, for 
example). But fancier fonts should be 
specifically created for, and installed 
into, the LaserWriter. 

Last-Ditch Fix For 
Corrupted Document 

IfMacWrite has Bombed while you 
saved a document, rendering your file 
unreadable by the machine, there's a 
fix using an editor like MacTools. Look 
for the first four bytes of the file's Data 
Fork and reduce that number by $20 
(for example, reduce from 0001 0258 to 
0001 0238). This often makes the 
document readable by the Mac again, 
without significant loss of text. 



Reformatting· Lines Withouti 
aNew Ruler 

You don't have to set up a new ruler 
every time you want to center, flush, 
or justify a line or two of type. Ju~t 
highlight the section and select the 
alignment option you want from 
under the· Format menu. Everything 
else will be left in place according to 
the Ruler setup. ·. 

Reformatting Paragraphs 
Without a New Ruler: 

. .. 
To reformat an entire par~ph, 
double-click any word on it, then 
choose format (flush left, center, etc.) 
from the Format menu or using the 
corresponding command keys. The. 
enti~ paragraph will be reformatted 
to the point in which the RetUI'I) key 
is pressed next. 

Right-Justifying Part of a 
Line 

If you have to right-justify only a part 
of:a line, use a decimal tab instead. 
For example, to place a numbered 
response blank at the far right side of 
a questionnaire, just set a decimal tab 
where-you want the rightmost , : 
character to appear. As long as there , 
isn't a period in whatever you typ.e·· 
after pressing the ·Tab key, those 
characters, complete with style · 
selections, will appear right-justified 
at the tab· point. 

MACWRITE 

Inserting a Word Without 
Using the Mouse 

To insert a word without taking yoJll" 
hands oft' the keyboard, backspace to 
the insertion point (make sure you 
don't backspace past 50 characters) 
and type in the word. Then hold down ' 
COMMAND-BACKSPACE to retrieve l 
the backspaced text from the buffer. 

Use Replace Option to 
Enter Repeating-Complex 
Words. ;; · 

If you have to type a complicated 
name or word repeatedly in your text, 
here's a way to shortcut all that 

1 
messy typing: Make up a nonsense 
word, or a word that isn~t used· 
anywhere else in the text; For _. 

·.example, Digital could be Just Dg. 
When you finish the document~ go, to 
the Search menu and select.Change. 
Change your nonsense word to the· 
actual word (choose the Whole Word 
option to avoid. inadv.ertently 
misspelling real words) and let the 
Mac do the complicated typing for 
you! 

Resizing the Main Wiildow 
to Accommodate: Large-:_·, 
·Screen Monitor 

The main· window can't be resized 
beyond the standard Mac scree~,.even 
when you're working. with a.large 
monitor or a software screen 
expander. But using,~sEdit, you·can ! 
patch MacWrite 4.5 t;c) make the 
window expand to a full page. The 
patch, consists of two part~ ... 
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In part one, you patch the code to 
allow for a larger window: Using 
ResEdit, open a copy of Mae Write 
(never alter an original application). 
Then open the CODE·resouree with 
an.ID of9 by double-clicking on the 
CODE line in the MaeWrite window, 

· ·then double-clicking on the line 
CODE ID=9. When the window opens, 
choose Find Hex from the Search · 
menu, searching and replacing the 
only hexideeimal occurrence of 0136 
with 0300. Then close all the windows

1 

and save the changes to MaeWrite. 
You can now resize the Mae Write 
window. 
If you want MaeWrite to 
automatically default to the larger 
window,· use ResEdit to open the 
Mae Write copy again. Double-click on 
the WIND resource line and locate 
and open, by double-clicking, the line 
-WIND ID::301. Change the value of 
337 (it's found in the third edit box) to 
768~ Close the windows, save the 

·changes, and youve got a MaeWrite 
that automatically opens to a large 
screen display. 

Delete Text Quickly With 
Enter Key 

Use the Enter key to delete text 
quickly. Just hold down Enter·while 
selecting the text. As soon as you 
release Enter, the highlighted text 
disappears. This·is not a Cut, and it 
ean~t be :Undone. 

· FintJjng the! Cursor in a 
Long Document 

When you're working in a large 
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document, sometimes you might lose 
the cursor. Just hit Enter to.rapidly 
scroll directly to the cursor entry 
point. 

Insert Invisible Bind 
Between Two Words;. 

There's a way to keep two words 
together on a line, even.ifMaeWrite 
wants to break them up. Just inseit 
an invisible binding space by pressing 
OPl'ION-SPACE in between the two 
words. The Mae wiTh treat the:.words 
as a single element. 

Keeping Key Caps Window 
Open When You Need It 

If you use a lot of special text 
characters in your work,.-it's a good 
idea to shrink the·word processor 
window down enough SQ that you can 
keep· the Key Caps window open at 
the bottom of the screen. · · -;; 

Stretching or Shrinking 
Pasted MacPaint. Graphi~ 

When you paste a MaePaint picture 
into MaeWrite, the image can be 
stretched or shrunk. Just· place the 
cursor over one of the three squares 
that you'll see on the bottom border. 
(Don't click anywhere els~that 
results in the picture being 
permanently placed!) Now; drag the 
mouse while still clicking to resize it. 
Release the button and the drawing 
reshapes itself. The only way to 
return the picture to its original 
proportions is to press Undo 
immediately after placing the picture. 



CorreCting Distortion in 
Pa~ted MacPaint Graphic& 

't 

Sometimes MacPaint 
:images-especially circles--look 
distorted when you paste·them into 
Mac Write documents. To correct the 
distortion, choose Page Setup from 
the Fil~ :menu and click, the Tall 
Adjusted box in the Orientatio~ ; 
option to stretch the picture 
horizontally. This usually works. 

Pasting MacDraw 
Docum~ts Into Large Fil~ 

When trying to paste a MacDraw 
graphic into a large document, you'll 
often get· a message saying· that the 
Clipboard is too large to -transfer. Not r 
only that, but the Paste command .. 
then fails! Get around this by Pasting 
the graphic to a New, empty 
document, then Cut and Paste it. into 
the docum~nt you.need it in. 

·Accessing~Special Font 
Characters. 

To accent a letter with a diacritical 
mark, pre~ OPI'IQN while pressing 
the key that creates the mark (this 
changes from font to font, so check 
·Key. Caps to find the proper key). 
Release both keys, then type in the 
letter to be accented. 

The same· technique applies to · , 
· :creating an· umlaut, or other accent 
marks~·, . ·. r: 

Make. anreJD dash (a long dash) by 
typing SHIFI'-OPTION-dash. 

MACWRITE 

Make an en dash (a very short dash) 
by typing OPI'ION-dash.-

·' ; 

·,Mac Write AS a Poor Man's 
Database~ 

You can use Mac Write as a . .short­
term database. Use Search, Find, and 
Find Next to quickly locate names, 
phone numbers, cities or addresses 
embedded in a document. 

Varying Spaeing Betwee:o 
Lines · · _ , . 

There's a way tc). vary the spacing 
between ypur lines ev~n more than 
you can with the three stand8rd _SI)$ce' 
controls. J~~i~ cb,oose any blapk.s:D&:Ce : 
on th~ lower of.the twol~peSr9,f ~xt, · 
then cb~ge. the font siz~ of that space 
to the size ju$ _larger-~- the. one 
you're writing with. ~e~entire line, 
·will move do~ a little to. l : • . 

· a~commott.~ the larger~foll~~pa~J 

Double-Underlining 
;Headlines 

Double-underlining headlines m&kes ' 
. them stand out on. the page. To 49· it, 
first press COMM.AND~U, then -. 
SHIFI'-dash. Type in a few doubl~ · 
underlines, then move the cursor hac~ 
a few.· characters and click. so that' : 
you'll end up typing intO -t)l~ Drld~~ of 

. your lines. Then, type in tb"-Jle.dline.; 

Highlighting .Large -Portions· 
of Text 

. ' 

There's a· quick way to select a . 
highlight a large porti<>n of text . 
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without having to scroll through it 
line by line.: Click at the end of the 
text you want to highlight, then use 
the scroll baron the right to get to the· 
beginning of the text. Holding the 
SHIFI' key, click on the beginning 
portion of the text. All text between 
the two click points will be 
highlighted. 

When You Import a 
Docum.ent·,With Too Many 
Carriage Returns 

If you receive a plain text file that has 
carriage returns at the end of every 
line instead of at the end of every 
paragraph, Mac Write can fix the 
problem. Load the text file into 
Mac Write, :and at the prompt, select 
the carriage return-after every line 
option. When :the file opens, all the 
text will have· run together, so you'll 
have to sel)arate paragraphs by hand. 

Saving Time When Setting 
Up Rulers 

Using the ruler to set -tabs, margins, 
etc. takes up· a lot of time on large 
documents. To speed things up a 
little, insert a new ruler above the one 
already there, set· the formatting the 
way you wantjt, and then select and 
Clear the rulerundemeath. The text 
following the ruler will then reformat 
to the -new: specifications. 

Creating a ~tie Page 

If your docliment requires an 

unnumbered title page, select Title 
Page from the Format menu. This 
keeps header or footer information 
from appearing on the first page. The 
next page printed will be Page 2, and 
will have all header and footer data ' 
included. · .. 

Varying Default Page. 
Number 

To make the second page of a 
document the first numbered page, go 
to the Format menu and select the 
.Set Page # option. Enter a zero, and 
your title page will be Page 0, 
followed by Page 1, etc. The only 
problem with this is that you can't 
choose to print only the· title page. If 

-. you need to, then temporarily·reset 
the title page to Page 1. 

., :· ·' 

The Set Page # option also lets you 
start numbering pages in any way · 
you like. For example, if you were 
working on a book and the second 
chapter began on page 45, you, could 
Set Page I to 45 for the Chapter Two 
document. 

Adjusting Subscript 
Spacbmg , 

When you use subscripts, you might 
be annoyed by the way MacWrite 4.5 . 
acijusts the line spacing on all lines 
that contain the subscripts. To get 
around this, specify in the ruler that 
the text to follow is to be six lines per · 
inch. This ensures uniform line 
spacing. Then use the line spacing 
icons to acijust for single~ double, or 1 

triple spacing. 



Quickie Word Count 

Want to count the number of 
characters in a line or paragraph? 
Select the area you need to count and 
choose UNDERLINE and OUTLINE 
from the Style menu. Look closely at 
the underscoring and you'll notice 
that at each interval of15 characters 
(including spaces), there's a small dot 
inside the double underscore lines. 
Count these dots and multiply' by 15, 
then add the number of characters to 
the right of the last dot. There's your 
character count. By the way, these 
dots won't appear when you print the 
document. 

Locked Documents Aren't 
Always Locked 

Be extra careful when working with a 
Locked document in MacWrite. 
Version 4.5 ignores the Lock Box set 
it the Get Info window. If you select 
Save instead of Save As •.• when 
working with templates, the template 
will be changed into your work file. 

Keep Backup Templates 

Avoid corrupting templates by 
mistake by saving template backups 
to a separate disk, used only for 
backup purposes. 

• Make Millions 
Reach Out and Touch 
Someone 

Tired of waiting for Manny the Mouth 
to call with the latest tips on how 

MACWRITE-MICROSOFT BASIC COMPILER 

much stock your competitor owns? · 
Give him a call directly by picking up 
the phone and dialing 62669. 

~Megaform 
Creating Automatic-Fills 
For Forms 

This program requires that each form 
has one cell that is manually filled 
out. You can get around this 
restriction by designing a form that 
uses its manually filled cell to force 
other forms to complete. For example, 
filling in a name on a master index 
card could force the creation of an 
index, a new record, and an updated 
customer record. 

~ Microsoft BASIC 
~Compiler 

Hiding Your BASIC Window 
When Running the Program 

Every pr~gram compiled will 
immediately display a window upon 
startup when you run it. This window 
often differs from the main window of 
the program you wrote. Plus, it's a 
dead giveaway that you wrote the 
program in BASIC! Use a disk/file 
editor application to patch the 
compiled program and eliminate this 
window. 
In the resource fork of the program, 
search for the hexidecimal string "00 
29 00 02 01 54 01 FC" and replace it 
with all zeros. Save the changes to 
your file, and you'll never have to look 
at that opening window again. 
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Restoring the BASIC Menu 
Bar 

If you stop a program that has its own 
menus, you can restore the MS 
BASIC menu bar by typing in MENU 
RESET. 

Stop a Document From 
Launching 

If you accidentally open a document 
from the Finder, but only meant to 
open the program, press COMMAND­
period while the program boots. That 
launches the application instead of 
the document. 

ChanP.g Font Size and 
S~le m List and Command 
Wmdows 

While MS BASIC allows you control 
over different font sizes and styles in 
the output window, there isn't an 
obvious way to change these for the 
List and Command windows. Do it 
using the POKE commands "POKE 
&H985, 4: POKE &H987,9". The 4 
represents the font ID number (in this 
ease, it's Monaco). Substitute the ID 
of the font you want to display in. ·The 
9 is the point size, so you should 
substitute whichever font size number. 
you want. 

Version 2.1 Glitch 

In version 2.1, if a Tab character is 
before a label name you'll get an error 
message. 

(-::.: ::::ffi Microsoft FORTRAN 
Make Each TYPE Statement 
Dispiar Information on a 
NewLine 

The TYPE statement is an easy way 
to output data on to the screen, but 
typed output is not followed by a 
carriage return (as it is with 
FORTRAN on other computers). This 
can lead to a problem in which 
information from each subsequent 
TYPE statement appears on the same 
line and runs ofF the screen; To have 
each TYPE statement display 
information on a new line, have your 
code tYPe the ASCII characters for a 
carriage return and a line feed at the 
end of each TYPE statement. To do 
this, include the following statements 
at the beginning of your MS 
FORTRAN programs: 
CHARACTER*! CR, LF 
PARAMETER(CR=13, LF=lO)· 
Once these statements are included, 
all TYPE statements should include 
the variables CR and LF at the end of 
each parameter list. For example: 
"TYPE *, 'This is the FIRST line', 
CR,LF." Other ASCII characters may 
be added to TYPE statements in the 
same way .. 

~MindWrite 
Sorting Text Within the 
Program 

It's possible to sort text within 
MindWrite. With the arrow cursor, 
click to the left of the paragraph you 
wish to appear first. Then click to the 



left of the other paragraphs in the 
order in which you want them to 
appear. Position the cursor to the left 
of a selected paragraph until a 
pointing hand appears. Hold down the 
mouse button until the pinching hand 
cursor appears, then drag that hand 
to where you want the items to 
appear and release the mouse button. 
The items will appear in the order in 
which you selected them. 

Saving Clipboard as a 
Document 

It's possible to save the contents of 
the Clipboard as a document. Just 
open the Clipboard window and 
choose Save from the File menu. 
MindWrite then prompts you for a 
name for the document. This saves 
the entire Clipboard, including the 
dotted lines that separate selections. 
You can then restore the Clipboard by 
opening the document, selecting all 
(COMMAND-A) and copying it 
(COMMAND-C). 

mustration Count in a 
Document 

It's easy to keep count of the number 
of illustrations in a MindWrite 
document. Just label all your graphics 
with a special word, such as "Figure." 
You can later count the number of 
times the word occurs by conducting a 
Find All for that word, then using 
Word Count on the resulting search 
document. As long as none of the 
illustrations have subordinates, the 
number of paragraphs in the Word 
Count box tells how many times the 

MINDWRITE-MINIWRITER 

word "Figure" appears. You can use 
the same method to count the · 
occurrences of any special word. 

Extra-Wide Printouts 

The program allows you to produce a 
document up to fifteen and a half 
inches wide on a wide-carriage 
Image Writer. Windows automatically 
zoom to the size of the screen, so you 
won't see more than six and a half 
inches of MindWrite's rulers unless 
you have a large external monitor or 
unless you drag the document window 
to the left and then resize it, larger, to 
the right. 

Text Wraps to Fit Ruler or 
Window 

You can choose to wrap text to fit 
either the window or the ruler. This 
means you can conveniently edit text 
in a window the size of your screen 
without the distracting movement of 
horizontal scrolling, and then later 
select WRAP TO FIT RULER to 
review line and page breaks. 

LID miniWriter (Desk Accessory)­

Scroll Screen Up and Down 

To actively scroll the screen up and 
down, press COMMAND in 
conjunction with the cursor key~. 

Bypassing the Opening 
Screen 

Use the keyboard to get pa~t the 
opening screen. Press COMMAND-N 
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while the DAis loading to start up 
with a blank document. 

· Access Text-Only 
Documents on the Disk 

Press COMMAND-O while 
miniWriter is loading to access other 
documents that have been saved as 
text-only. This opens the standard file 
selection dialog box. 

LVTMORE 
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Your Own Personalized 
Startup Screen 

You can personalize your MORE 
startup screen. Once you've "branded" 
your disk in this fashion, it's for 
keeps, so carefully consider what you 
etch into the startup. 

Displaying More Than One 
Level of Headline in a 
Bullet Chart Slide 

Sometimes you'll want to display 
more than one level of headline in a 
single bullet chart slide. To do it, Cut 
or Copy to the Clipboard each outline 
section that you'd like to see appear 
on one bullet chart slide. Open a 
document window and Paste in the 
contents of the Clipboard. The 
indentations remain intact. Edit the 
leader characters to your satisfaction, 
then go to the Bullet Subheads dialog 
box and tum off the Subheads, then 
leave on Documents. Your slides will 
show multiple levels when you do 
bullet chart presentations. 

Centering Bullet Charts For 
Printing 

To center a bullet chart on a page 
when printing, be sure to tum on the 
As Shown When Printed in the Bullet 
Options dialog box. If you don't, the 
chart will print the way it looks on­
screen. 

Indicating Where Sum Total 
Should Go 

The Calculate command normally 
positions the sum total at the 
beginning of a headline, although if 
there is already a number in the 
headline the sum total will replace 
that number. To indicate exactly 
where the sum total is to go, place a 
"$0.00" in the location you want to 
specify. 

Hiding Numbers From 
Calculations 

You can "hide" numbers from the 
Calculate command. MORE considers 
numbers containing a slash (/) to be 
dates, while it thinks of numbers 
containing a colon to be times. That 
means, any figures that contain these 
characters will be ignored when the 
Calculate command is executed. 

Dollar Figure Takes 
Precedence Over Other 
Figures 

If a headline contains both a dollar 
figure and a non-dollar figure in the 
same headline, the dollar figure takes 
precedence for calculations, while the 



other figure is ignored. For example, 
if you put both an expense amount 
and the date of an expense in the 
same headline, put a dollar sign in 
front of the expense and for 
calculations the date is ignored. 

Hide A Headline While 
Reorganizing Outline 

You can reorganize an outline by 
dragging a headline under another 
headline that has collapsed 
subheadlines and "hiding" it there. 
This lets you clean up your outline 
and concentrate on organizing the 
main details. 
To move a headline under another 
and hide it, select the headline you 
want to move. Then place the pointer 
to the right or left of the headline (or 
on the headline, if the Recognizes 
preference is set). Now click. The 
pointer changes to a right arrow. Hold 
down the mouse button and OPI'ION 
and drag the pointer underneath and 
to the right of a headline with 
collapsed subheads. Finally, release 
the mouse button. The chosen 
headline is now "hidden" at the end of 
the collapsed subheadlines. 

Fast Access to Tree Size 
Dialog 

You can quickly access the Tree Size 
dialog box by double-clicking on any 
of the orientation icons (the first four 
icons at the top of the Tree Chart 
palette). This dialog box lets you alter 
the exact dimensions of the boxes in 
your tree. 

MORE-MORE 1.1 

Quickly Opening Tree 
Options D1alog 

A quick way to open the Tree Options 
dialog box is to double-click on any of 
the box shape icons in the Tree Chart 
palette. This dialog box lets you 
a(ijust the patterns of the lines and 
boxes in the Tree, and also allows 
a(ijustment of grid lines, rulers, and 
page lines. 

LVTMORE 1.1 
Toggle Between Headlines 
and Document Window 

You can quickly toggle between a 
headline and its document window by 
pressing OPI'ION-ENTER. 

Key Equivalents Work in 
Dialog Boxes 

For all dialogs where there is no text 
input, you can use C for Cancel, 0 for 
OK, Y for Yes and N for No. If there 
are text entry boxes, use the 
COMMAND key along with the key 
for choosing the button. 

Cancel Dialog Quick 

Cancel any dialog by pressing 
COMMAND-period. 

Reversing Text Entry Point 

While the Tab key advances through 
text entry boxes of a dialog, SHIFT­
TAB moves the text entry point in 
reverse order. 
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Entering Tabs Into 
Headlines 

Enter tabs into a headline by typing 
OPI'ION-TAB. 

.Multiplan 
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Quick Column Addition 

Quickly add a new column to a 
spreadsheet by holding down SHIFT 
while clicking in the head of the 
column directly to the right of the 
position in which you want to insert 
the row. 

Copying Rows and Columns 
Into Word Processor 

It's easy to copy the rows and columns 
of your spreadsheet into a word 
processor. Just select all the cells in 
the spreadsheet and Copy them to the 
Clipboard. Then, launch your word 
processor make sure your word 
processor's tab settings correspond to 
the spreadsheet's column widths. 
Then, Paste the data in from the 
Clipboard. 

Sorting a Series of Rows 

To sort a series of rows, select all the 
filled-in cells in the column containing 
the "field" on which you want to sort. 
Then choose the Sort ... command. In 
the dialog box, click your sorting 
choice in ascending or descending 
order. The information in columns 
other than the one you sorted on will 
be rearranged to reflect the sorted 
column. 

Longer Header or Footer 
Text Than Text Box: Can 
Display 

You can create header or footer text 
that's longer than the box can display. 
To edit or view this text, place the 
cursor in the visible text near the 
rightmost end of the entry box and 
drag off its end. The text will scroll to 
the left and the "hidden" text appears 
highlighted and ready for editing. 

Recalculating New Value or 
Formula Entries 

If you're having a problem because 
new value or formula entries aren't 
recalculated into the rest of your cells 
until the document is saved, you must 
have turned off the Automatic 
Calculation feature. You can either 
just use CALCULATE NOW from the 
Calculate menu (also accessed with 
COMMAND-=) or you can tum 
AUTOMATIC CALCULATION back 
on from the Calculate menu. 

Rounding off Half-Pennies 

If your spreadsheet contains dollar 
figures with decimal places less than a 
penny, Multiplan executes the 
calculations exactly, using those 
values. You can choose the Round 
function to round the figures off to two 
decimal places before calculation, if 
you don't need such exacting figures. 

Fixed Numbers Act Like 
Text 

If you display a number with the 



FIXED function, it will act like text 
and can be treated as such for 
concatenation. 

Fonts Can Be Changed 

If you don't like the default font of 
10 point Seattle, change the font to 
9 point Geneva. You might even be 
able to fit more rows and columns 
on printouts. The easiest way to do 
this is to replace Multiplan's System 
file with the one from Microsoft 
Chart. If you don't have that, use 
the Font/DA Mover to remove the 
Seattle fonts from the System file. 
Then it will default to 9 point 
Geneva. However, you;ll have to 
reset the column widths to the size 
you want. · 

Printing in Helvetica 

· To print in 9 point Helvetica on the 
Laser Writer, use the Font/DA Mover 
to remove all Seattle fonts and also 
remove 18 point Geneva. In Multiplan 
versions 1.1 and later, this won't be 
necessary, since you can choose your 
fonts from the menu. 

Use Forced Page Breaks 
When Printing Large Sheets 

When you're printing large sheets of 
Multiplan documents, it's easier to 
used forced page breaks. These break 
up the spreadsheet into printable 
units. Then, select pages from the 
Print dialog box. This may sound 
cumbersome, but it's a lot easier than 
co~stantly selecting areas to print 
from the spreadsheet. 

MULnPLAN 

Squeezing More Data On a 
Page 

To squeeze extra data on to a page, 
choose a page size in Page Setup 
that's larger than the actual size of 
the paper you're using. 

Another way of getting more data on 
the page is to select the Page Setup 
option and set all page margins to 0. 

Tall Adjusted Print Option 
.is Better, But It Takes 
Longer 

The Tall Adjusted printout is much 
darker and more legible than the 
printout you get using just the Tall 
setting, but Tall Adjusted pages take 
almost twice as long to print. 

Simulating Freeze Title 
Option on Printouts 

You can simulate the Freeze Titles 
screen option on your printouts if you 
want. Copy and Paste an extra titles 
column at the leftmost side of each 
page, then .obscure it from view by 
dragging the column to its right, over 
the dotted lines. You can't see it on 
the screen, but the printer will 
produce the titles column in its proper 
position. 

More Columns Can Be 
Printed Than You ThiDk 

Multiplan can print columns up tQ 
128 characters wide with the 
orientation printing option, even 
though you can't enter numbers over 
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99 in ·the Column Width dialog box. 
First, open the spreadsheet and Show 
Values. Then use Column Widths to 
set the column width to exactly half of 
the width you want for the printout. 
Finally, select Show Formulas, and 
the column width will double to what 
you want. lfyou choose Column 
Width again, you'll get an "Invalid 
Column Width" message, but this 
won't affect any printing or 
operations. 

Highlighting Sections With 
a Graphics Program 

It's not possible to highlight 
particular sections of a Multiplan 
sheet. But pasting the document into 
MacDraw or MacPaint lets you add 
tints to highlight headings and 
important totals. 

Showing Cells That Need 
Alteration 

Use the Protect Document and 
Remove Cell Protection options 
together to set up a model in which 
cells that might require alteration 
show up as highlighted and 
unprotected. Then, to make changes, 
you can move instantly between these 
unprotected cells by using the Enter 
key. A plus is that row and column 
lines are suppressed on a protected 
sheet, making them easier to read 
and cleaner looking. 

The Easy Way Into 
Protected Spreadsheets 

To recover protected spreadsheets, all 
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you have to do is open the protected · 
document and Save As. Pick a new 
filename, Save, Close the protected 
document, and then open the Saved As 
copy and get to work. Protection does 
not transfer to new copies of documents. 

Putting Titles at the Top of 
Lists After Sorting 

If you compile lists and want the title 
at the top after the sorting, type a 
space before the title. This space has 
a lower ASCII code than any other 
single character. 

Possible Incompatibility 

If you use the System Update utility 
that came with Finder 4.1 on 
Multiplan 1.02, it makes some odd 
changes to the system fonts. For 
example, it designates 12-point New 
York as a system font, and assigns 9 
point New York as the font the Finder 
should use for icon labels. Remedy the 
problem by creating a new System file 
on another disk, and using Apple's 
Font/DA Mover to be sure the new 
System contains only Chicago 12, 
Geneva 9 and 12, Monaco 9, and 
Seattle 10 and 20. Then, running the 
Mac from the new System, trash your 
Multiplan System file and replace it 
with the new one. 

~Multiplan 1.1 
Embedding Formatting 
Commands In Header or 
Footer Text 

You can em~d formatting commands 



and other instructions into· the h,eader 
._.or footer te~. Insert the commands in 

the Page Setup dialog box: ··. 
&L aligns the characters that follow ' 
at the left margin; . 
&C centers the characters that follow;· 
&R aligns the characters that follow 
at. the right~ margin; 
&P prints the page qumb~r; 
&D prints the current date;·· 
&T prints the current time; 
&F prints the name of the document; 
~B prints the left, center, or righ_t 
part of the header or footer ia 
boldface; · · . 
&l prints the l~ft, center, or right part 
of the header: or footer injtalics; 
&& prints a single ampersand (&)~ 

-.~overVUE·· 
Previewing Reports 

: Preview a report by sa~g it to disk, 
then opening it with a ~xt processing 
desk accessory like.!4ockWri~ or 
miniWriter. You'll be able ,to see and 
print th~ report, and can even m~e 
changes witho~t re9pe~~g OverVUE. 

Problem-~.-ee Column 
Insertion · · 

Inserting a column into tl.te middle of 
a gw:oup of columns in a data file can 
confuse the report templates, ~cause 
thes~ templates relate to th~ ;position 
of a field on the line in .the.data 
column .. Fix the problem by choosiQg 1 

. Hide Fr~mes, then choosing-Show 
Frames, and then rebuilding your. 
report ~mpl_at8; to refer to the new 
line positions of the fields. 

MULTIPLAN 1.1-0VE~V.UE 2.1 

Embedding Tabs Wh(!n 
Exporting Data 

- . 
OverVUE doesn't use Tab characters ~ 
to separate fields, which c~ cause 
problems when you try to Paste 
information into a database manager 
or spreadsheet that uses Tabs as 
separat:Qrs. To remedy problems on. 
files you'll be exporting, place a ~de 
character (') between fields in the _ 
Report Generator. ·. ' 

Use Mac XL Edition-,With 
HyperDrive . · · 

.If you'll be running Over VUE on ~ . 
HyperDriye, be sure to ~e the ~c 
XL edition or you'll run o~t of .· ·, 
m~mory. 

Incompatibilities 

Over VUE might Bomb if.used in 
conjunction with memory ~che 
software like TurboCh.arger or 
PowerCache. If you find. yourself 
having trouble ~ning ~t wi~J)le,se 
programs, try a using a :smalle~ cache 
siie, or else delete the cache 
appliCation completely. Y~l:l.ehouldn't I 

experience problems using.~Ov~r.VUE : 
with the Mac Plus' automatic disk 
caching. · 

~OverVUE 2.1 
Don't Use GLOBAL 
REPLACE If You Can Help 
It 

In applying the GLOBAL REPLACE 
function, if the < or <= value~ are 
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applied,:you run the risk oftrashing 
some data, especially if you're 
working in a numeric column. To 
sidestep this problem, use the < or <= 
value with SELECT instead of 
GLOBAL REPLACE. After the 
selection is made, use FILL to replace 
the old data with the·new, then 
SELECT ALL to get all records back 
on-screen. 

BI!PackH Ill 
Packing Groups of Files 
Without Using File 
Selection Window For Each 

Pack a group of files without going 
through tlle file selection window for 
each one by moving all the files you 
want in the packed file. and Packlt to 
the desktop. Then, select them all by 
using the Shift key, the selection 
rectangle,· ·or both. When that's done, 
either double-c)ick on the· application 
(not on' a document) or choose OPEN 
from the File menU. You'll then be · 
req\l•ted io provide options and a 
destmation;filename, and the program 
will pack all of the selected dOcuments 
irito a Packlt file. 
Wh~ Ytiu,retum to the desktop, 
reselect all the documents and the 
application, and put them back by uSing 
the PUT AWAY command under the 
File menu. This last step is important! 

~PageMaker 
Correcting Underscoring 
~blems 

When making a "fill-in" sheet, the 

underscore characters you type at the 
end of each line will occasionally line 
up with the end of other lines. To 
correct· the problem, after you've 
completed the page draw a box over 
the:edges of the ends of the lines 
which encompass all of the associated 
lines. Give that box a white shade and 
"None" lines, so· it can't be viewed. It 
will cover (invisibly) the objects 
behind it. 

Easy Way to Identify.'Text 
Block Handles 

When working with a page containing 
a number of different text blocks, 
determining which handles belong to 
which block can be a problem. There's 
a workaround to the long handle l 
lines: Select, from back to front, all of 
the text in a1blQck arid then cut it. 
Then select the arrow tool and paste 
it in the text in the Clipboard. You'll 
notice that the text now has short 
handle lines in~tead of long ones. 
Still, selecting to the right will reveal 
the old_ handle lines, which can be 
deleted quickly by typing a backspace~ 

Deactivate Continued Text 
Handles in Version L2 · 

In PageMaker 1.2, a continued text 
handle '(which displays the + sign) is 
acCidentally clicked; the text doesn't 

· have 'to· be placed on to-the paste 
board (the areas on the sides of the 

··active page). Instead, deactivate the 
continuation by clicking on any of the 
tools in the toolbox. This ensures that 
your original text block won't be 
changed. · · 



Getting PageMaker to 
Remember Page Setup 
Alterations 

Choose ~age Setup frp.II).-the File . 
menu with no docume~t-open and 
only the gray desktop showing to, alter. 
your Page Setup settings in a way 
that PageMaker will remember. That 
way, whene\'er you start a new· 
publication, your altered settings will · 
be the default settings. 

.... ·,, 

Actual Size Display Rulers 
AreMostAccurate .- -' 

The 200% size has the most fracti.onal 
markings on the rulers, so you would 
assume t\iis :would be the most 
accurate, size-wise. But-that isn't _ 
necessarily true-in some cases, items 
that appear to be. correctly placed. in 
200% mode tum out to be slightly 
misaligned in .Actual Size. The 
printed version matches Actual Size 
display most accurately, so keep this 
in mind when placing objects on a 
page. 

Toggling to MacPafut-Style 
Hand Tool 

You can toggle to a MacPaint-style 
hand tool by holding OPI'ION down 
while clicking on your document in 
any other place but in. a column .m.Ude. 
Use the hand to drag·an image 
around the window and redraw _any 
portions that weren't on the screen 
before yo~ started the drag,. when the 
image has been placed. 

· .PAGEMAKER 

Disabling SNAP TQ:GUIDES. 

Tum,oft"SNAP. TO GUIDES an the 
Tool~ wen~#' you .don;t use it often .. If 
you w~t to make a move ~at isn'tr · 
affected ~y these guides,j~t be 

· carefW where .you place the pointer. If 
it's ~lose .to a guide when SNAP TO· 
GUIDES is turned on, the item you're 
moving will be affe~d by the gui,des. 
If you position the pointer away from 
the guides when you start the move, 
yo~'ll be able to place the element 
without any SNAP TO GUIDES 
!etr~cts. : . · : >-<:. · 

", ' .. ' 

PrintingonLaerWriter 
Plus Requires Version-1.2 or 
Higher · .... _ ··. 

If you'll be printing PageMaker 
doclJ]D.ents with the LaserWriter PJus, 
be sure yQu're working with 

. PageMaker 1.2 or higher, or the . 
printer will treat the newer ROM- .r 

based fonts (and other Adobe fonts) as : 
bit-mapped images, makingyour 
printout choppy and :ugly. 

Reset LaserWrite;r Before. 
Printing PageMaker 
Documents -! · 

If you have used .the Laser Writer to 
print from other applicaijons, tum -it 
off and then .back on again to reset it 
befor~ printing PageMaker -.. 
documents. This is.because 
PageMaker initializes the 

.. LaserWriter with Aldus Prep,.but it , 
doesn't replace the old Laser Prep file.' 
Both are memory hogs, so when .the 
Laser Writer· stores both it .slows down . 
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--:·in, printing speed· Likewise, 
reinitialize the printer after finishing 
your PageMaker printing. ·If the Mae 

:is·on a LaserWriter-eonlteeted ·. 
network and it seems to ·oo printing 1 

very slowly, someone probab1y · 
initialized the Laser Writer with Laser. 
Prep. Reset it to speed up p~nting. 

Evenly Spaced Lines in · 
DiffiCUlt Places 

There will be times·when you want 
evenly ·spaced lines in ·a place not 
easily divided with the ruler. To make 
them easily, create and save your own 
simple rulet·(With some division lines) 
in a PICT tile using· MaePaint or 
MaeDraw. Then, enter PageMaker 
and use the PLACE command to put 
your ruier on the page. Now, select 
the ruler and resize it to fit the space 
you need to ~divide. You can now draw 
lines using the ruler as a guide. When 
you're finished, remove the ruler.• 

Workaround For Graphic 
Clipping Problems 

When you open PICT files within 
PageMaker; a bUg sometimes surfaces 
that clips off the top part of. a graphic, 
especially if it eon_sists of text placed 
~ove graphics. Work around this by 
placing a shape· above the text and 
giving it no l~e fill or fill pattern. 
This invisible shape fools the program 
into including the full text. 

Toggling Between Full Page 
and Fit In Window Views 

Toggle between the Full Page and Fit 

In Window views by holding down the 
COMMAND key while clicking in the 
page window. ' 

Early ·venions Bomb When 
You Delete Several Pages in 
a Row·· 

·,r,, 

Early versions of PageMaker can 
crash ifyou·try deleting several pages 
in a row. :Avoid this by deleting only 
one or two pages at a time, saVing the 
document between deletions. Each 
page contains a lot of data, so the 
Save proeess is quite slow, but it's 
better than Bombing. Use PageMaker 
1.2 or higher to avoid this kind of 
etash~ 

Save Often to Avoid 
CorrU.pted Flles 

As with many page layout programs, 
PageMaker's complexity increases the 
chance that it will crash the. system. 
Make· sure to save your tiles often, 
and keep your backups and version 
numbers up to date. 

~ PageMaker 2.0 

Selecting Closely-Packed 
Objects 

When working with a number of 
objeets that are confined to a small· 
space; it's often hard to select the · 
exact object you want to manipulate. 
In PageMaker 2.0, you can flip 

··through closely packed objects by 
COMMAND-clicking near an object. 



Guide Lock Aids in Object 
Selection 

PageMak.er 2.0 places all non-printing 
guides "over the top" of a document, 
so it can be difficult to select items 
located on or under a guide without 
grabbing the guide by mistake. Use 
Guide Lock from the Options menu to 
lock the guides temporarily, making it 
impossible to select and move them 
accidentally. When you're done 
moving the objets, toggle the Guide 
Lock off by choosing it a second time. 

$Parameter Manager 
Copying Formulas to 
Another Calculated 
Parameter 

If you're entering a formula into the 
calculated parameter dialog box and 
you need to use the same formula in 
another calculated parameter, select 
the formula and use the Cut and Copy 
commands by their usual keyboard 
equivalents (COMMAND-X and 
COMMAND-C). You can then use the 
Next or Previous buttons to advance 
to the desired parameter and use 
COMMAND-V to paste in the cut or 
copied formula. Since the menu bar 
isn't accessible while the calculated 
parameter dialog box is open, the only 
way to edit these items is to use the 
keyboard equivalents. 

Quickly Scrolling to the End 
of a File 

You can speed up data entry without 
having to scroll to the end of the data 

PAGE.MAKER 2.0-PROFESSIONAL COMPOSER 

base to select a new date/sample field. 
Hold down COMMAND-OPTION 
while pressing Return. This will scroll 
you to the end of the file and place the 
cursor in the date/sample field, 
preparing you for entry in a new row. 

COMMAND-T does the same thing, 
except that it also enters the date, 
time and the next sample number. 

~ PowerCache 
Incompatibilities 

Running this program with a 
Hyper Drive 20 results in a Bomb. 

If you run PowerCache on a Mac XL, 
it will damage your System file. 

Different System Files Can 
Hang This Program 

Avoid switching disks that contain 
System files while working with 
PowerCache. It may cause your 
system to hang. The most frequent 
reason for this is users starting up an 
application from another disk when it 
contains a System file. You can avoid 
this problem if you keep a copy of : 
your application on a disk without a 
System file, using a PowerCache­
equipped startup disk to enter the 
application. 

~ Professional Composer 
Workaround For Ignored 
Rehearsal Marks 

Use the Print Parts option under the 
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File menu to "consolidate" rests in 
parts. However, in all parts other 
than the first, rehearsal marks will be 
ignored if rests precede and follow the 
rehearsal matk. You can fix the 
problem by inserting a thick barline 
nom the Barlines palette at the left 
side of any measure in which a 
rehearsal mark is inserted. Any 
barline at rehearsal marks, other 
than the standard one, force 
Professional Composer to break 
consolidated rests around rehearsal 
marks in parts where rests precede 
and follow the mark. 

Place Ties and Articulations 
After Transposing Parts 

When working with transposing 
instruments, be sure that you place 
your articulations and ties ~ryou 
TRANSPOSE PARTS. This program 
will not allow for the fact that the 
direction of note stems often change 
after transposition. Your articulations 
and ties will often end up on the 
wrong side of the notes, and redoing 
articulations and ties can be tedious. 

IF.il Quick ~ Dirty Utilities, 
~Volume2 

Reset FKEY to Simulate 
ShutDown 

Using the Reset FKEY can be a 
timesaver if your program freezes, 
since it performs an .operation similar 
to Shut Down, saving hard drive 
users the long recovery time after a 

system error. 
Sometimes if your mouse freezes, 
you'll be able to call up the Reset 

· FKEY, but will be unable to reset the 
Mac because the default dialog choice 
only allows you to Cancel the 
operation from the keyboard. But you · 
can solve it by patching the FKEY 
using a disk/file utility application. 
Start by opening the FKEY in its own 
file and changing the one hexidecimal 
occurrence of 67 40 to 6640. Then, 
make an ASCII change of"Reset" to 
"Don't" and an ASCII change of the 
occurrence of"Cancel" to "Reset!" 
(Make sure to include the apostrophe 
and exclamation point.) Save your 
changes, then install the modified. 
FKEY in yotir System file. 

([:·:;!Ill] Radius FPD 
Turn On Custom Feature to 
Activate Screen Blinking 

If you have the Radius FPD installed 
in your Mae, but the Radius screen is 
tumed off, the automatic screen 

· blanking won't work unless you have 
at least one custom feature turned on. 

®J Rags to Riches 
Charts Can't Be Deleted, 
But They Can Be Redefined 

}llan carefully before creating your 
Chart of Accounts. You can't delete a 
chart once it's been added. It can be 
completely redefined and used 
elsewhere, though. 



Key Codes Are Forever 

Caution also applies when you assign 
a key code to an account. Once this 
has been done, you can't use that 
account without a key code, although 
you do have the option to change it to 
another code. Unused key codes won't 
interfere with the program's 
operation. 

Capital Account Is 
Calculated When You Print 

Usually, a set of books has a Capital 
account which reflects accumulated 
profits or losses. The Rags to Riches 
GIL doesn't keep this as a regular 
account in your chart, but instead it is 
calculated when you print an Income 
Summary and Balance Sheet report. 
The figure will appear on the Balance 
Sheet as "Computed Retained 
Earnings" underneath the owner's 
Capital account. 

Combining Files on an 800K 
Disk 

You can combine Rags to Riches files 
on to an BOOK disk. Just make a 
startup disk containing the fonts and 
printers you'll be using, and then copy 
the program files to this disk. You 
need files carrying RR logo icons, 
named Ledger, Payables, and 
Receivables. You should still have 
room for the Templates folder as well 
unless you have numerous printers 
and fonts in your System file. 
Now, make a data disk that contains 
no System and save the data files to 
this disk, backing it up periodically to 

RAGS TO RICHES-RAMDISKS 

head off potential disasters. 

1m;:) I RAMdisks 
Configuration to Minimize 
Disk Swapping, Maximize 
Application Storage 

To minimize disk swapping and still 
allow several applications on a disk, 
try this setup: configure the RAMdisk 
to contain the System file, Finder, 
and Image Writer driver. Than, after 
booting the RAMdisk, remove the 
System disk and you'll have two free 
disk drives if you work on a two-drive 
system. Put a disk containing the 
applications you want to use in one 
drive, and you'll find the disk space 
gained by having no System or Finder 
leaves enough room for several good­
sized applications. Leave the second 
drive empty, inserting disks when 
they're asked for. 

Modify Phantom Copies of 
Applications 

If you're going to attempt complicated 
changes to an application program 
(for example, if you'll be modifying it 
in ResEdit), load a phantom copy of 
the application. into the RAMdisk and 
make the modifications there. That 
keeps your disk copy safe, and if the 
worst case happens and you 
completely scramble the data, just 
start over by powering off and on. 

RAMdisks Aren't 
Permanent Storage 

Whenever possible, avoid storing data 
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files on a RAMdisk. If you do, be sure 
to save your files to floppies often so 
you never lose data in a crash or 
power failure. 

Save As ••• Slows Operations 

Once you've used Save As ... , most 
applications will work with the copy 
on the disk, ignoring the RAMdisk 
copy and slowing down applications. 
You can avoid this by immediately 
invoking Save As ... again to save back 
to the RAMdisk. 

~RamStart 
Kee:p Programs to Be 
Copied At Root Level 

Avoid problems when using version 
1.0 with an HFS system by keeping 
all the programs you want to copy to 
the RAMdisk at root level. Versions 
1.21 or 1.22 don't have as much 
trouble using HFS. 

• Ready, Set, Go! 2.1 
Tips For Importing 
Formatted or Tabbed Data 

If you're bringing heavily formatted 
and/or tabbed data into the program, 
use a screen-to-Clipboard DA like the 
Clippy FKEY or the Quick Grab DA 
from Quick & Dirty Utilities Vol. II. 
Bring your information in as a 
graphic or series of graphics (take bit 
map dumps of word processor 
screens). Matching the Mac Write 
ruler with Ready, Set, Go's block 
layout in Switcher makes this easy. 
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Only bring in finished documents, 
though, since if you have to make 
corrections you'll have to reimport the 
word processor screen. This should 
work when you're using any program 
that accepts Clipboard graphics. 

.Ready, Set, Gol3.0 
Wrapping Text Around Text 

It is possible to wrap text around 
other text. Just choose Specifications 
from the Special menu and pick "run 
around." The resulting text can wrap 
around the text block just the way it 
can be done for a picture. 

Viewing Page At Text Block 
Insertion Point 

Using COMMAND-1 to COMMAND-S 
to view a page can be annoying, since 
you always see the upper left comer 
of a page. To work around this, while 
the text tool is activated, click and 
hold the mouse button with the cursor 
in the text block you want to zoom to. 
Still holding down the button, type 
the Command key to zoom to any 
factor. When you release the mouse 
button, the view will shift to show the 
insertion point in your text block. 

Import Documents of S2K or 
Less 

If you're importing a complex PostScript 
document, cheek the size of the file first. 
It has to be 32K or less to import 
properly, because Ready, Set, Go! 3 is 
limited to 32K text blocks. Using longer 
documents is asking for trouble. 



Use Program's Own 
Drawing Tools To Save 
Printing Time 

Although Ready, Set, Go! is excellent 
at importing 300 DPI graphics, if your 
needs aren't too complex, try to make 
do with the drawing tools in the 
program. It saves considerable time 
outputting a page. You can create 
pretty elaborate logos with some 
imaginative use of the fill patterns 
and shapes, and your page will print 
almost as fast as if it was text-only. 

B~ass GET PICTURE By 
Usmg Clipboard Instead 

Although most people copy graphics 
from files using the GET PICTURE 
routine, you can skip a step by 
passing an image through the 
Clipboard. If you work with a drawing 
or painting program and RSG under 
Switcher, cut the image to the 
Clipboard, switch to RSG, use the 
cropping tool to prepare the target 
graphics block, and then Paste. You'll 
still have the same control as if you 
had imported the image through a 
file. 

Link Text Blocks in Exact 
Order, Page By Page 

When linking text blocks together, be 
sure to link them in the exact order 
page to page that you want. The 
program won't assume that you want 
the blocks linked in numerical page 
order, but instead will take your 
commands literally. If you try to link 
up the blocks from front to back, the 

READY, SET, GO! 3.0-RED RYDER 

result will be an awful mess. 

&Red Ryder 
Disabling the Opening 
Screen 

Disable the opening screen by 
creating a dummy file (such as a text 
file with a single character in it) with 
the name RRJ$, then place it on the 
same disk (when using MFS) or folder 
(when usingHFS) in which Red 
Ryder's application is located. 

Versions 8 or Higher 
Incompatible With 128K 
Mac 

If you're still using a 128K Mac, don't 
use Red Ryder versions 8 or higher. 

Other Incompatibilities 

Version 7.0 can have compatibility 
problems when used on an Apple 
Hard Disk 20 under HFS. With this 
configuration, if you put Red Ryder in 
a folder, that folder can take up as 
much as 15 megabytes of disk space 
and prevent it from being available to 
other programs unless the folder is 
deleted. Either don't put this version 
in a folder, or upgrade to version 9.2. 

Version 8 can crash upon Quitting if 
you are using a Mac with 64K ROMs 
and a hard disk. Again, upgrade to 
version 9.2. 

Version 8 also has problems in using 
CompuServe's B protocol. For the last 
time, upgrade! 
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Toruing the Mac Into a 
Mainframe Terminal 

You can use Red Ryder to turn your 
Mac into a mainframe terminal. The 
ability to write procedures simplifies 
logging on, and you can use the 
VT100 emulation mode to produce a 
good full-screen terminal. The ability 
to define macro keys and have thirty 
of them available at a mouse click 
reduces the need to remember a 
jumble of mainframe commands. But 
perhaps the most convenient feature 
is the ability to copy from the screen 
by dragging the mouse. Combine this 
feature with the Paste to Modem 
command, and an IBM mainframe 
can be given a substitute clipboard. 

Smooth Scrolling in 'lTY 
Mode 

Implement smooth scrolling in TrY 
mode using Red Ryder version 9.4. 
Just select VT100 Mode from the 
Special menu and then check the 
Smooth Scroll Mode box. Red Ryder 
will now produce smooth scrolling, 
even in 'ITY mode. 

'-. Resource Editor 
B (ResEdit) 

Always Work On A 
Backup-If Not, You Could 
Be Sorry 

First and foremost, never work with 
ResEdit on anything other than a 
backup copy of your application. 
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Using RAMd.isks As Work 
Disks 

Your safest bet when using ResEdit it 
to work from a RAMdisk. Create a 
ResEdit disk containing the System, 
Finder, ResEdit, and RAMdisk 
programs, using no folders. Then copy 
the application you want to customize 
to the RAMdisk. Set RamStart as the 
startup application and then Shut 
Down. Then, reboot using the disk. 
You'll find that working from a 
RAMdisk speeds up the moves 
between your application and 
ResEdit, and RamStart spits out your 
application disk after loading its 
files-so you never have to worry 
about trashing your only copy of an 
application. If things go wrong, just 
reboot and try again. 

Open Any Resource As If It's 
Another Resource Type 

Press OPI'ION-SHIFI' while opening 
a resource to get a dialog box that 
allows you to open any resource as if 
it was another resource type. You'll 
find this feature useful for examining 
version resources. Open them as STR 
resources to see an English language 
string instead of hex data. The string 
usually contains version numbers, but 
sometimes you might be surprised. 
Just type into the box to add to or 
change the text. 

Full Clipboard Can Cause 
Trouble Cutting Resources 

If you have trouble cutting resources, 
it could be because your Clipboard is 



getting full. Remember, when you cut, 
everything moves to the Clipboard, 
but when you Clear, the data 
disappears. Cuts can be undone, but 
Clears are irreversible. 

Cu$tomizing Scroll Bar 
Patterns 

You can use ~sEdit to customize the 
patterns of your scroll bar. Open your 
System file and open the PAT 
resources. Double click on the light 
gray pattern, and make sure that the 
name of the opened window reads 
"Pattern ID = 17." If it doesn't, close 
the window immediately. You'll now 
be presented with a FatBits · 
environment that can be used to edit 
the file. When you find a pattern you 
like, save the System file, quit, reboot, 
and have a look at those new scroll 
bars. 

Getting the Finder to 
Recognize a Modified Icon 

You probably already know that you 
can use ResEdit to modify an icon. 
But your new icon might not appear 
on the desktop .after you return to the 
Finder. This is because the Finder is 
still working with a copy of the old 
icon in its desktop file. Get your new 
design to the desktop file by either 
removing the desktop file using a disk 

· utility, or by ejecting the disk, 
trashing its icon, and then reinserting 
it while holding down COMMAND-
OPI'ION. . 

RES EDIT 

Keep Work Files At.Disk 
Root Level 

When working with ResEdit on an 
HFS system, keep files you want to 
Open tmder ResEdit at the root level 
on the disk. If you try opening a file in 
a folder, ResEdit might create a new 
resource instead of opening the file 
you want. 

Creating Your Own 
Resources 

Newer versions of ResEdit can create 
resources. Just use the New option 
under the File menu to begin. 

ResEditJComicWorks 

There's a special FKEY in 
Comic Works that copies any part of 
the screen to the Clipboard as a bit­
mapped image. You can paste this 
FKEY into your own System using 
ResEdit. First, open the System on 
the Comic Works master disk and 
open the FKEY resources. Select 
FKEY 6 (Screen Clip) and copy it, 
then close the file, open the System 
file you want to install it on, open 
FKEY, and Paste. 

ResEditJFinder 5.2 

You can disable the message "Are you 
sure you want to remove the 
application X?" from popping up. when 
you throw applications in the 
trashcan. Find and open the LAYO 
resource, open ID = 128, and you'll 
find a number of options, including 
"Skip trash warnings." Select the 
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RES EDIT 

number one radio button and close 
ResEdit, saving the changes. 

ResEditJFullPaint 

Recue the size of FullPaint by using 
ResEdit to clear the two help screens 
(stored as PICT resources). This clips 
14K off the program. 

Screen dumps are created as PICT 
files, but even so, FullPaint can't open 
them directly from the Finder. Use 
this modification to correct the 
problem: 
Open up your System file with 
ResEdit. Within the System file, open 
up FKEY 3. Find the characters 
MPNT on the right side, and change 
them to PANT, then close and save 
the System file. 

ResEditJGraphicWorks 1.1 

You can use ResEdit to edit and 
permanently change any of the 
default patterns in Graphic Works 1.1. 
Enter ResEdit and open a copy of the 
GraphicWorks 1.1 application. You'll 
find a resource of type PAT# (Pattern 
List). Double-click on the PAT# line 
and then double-click on any of the 
four palettes that have appeared. The 
editor you'll see is similar to 
MacPaint's fatBits. The pattern 
currently being edited is shown in the 
bottom center of the window. Click on 
the pattern to its right to make that 
pattem the one being edited. 

ResEdit/LightSpeed C 

The project window in LightSpeed C 
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can only display up to 12 file names at 
once. You might need to enlarge the 
window to view your file names, but 
when you run the program, the 
project window goes back to its 
normal size. 
Use ResEdit to change the location 
and default size of this window. Open 
ResEdit, open LightSpeed C, and 
open the WIND resources. Find the 
resource numbered 129 and open it. 
The boxes with numbers shown are 
ordered by top, left, bottom and right. 
Change the bottom number by adding 
some multiple of 14 (this represents a 
14-pixelline in the project window). 
To add seven new lines, type in 318 
(220 plus 7 times 14). Then quit and 
check out the changes to your copy of 
LightSpeed C. To change the default 
location of the project window, alter 
the number that shows the left bound 
of the window. 

ResEdit/Mac SE 

Use ResEdit to remove some 
unnecessary resources from the 
System 4.1 file on the Mac SE. The 
Pl'CH resources are "patches" to a 
particular machines ROMs. The 
unnecessary Pl'CH resources are 
those numbered 28927,105,117 and 
376, which are patches for other 
computer models such as the Mac 
512K and XL. Also, now that the 
SANE mathematical routine 
functions· are found in the SE's ROM, 
you can remove them from the 
System file as well. The SANE 
resources are PACK 4 and PACK 5. 



ResEdit/miniWriter 

miniWriter d~faults into settings that 
you can change by using the Options 
in the miniWriter menu. But you can 
customize the default settings to your 
own taste. First,. open the miniWriter 
DA from its icon (don't open it from 
wi~n the System tile). Then, copy 
the TMPL resource you'll find there 
and Paste it into the TMPL resources 
of a copy of ResEdit. Next, quit and 
reboot from the modi6.ed Re$Etll.t · 
copy. Then, open the tn WRT resou.r;ce 
in miniWrl.ter, scrolldown to the 
default\options, and.set them _ 
according to your needs. O=off, and· 
l=on. 

ResEdit/Phone Pad 

ResEdit can help if Battery Pak's -
Phone P8.d· desk accessory pages are 
too small for your needs .. Start by 
usjng the Font/DA Mover and save the 
Phone Pad DA into a new file. Then 
enter ResEdit, open the new file, and 
locate and o:Pen the WIND ·resource 
that's shown, then click on 'the Set 
button. Now, .draw a·rectangle large 
enough to accommodate the Phone Pad 
page you wish to create. (Don't draw 
the rectangle too close to the menu 
b~~ though, or you could find problems 
later.) Save the changes to the DA file, . 
quit, then install your altered DA 

ResEdit/Ready, Set, Go! 3 

Sometimes Ready, Set, Go! 3 loses its 
application ic_on, which can re$~lt in a 
"Couldn't find the application" error 
when you try to open a RSG 3 

document. On a backup of th.e 
application: · 

.RESEDIT 

Launch ResEdit and select the. ~~dy, · 
Set, Go! 3 applic_ation. Choose GET 
INFO from the File menu and click on · 
the Bundle box to tum it on. Then 
clos~, the window and. saye t:he. 
changes. (Setting the bundle pit-in an 
application spe,c~e.s ~~t the · . 
application "own~" do,cuments and 
that i~ has its o.wn individual ~c~n.) 
Now, double-click on the ~G)~ 
applicatio~ to open it ancl show its 
resources. Select NEW from the File 
me~u and enter~·. new r~source. tyPe 
ofMRSN (all ~p~). A·b~ ~N:• 
windQ~ ()pens ~me~ately ~Choose· 
NEW again from the File menu. and 
enter the following at the insertion 
point: 
OB 56 65 72 73 69 6F 6E 20.33:2E 30 
Close the window ~dyou'll notice 
how the only listirig in.the'MRSN 
wil;ldow is highlighted. Choose GET 

: INFQ :from the ,File menu.,apd change 
the.ID name to zero. Finally; quit 
ResEdit and save the changes ~ade 
to the.RSG 3 backup. N~w, just re~ot 

1 

the backup .and go! 

Res;Edit/System 

If you aren't sure what version of the 
System file you're using, ~sEdit can 
tell you. Open it and double-click the 
System file, then scroll through the 
window until you find the reso~ce: · 
type STR. Open this and you'll find~a ' 
number of STR resource files. Locate 
the STR withiQ=O and do~l~.,cli~k it 
to open it. You'll see the version 
number .and the.date on which th$t 
System was created. , 
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ROGUE-SHADOWGATE 

~~Rogue 
ResCUing Characters From 
Automatic Deletion. 

ROgue deletes a character from the 
disk each time the character file is 
opened at the ·beginning Of a: game 
session,· making-it· difficult to save 
him-and impossible if he meets an 
untimely end. To avoid this, save your 
character and then eject the disk and 
lock it. Reinsert: the ·disk and play the 
game. Since'thedisk is locked, the· 
·game c~'t erase your character. To 
save his'newest eXploits back to'disk, 
eject the disk· tmd 1mlock it, then 
reinsert it to· save again. 

JS.~on Ill .. 
Setting Bim~caps 

Less experienced players will find the 
game's n()mial settings tOo hard. You 
can maie· the game more enjoyable 
for non-experts by handicapping 
Sargon III. Do this by taking pieces 
away from Sargon's setup before 
starting the game. Handicap by 
pulling down the Options menu and 
choosing CHANGE BOARD. Then, 
drag the pieces you want off the board 

-and click OK to· begin the game. 

~ 

LID S~r,apbook (Desk Aceessory) 

Sera tiook' Limits ··~:· .. ;. ·'': 

Your Scrapbook can contain up to 256 
different entries. 
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Index Large,Scrapbooks · 

If you work with a large Scrapbook, 
reserve the first page or two for an 
index so you can find -specific pictures 
more easily than you would by 
scrolling through them. 

Use Scrapbook To Access 
Often-Us~d Graphics or 
Text · 

If you use a certain illustration (or 
·even a paragraph or so of text) very 
often, save it -into your- Scrapbook so 
it's immediately available whenever 
you need it. 

Shadow gate 

Use ~domizing To Your-­
Advantage 

The sphinx guarding the tower will 
ask you to bring him vanous items 
foqnd throughout the castle. Exactly 
what he asks for is generated 
rando~ly by the game, so save the 

. ,game just before enterllig this room .. 
If he asks for something you don't 
h~ve access to, or ifyo.ujust don't 
understand the meaning of ~he riddle, 
quit the game and reboot. Then try 
your luck again. · 

Note Pad Lets You Track 
Clues o~. the Fly 

Use the· Note Pad DA to copy any 
clues that you want to refer-back to 
later. 



LID Sleep . . . 
:- , . · (Publio:.Doroain Desk Accessory) 

Temporary Deactivation 
Temporarily deactivate Sleep by 
holding down the OPI'ION key. The 
screen will Show in-full view until 
OPI'ION is releaSed. 

mu·sma~C011111 .• 
Forcing SmartCom to Use 
Text Prot9col 

.. · 

Instead of SENDing a file, PASTE it 
&om the Clipboard.· This makes· 
Smartcom use a text protocol, even if 
MacBinary or:Hayes -Verification .. 
protocol-has been selected. 

Capture ROutine Saves Only 
selected Text · 

If you capture data·to disk after 
receiving a transmission, highlight 
the text you want to save. The 
Capture routine saves·only selected 
text, so if you save a file with nothing 
selected, nothing is what you'll end up 
with. (," 

Saving Text From the 
Capture Buff~ 

Ilyou accidentally Close yout 
document without having saved the 
contents of the capture buffer, don't 
pani~yet.. Try reopening a 
communications doeument.lfyou 

.' didn't:use the Clear command from 
the Edit menu to purge the bufFer 
before you closed the transmitted 

SLEEP-SMASH HIT RAQUETBALL 

document, the .-text is still in the 
capture buffer, and it will·appear in 
the document window. This won't 
work if you accidentally Quit 
Smartcom. 

Save and Save As ••• Don't 
Save What's in the Capture 
Buffer · 

The Save and Save As .•. commands 
only save the settings, not the data in 
the capture buffer. 

Put Your Work Flles At Root 
Level 

Some earlier versions of Smartcom 
(2.1a, for example) can't recognize 
documents or applications -that are-in · 
folders on an HFS system. Remember 
to put your work files on the root,_level 
before ·starting, and you shouldn't 
have any problems. Version 2.2b 

. corrects the folder problem. 

Use Different System Flle 
When Using Sidekick 

If you'll be using Smartcom II with ~ 
Sidekick desk accessories, replace the 
System file with a new one. -Hayes 
removed some resources from the 
Smartcom II System, and this can 
cause operating problems with 
SideKick. 

, Sffi&Sh Hit Raquetball 
Fast Shutdown 

Want to shut down quickly from 
within the game? Just press 
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SMASH Hrr ,BAQUETBALL.;..SUPERPAINT 

COMMAND-Q to end the game and 
return to the Finder. 

~Software sl~ple~ · · 
You Can'-t Save MacPaint 
and MacDraw Demos; But ••• 

MacPaint and MacDraw are both 
given to new ~cintosh owners on the 
Software Sampler disk., But in both of; 
these programs, the Print and Save · 
options have been disabled.~If in the 
course of testing the programs, you 
create a graphic you just don't want to 
part with, you.can cut the ;artwork, 
open the-Scrapbook DA, and ·paste the 
graphic:in. Later, when you buy the 
program, you can move it back to .the 
application for further work. And, if 
you u&e a word processor, you-can 
move the Scrapbook file on to the · :. 
word processing disk and paste it into 
your text document. 

mJ Studio ~~s~i~n ·. ; 
... 

Note Entry Shortcut 

Need a sho'ttelitfor entering notes 
into Studio Session? After .putting ani 
note on the staff, hold the mouse · 
button down. ~agging it .left or· right : 
changes the duration, and dragging 
up and down changes accidental. 
After moving one way back and forth, 
you'll have to click again to make a 
different kind of change. 
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Y\. SuperPaint , .. 
Using the Lasso 'While the 
Marqu~e is ~lec~d 

• ,.; ,h ,J•\L · 

While in the Baint, layer, you c~ ))ave 
th'e tn;_arquee tool selected and· still be · 
able to use the W.so- tool. Just hold 
down the OPI'ION key and the ~sor : 
tums into a lasso, making it ea~ to_·_ 
select odd-shapeq bi~maps on th~. ;_- .­
screen. 

Nudging Selected Graphics 
By a Single Pixel 

... ·. 

While any item is selected with either 
·. -the lasso:or with the marquee, your 

can "nudge" it in S:DY .. direction by 
using the arrow.keys~ If you're -using a 
keyboard that has no directional 

· arrow }teys, use __ CO)lMAND-Y ~- · _ 
nudge upwards, COMMAN,D.J ·f".9. -· . 
nudge left, COMMAND-K to nudge 
right, and C0MMAND-D to shift · 
do~wards~~ · 

. ·~.; 

Closing All Open Windows 
atOnce · . · ·· 

.') ~ f. 

Hold down OPI'ION while selecting 
Close from the File menu to close all 
windows th~t ar' curren~ly ppen. . -

Crosshairs Can Help When 
You Paint From Centered 
Point:, · · .. · .. \ ·.'· 

Instead of:ehoosing DRAW (PAINT) 
FROM CENTER before\drawing one 
of.the;QuickDraw primitives to.paint 
the'shape:fro~ a centered point,- .. 
double:.:click on the palette tool you.-



select instead of just clicking. The 
icons in the palette will then show 
crosshairs to identify the difference. 

Reversing the Pattel'D. 

When editing paint patterns or paint 
brush shapes, hold down COMMAND 
while clicking the mouse anywhere in 
the pixel editing box to reverse the 
pattern, making white black, and 
black white. 

Obtaining a "Spattered" 
Effect" 

Obtain an interesting "spattering' 
effect by choosing the paintbrush 
p~~tem that you'd like to spatter. 
Then, chooSe ~e spray can tool and, 
while yo~ paint, hold down OPI'ION. 
The faster you move the mouse, the 
further apart the spattering will 
paint. 

Obtaining a "Screening" 
Effect 

A great "screening" effect can be 
created by using Paint on Black and 
the selection ~gle, especially in 
conjunction with the Laser Grey 
patterns. If you don't like the effect, 
try moving the·marquee one pixel up 
or down. to change most of the screen 
effects. 

Smoothing Bit-Mapped 
lma-~ For Laser Printing 

r,· • :.;, 

If you h~v~ an extensive bit-mapped 
clip-alt library, there's a way to 
smooth images for printing on the 

SUPER PAINT 

LaserWriter. Open your image in 
SuperPaint and Save it. Then Open a 
new document, hit the PLACE 
LASERBITS command, and tell it to 
use the file you just created. The 
result will be a 1/16 origin81 size 
document at 300 DPI, and it prints 
perfectly. Realize that the larger your 
original image, the longer it takes to 
print. 

Turn Smoothing Off to 
S~ed Up Printing 

When printing a LaserBit document, 
tum the smoothing effect oft' to speed 
up printing. 

Adjusting Length On 
Imported MacDraw · , 
Graphics 

SuperPaint's print area is 
approximately 7 11116 inches by 9 5/8 
inches, which is slightly wider but 
shorter than MacDraw. A quick fix is 
to set the Page Setup to enlarge at 
104%. This results in ten-inch lengths 
when you need them. Just remember 
to watch the width of your job, since it 
expands sideways as well, and also 
set the print dialog box to print only 
the first page. This circumvents . 
SuperPaint's need to send a blank 
page through when enlargements are 
requested. 

Lower Detail Level Speeds 
Smoothing 

When using the FatBits mode, don't 
immediately jump to the finest detail 
level. Instead, use the left side of the 
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SUPERPAINT-8WITCHER 

screen (which displays the actual 
appearance of the work) as your 
guide.lfyou can see all oftbe object 
you'll be working on, stay. on that 
magnification level unless you need a 
finer.one. You'll save time smoothing 
work if you work in the lowest 
possible magnification. 

~SwHcher 
Finder is a Good Switcher 
Addition 

Installing the Finder as a Switcher 
application lets you easily shift tiles 
between disks, and you'll be able to 
quickly launch another application 
(that hasn't been loaded into 
Switcher). Once .the Finder is 
installed, you can move into the 
Finder, launch the new application, 
cut or copy what you need, then 
switch back to the application you 
were working on. Switcher's double 

· arrow remains in use even with· your 
non-installed application. You might 
have to reinstall the Finder after 
leaving the non~installed application, 
but it's still faster than quitting and 
reinstalling the entire· Switcher set. 

Load The Finder First 

If you'll be using the Finder under 
SwitCher, always be sure to load the 
Finder before loading any other 
application. · 

E~ress Route to Main 
· SWitcher Window 

When working in an application, you 
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·can take the express route to the 
Switcher window by clicking in the 
center of the arrow in the upper right 
comer of the screen. 

Don't Start Up From 
Installed RAMdisk 

Occasionally you might get the 
message "Sorry, but you don't have 
enough memory to run Switcher. Go 
get a 512KMacintosh," it doesn't 
mean the 512K Mac you're using is 
going on the fritz. There's a good 
possibility that the message came up 
because you tried to run Switcher 
after using a startup disk that 
included an installed RAMdisk. The 
easy remedy for the problem is to 
replace the old System file (not the 
System folder) with a new copy. 

If You Crash or Freeze 

In the event of a crash .or a screen 
freeze, try holding down COMMAND­
SmFT-OPriON-Period. lfyour 
problem is localized in the application 
you were working in, this should 
return you to the Switcher screen. If · 
this works, go to each of the · 
application windows that didn't crash 
and Save, then Quit, immediately. 
Then quit Switcher and restart the 
system. This avoids the damage that 
can result if the crash has damaged 
Switcher's System files. 

Attaching Documents to 
Applications 

An application in a Switcher set can 
Open a document when launched 



froJQ.: ~-saved Switcher set. To attach a 
document, select an application's slot 
in the SWitcher screen and choose: 
Attach Document from the File menu. 
You'll see.abox with a list of all the 

, .. documents that application can open. 
Select the .document you want.and 
click Open. Its name now appears in 
the application's slot in the Switcher 
screen. If the application is active, it 
doesn't open the document you. · ; 
selected, because the document 
currently Open might be destroyed 
before you can save your changes.~ But 
if the application is inactive, the 

. . document will open as soon as you 
launch the application. If you save the 
Switcher set, the document will be · 
attached to. the application every time 
you load·the set until you change.the 
configuration. . 

QUIT Doesn't Reboot 
Computer 

·' 

When the Finder is loaded into 
Switcher 4.8 (or a higher version 
number), the SHUT DOWN command 
in the Special menu changes to QUIT, 
which releases the Finder but does · 
not reboot the computer. 

"Always Convert Clipboard" 
Is Slow 

Choosing" Always. Convert Clipboard" 
slows down the operation of the 
pro~iil. To·convert the Clipbo~rd 
easily and re8$onably quickly, hold 
down OPI'ION while switching 
appli~tions. 

SWITCHER 

ByPassing the Startup· 

If your startup applications set has 
been set. in a file named .. 
"Switcher.Startup," you can.bypass. it 
by holding down OPI'ION while 
launching.Switcher. ; ·:·. ·.· 

Causes For MacDraw Crash · 
MacDraw works well with .the d~fault . ) . "! .· 

128K memory allocation, and i~ works 
with the Same One Twice optio~. ;But · 
if you cre~te a document tha~ ~es 
more than 80% ofMacDraw's. 
avail~ble memory, o~ ifyou Cut:or . 
Paste·to consume more than 80%, the 
·.program will crash. Check the · ·­
amopnt of memory used by looking in ' 
the About MacDraw window under· 
the Apple tn.~~~- ., 

If Mac Write Has Been 
Missing th.e End of a File 
MacWrite might suddenly truncate· 
text files that you try to open if you 

~ have allocated to small a SWitcher · 
parti~on in Mac Write. When· · 
Mac Write runs out of memory, it 
simply stops loading the file, and will 
display only what it can load. ~fyou've 
been having trouble like ·missing lines 
at the end of Mac Write files,· allocate 
MacWrite a larger partition next· 
time. · ~ >--

Give MacWrite Large · 
P~tion If ~er Printing 
If you'll be printing MacWrite·:·, ·. ·~ 
documents with the LaserWriter, give 
this application a_ larger partition 
than the def$ult 128K. 144K or more 
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SWITCHER 

will give you better printing results. 

Double MacWrites or 
MacPaints Can Double Your 
Trouble 

Never open two copies ofMacWrite 
with different documents in each, 

,.under Switcher .. Jt could crash both 
your tiles. That's because MacWrite 
creates temporary work tiles as you 
write, and bOth copies would then be 
creatin~ ~mporary tiles with the 
sam.e·nam.e&-7-0r at least, they'd try. If 
the copy of Mac Write you're currently 
working on gets confused, it_ c~uld 
mangle your document to the point of 
ruin. If your copies of the applications 
are on two different disks or m· two 
different volumes, you might fare 
better. The same applies·for working 
with tw~ c~pies of MacPaint. 

How Much Should You 
Allocate to an Application? 

You can't allocate less than 64K to an 
application, and most applications · 
default at a 128K allocation. Change 
.the~ settings before launching an 
application by choosing Configure, 
then Install from the Switcher menu. 
Then input the settings you prefer 
into the dialog box. Switcher always 
attempts to allocate an application's 
Preferred Memory Size. If it doesn't 
have eno~h space to 4o so, it 
allocates the Minimum Memory Size. 
(Many applications include a size 
resource that relay both oft1i«!se sizes 
to Switcher.) If there's not enough 
memory· to :allocate Minimum size, 

·you'll get an error message. 
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Saving Memory Settings 

The memory allocation dialog box has 
two buttons in the lower left comer, 
Permarient and Temporary. If you . 
click·on Permanent after changing the 1 

memory settings, ·Switcher 
remembers the settings in future uses 
of the applicationi Click on· the· 
'l'emporary button to make the 
settings. apply only to the current 
session. 

Ideal Memory Allocations 

Jazz requires 304K allocated to work . 
·.properly. 

· MacPaint should be allocated l79K. 
And,make sure Switcher saves 
MacPaint's screen to avoid•problems. 

Allocate 310K to Helix if you use·it 
under Switcher. 

With Microsoft Chart, allocate 192K. 

With Excel, allocate 304-512K. 

. J With File, allocate 288K. 

Multiplan works best with 160K 
allocated. 

Allocate 160K for Word. 

If you're working with Finder 6.2 or 
,. higher, allocate at least 192K. 

J.• • 

Running Word With Finder 
Can Damage· Files 

Avoid damaged Word tiles by making 



sure not to run Word· and the Finder 
simultaneously in a Switcher set. You 
might find Word's temporary files 
damaged by the Finder. . · 

Switcher And Scientific 
Writing 

To incorporate Switcher's best 
attributes into·· scientific writing (such 
as:·pteparing:drawn-figures), install·.a 

7 language like BASIC or FORTRAN as 
one applicationrwith Cricket Graph 
as the other;~ The output ofthe 
computer· program can. be stored· in 
the Clipboard, switched to Cricket 
Graph, and then charted easily. Use 
the resulting graph (modified in 
MacPaint or MacDraw, if you like) in 
your word proCessing document. 

Design Custom Symbols As 
You Work 

If you need special fonts while 
working, run Altsys' Fontastic font 
editor in Switcher with a· word 
processing program for the capability 
to design custom symbols as you go. 
Put custom. characters into unused· 
Shift and/or Option key font slots.-. 
These custom symbols can be 
incorporated as a custom font which 
you can install to be standard in your 
word processor's Font menu. 

Quit All Applications Before 
Quitting Switcher· · 

Remember to Quit all,applications 
before•Qtiitting Switcher. If you're · 
usmg the Finder, quit by switching to 
it and double-clicking· the Switcher 

SWITCHER-TELECOMMUNICATIONS 

icon. (this:removes the ;Finder and 
returns you to the Switcher screen). 
You can· quit Switcher with only .one 
application installed. In this ·case, the 
Switcher screen disappears ancL the 
remaining application stays on the 
screen. But that applica..tion will still 
only be able.to use the:me:mory · 
allocated in Switcher. To utilize your 

1 

Mac's full RAM capacity, quit the 
Switcher set and then start the 
application from the Finder. 

Last Application Installed 
Remains Active When ·You 
.Quit . 

When .you end a Switcher work · 
session, the last application that lVa& 

installed remains active. If you Quit 
Switcher without Quitting the . :. 
application, it will return to the 
screen with whatever w~rk you had in 
pro~ss after Switcher :.\las 
deactivated · 

Telecommunications 
Beginners Should Get '· 
Cheap Practice 7 ' • 

•' 'li, 

If you're new to telecommunications, 
or are just getting to kno~ a new 
telecom program, you don't have to 
pay expensive connect charges while 
you leam how to upload and : 
download on networks. Contact your 
local Macintosh users' group or an . 
experienced friend and get the phone 
number of a free local bulletin board. . 
Practice uploading and downloading 
on the free network. 
Once you know your way around the , 
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local network; look for shareware and · 
public domain libraries; where.you 
might be able to download·programs 
for far less than you~d be charged by a 
natidnal network.. ~ 

When Call-Waiting 
Disconnects Transmissions 

··/ 'i J. .. l. 

If you have call waiting and a modem, · 
you can run into a lot of interrupted 
telecommunication sessions. A little­
known trick is to add "*7C1' on touch 
tone.phones~ or to dialll70 on pulse 
phones, just before the number to be 
dialed in your modem dial command. 
This disables call waiting. This tip 
doesn't work in all areas of the . I 
country. Ask your phone: company. 
Sometimes they can put it in on 
request. 

Telephone Noise Can 
Interrupt Transmissions 

l.i· 

If you experience continued failures 
midway thro~h trans~ssion while 
using a protocol transulission, you're 
problem. could be telephone noise. Try 
getting a cleaner connection by 
hanging up and dialing again. 

J -~ •• I I .. ; 

Cutting Noise On , 
CQmpuServe 

On ConipuServe, as on any· other 
network, liD.e noise can ruin an·_· 
upload or download. To cut out the 

· noise,-make. the first character in each 
"typing" command in your·macro the 
control character that says to the ·· -
network, "lgnore:what rve ·typed so 
far.JJ This cuts down on problems , 
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associated with your prom-am's 
reading ,noise ,input :as your typing. 
When you're on CompuServe, type 
CONTROL-U. This tells the service to 
ignore noise. 

Disabling Internal Modem 
Speaker 

The internal modem-speaker of a· .• 
·.Hayes or Hayes-compatible moQm 
·.can be temporarily disabled. Just type 
A'fMO from·your.terminal program 
and press Return. The command ·will 
be acknowledged by an "OK." Tum 
the volume back on by tYPing ATMl 
and pressing Return. 

Getting Your Program to. 
Wait Longer·Before 
Be dialing 

Many terminal programs allow users 
to change the amount of time that the 
modem waits for a carrier before 
redialing when in auto-re«Ual mode. 
The eo:mmand ATS7 = x sets the 
number of seconds the program waits, 
with x·.= the default number of 
seconds. Default value is .usually 20 
seconds, buy you can change it to 
almost any number less than 255 by 
changing the default value. 

~Tempo 
··Get .Tempo ,To J!astall Itself 
on Startup ·.- · ··~· . · _ 

Tempo's ,ability to run a macro upon 
startup can be used to·make-it install . 
itself .in the menu bar (by selecting 
Tempo from~the Apple menu). · 



Don't· Duplicate Application 
Command Key . 
Combinations 

While creating macros within an 
application, don't assign command 
key conibinations that are already . 
being used by the applications. 
Combinations like COMMAND~V, X, 
and C are obvious no-no's ... but check 
your application's command keys 
before entering any new 

· combinations. 

Use Command Key 
Combinations When 
Possible 

You can get more speed in your 
macros by ·minimizing the use of th~ 
mouse to select menu commands. Use 
command key combinations whenever 
it's practical. 

Tem~ Can Tell You It's 
Finished 

Tempo can be p~med to beep 
after it's finished running a macro. To 
do this, the application that the ·macro 
is running should have a Save As ... 
command under its File menu. The · 
current file should have been saved to 
disk at least once. When the main part 

. of the macro has been programmed, 
select the REAL -TIME recording~ 
choose SAVE AS ... , and press Return. 
After the beep sounds, just select . 
CANCEL. Then, stop recording. If you 
make this into a $eparate macro, it c8n · 
be branched to from any other macro, 
so the Mac can always beep to let you 
know it's finished running the macro. 

TEMPO-THINKTANK 

Don't Hold COMMAND Too 
Long 

When holding down COMMAND to 
invoke a macro, don't hold the key 
dolv.ntoolong.Othe~se,you1lfind 
upper case letters displayed in lower 
case. Use OPI'ION instead of 
COMMAND when creating macros to 
avoid this problem completely. 

Incompatibility With 512K 
Mac and Hard Disk on 
AppleTalk 

If you're using a 512K Mae with a 
hard disk and AppleTalk, you might 
experience problems with Tempo. 
(Thesa~e combination with a Mac 
Plus works perfectly well.) Disco~nect · 
AppleTalk or the hard disk, or else 
use the combination with a Mac Plus. 

~ThinkTank 
Organizing~ Scrapbooks 
With ThinkTank 

If you work .with a number of different 
Scrapbooks, organize. and archive 
them with ThinkTank. You can Paste 
the Scrapbook into the program with 
a single command. Then, return to 
the Finder to activate different 
Scrapbook files (changing their names 
to make them the default ·Scrapbook) 
and then load them all into 
ThinkTank graphic windows.: With 
this method, you can rearrange pages 
and put them all back into the 
Scrapbook with a single command, 
either as replacements. or additions to 
the existing Scrapbook files. 
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Don't Use RAM Caching 

ThinkTank uses memory differently 
than most applications do, and it can 
have problems with caching. 
Therefore, don't use this program 
with disk cache programs. 

• 
Through the Looking 
Glass 

The Cheshire Cat Holds 
Many Secrets 

This program has a lot of interesting, 
undocumented features. For example, 
click on the Cheshire Cat's left eye 
and the opposing pieces will change at 
random. 

Click on the eat's mouth and the 
playing field turns upside down. 

Click on the eat's nose to reverse all of 
your mouse movements on the screen. 

Click on the eat's right eye and the 
black hole on the playing board 
multiplies until the entire board has 
been eaten away. -r VideoWorks 
Each Animated Sprite 
Consumes Memory 

Each animated sprite takes up 
memory space and slows down the 
program. When choosing how many 
objects you'll animate during each 
sequence, keep it simple for the best 
results. 
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Creating Self-Running 
Animations 

Make a self-running animation from 
your Video Works files. Just put your 
animation files on a disk with the 
Video Works player and set the Player 
to run as soon as the disk is inserted. 
Copy the System folder and the 
Video Works player from the 
MacroMind Utilities Disk to your 
blank, then copy the Demo List 
document from Video Works, and 
finally, transfer your animation files 
over. Select the Video Works Player 
icon on the new disk and choose Set 
Startup from the Special menu. Now, 
when the disk is inserted, it 
immediately launches into your 
animation. 

&Wizardry 

Avoiding Your Mistakes 
Being Written to Disk 

You just can't get a break in 
Wizardry. Unlike other role playing 
games, it writes all your stupid 
mistakes to disk. When you're about 
to enter a situation that experience 
has told you is dangerous, pop the 
disk using the CO:MMAND-SHIFT-1 
or CO:MMAND-SHIFI'-2 keys, then 
enter the area. When the dust from 
the battle clears, the program will ask 
.for the disk to be reinserted. If none of 
your important characters has died, 
go ahead. If the battle wasn't so lucky, 
tum the computer off and reboot. 



Werdna's· Buddies Are 
Randomly Generated 

The final battle with the evil wizard 
Werdna is harder some times than it 
is others, since the game randomly 
generates the number of monsters· · 
keeping him company. Before 
entering his chamber, pop the disky or · 
lock it. If'he's accompanied by.only} 
two monsters, it's probably the best 
time to fight. · 

Exit-Stage Right · 

To ·quickly exit the maze from Level 
10, walk into the little alcove right 
next to the entry point. 

Dishonesty Pays (Well) = 

If you want unlimited·gold so badly 
you're willing to ·cheat for it,. use the 
Swag bag to duplicate potions :and 
other· expensive treasures. When your 
roster has an item in the bag, you can 
switch rosters and the potion will still 
be there (this lets you duplicate a 
Wand of Conflagration· so that·every 
party member has one). Just back up 
the roster, Give the item to the bag, 
and then Restore the roster. Keep the 
duplicated item or sell it. 

Protecting Sensitive Work 
Sessions From Prying Eyes 

Ifyou're working on a sensitive . 
document, ·here's a quick way to'keep 
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it safe from prying eyes while you're 
working on it. First, open a '-.new· .. 
document. Using its size box, make 
this document as small :as you can 
and then move it to the bottom of 
the page with only its title bar 
showing. Then, open your private. 
document. If anyone walks over·to 
the machine to see what y~u're 
working on just double-click the new 
document~s ·title bar. and it instantly 
expands to cover your ~sensitive . 
document. 

Don't Delete Documents 
Until You Quit Switcher 

If you· use Word and, the Finder in· 
Switcher, be sure not to delete any 
Word documents that you're working 
on in that particular section: Instead, · 
wait until you have Quit Switcher and 
are in the.' Finder to delete. 

Easy MacWrite·to•Word ,, 
Conversions 

There's an easy way to convert '" 
.MacWrite files into Word. First, open 

· a Word file, then close it. Then choose 
Open from the File menu to call up 
the Minifinder~; You'll notice. that all 
Word and all Mac Write documents 
resident on the disk ate now listed. · 
Open any Mac Write file and you'll get 
a dialog saying the file is being 
converted. Click OK and you'll be 
able to open a converted file that 
preserves all your 
formatting:-including fQnt siz~s, 
boldface, and margins. The only 
thing missing is the paging . 
information. 
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Removing.the Last Word 
Typed . 

To remove the last word you typed, 
hold down OPI'ION aild then press 
Backspace~ This feature stops at 
punctuation and other special 
characters, so to delete a word like 
"Done?" you have to press OPI'ION­
Backspace twice-once for the 
question mark, and once for the word 
itself. This also removes the space in 
front of the word, like a cut or a 
SHIFI'-Backspace does. But this 
removal is permanent; the word is not 
copied to the Clipboard. 

E~ress Route to. the Right 
Edge of a Page 

Word version l.OX gives you the 
ability to create a document with the 
right margin at 19 1/2 inches. If you 
find using the horizontal scroll bar to 
see information not displayed in the 
window tedious, there's a way to get 
to the right edge fast: First, set up the 
margin where you want, then create 
one "word" by typing in a long string 
of letters. End the string with Return 
just before the right margin. lf you're 
using a numeric keypad and want to 
jump to the right, press 6. If you're 
using the keyboard, use COMMAND­
OPI'ION-semicolon instead. This is 
the command to move to the riglit of 
the current word. 

Viewing Several Points In 
Very Wide Documents 

To be able to view several specific 
points in a very wide document, use 
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the same tip as above, but separate the 
"word" string into severalpl¢.8~ . :Be 
sure to delete these nonsense characters 
when you're finished working. 

.. 

Copying Paragraph 
Formats 

lf you want to copy one paragraph's 
format to another, choose SHOW 4JI 
from the Edit menu. Then choose the 
break symbol {4fi) from the end of the 
paragraph containing the fo~at you 
want copied, then COPY it. Finally, 
select the 4fi from the end of the 
paragraph you want to modify and 
PASTE the first 4f[ into its place. (If 
you CUT the ,, a paragraph 
automatically picks up the format of 
the paragraph directly beneath it. 

Another way to change a block of text 
to the·style of another block is to 
highlight the text you want to change, 
then hold down COMMAND-OPI'ION 
while clicking on the text that has the 
style attributes you-want to change 
to. The original block will change to 
reflect the second block~s format. 

Quick Copy-And-Paste 

Copy and Paste in a single motion by 
clicking the place where you want the 
text pasted while pressing OPI'ION. 
To Cut selected text ins~ad, p_ress 
OPI'ION-SmFI' while clicking on the 
insertion point. 

Copying Graphics to 
CheapPaint Easel 

. If you use Hayden's CheapPaint DA 



with Word, graphics already in the 
Word document can't be cut and 
pasted into a CheapPaint easel. Get 
around this by copying the graphic . 
and pasting into an easel. 

Recovering Corrupted Files 

Sometimes you can recover a 
seemingly-lost file after a system 
crash. First, reboot the Word disk or 
boot from another·disk· and'insert 
Word in the second drive. On the 
desktop, you should see a file named 
MWOOOO or a similar name that 
begins with the letters MW. Using 
any utility that allows you to modify a 
file's Type attribute (like MacTools or 
ResEdit), change·· the file's Type froin 
WTMP to WDBM. Then change the 
name of the file, removing the MW. 
Hopefully, Word can now,read the 
file. 

Put Main Document and 
Merge Data File In Same 
Folder 

If you'll be using the Print Merge 
function on an HFS disk ·or volume, it 
might not work properly unless the 
main document and the merge data 
file are in the same folder. 

: Accessing Bidden Message 

There's a hidden message embedded 
·in the program. Open About 
Microsoft Word from under the Apple 
menu and press COMMAND-SHIFr 
to see it. 
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COMMAND-Period Comes, 
.In Handy 

A number of commands can be 
aborted by pressing_ COMMAND­
period. This stops printing, Find, 
Change, and Repagination. 

Selecting Characters Via 
the Keypad 

Word 1.05 contains the hidden ability 
to select characters with the keypad. 
On the keypad, hitting* selects the 
character to the· right of your insertion · 
point. (If text has already been 
selected; the selection will instead be 
extended one character to the right.) 
Press the+ key to select the character 
to the left of the insertion point. To 
quickly extend the selection, just hold 
down either of these keys.:. 

Selecting By.Word 

If you double~click on a word and then 
drag the mouse, the highlighting . 
moves backward or forward one word 
at a time, instead of character by 
character. 

Selecting By Sentence 

Press COMMAND while double­
clicking to select the entire·sentence 
so that, while keeping the mouse 
button pressed, you can select text a 
full sentence at a time. 

Superscript and Subscript 
Fonts Are Smaller 

When you choose a Superscript or 

127 



WORD-WORD 3.0 

Subscript font style from 'the Style 
menu, you'll get a smaller font, which 
will then be adapted to the style. But 
if you choose Superscript or Subscript 
from Format under the Character 
menu instead, it will not 
automatically show up in a smaller 
font. 

' Di~og Box Command Keys 

Word allows users to substitute 
command ·key combinations for 

. mousing in all dialog boxes. Any 
dialog box can be canceled by using· 
COMMAND-W·or COMMAND-period. 

., ... 

In the Save As ... dialog-box: 
COMMAND-1 or COMMAND-S saves 

: the file; .. , · 
COMMAND-2-or COMMAND-E ejects 
the disk; 
COMMAND-3 or,COMMAND-C 
cancels; 
COMMAND-4 or COMMAND-D 
switches drives. 

I. 

In the Open ... dialog box: 
COMMAND-1 or COMMAND-O 
opens the file; 
COMMAND-2 or COMMAND-E ejects 
the disk; 
COMMAND-3 or COMMAND-C 
cancels the box; 
COMMAND-4 or COMMAND-D 
switches drives. 

In the OK or Cancel dialog box: 
COMMAND-1 or COMMAND-O 
presses the OK button; 
COMMAND-2 or COMMAND-C 
cancels the box. 

128 

In the Change ... dialog box: 
COMMAND-1 or COMMAND-F finds 
next; . 
COMMAND-2 selects Change, Then 
Find; 
COMMAND-3 selects Change; 
COMMAND-4 or COMMAND-C 
selects Change All. 

~Word3.0 
Use Highest Quality When 
Image Writing Tiny Fonts 

When printing on the Image Writer, 
choose the highest quality printout for: 
5, 6 ·and 7 point·fonts. -The Mac will 
scale existing 10, 12 and 14 point 

. fonts to half-size for the printing, so 
all three of these sizes should be in 
your System file if. you'll be printing a 
lot of small fonts. 

Closing the Space Between 
Boldfaced Headline Words 

~· . 
Are _you getting too rq.uch space ·, 
between boldfaced headline words? 
Try choosing the space between the 
words and select Plain. Text. This 
draws each word closer together., 

ImageWriting·in 
Bidirecti.onal·Mode 

Although Word 3.0 won't allow the 
Image Writer to print in bidirectional 
mode with the standard Caps Lock, 
Shift and Option keypress 
combination while cli~g OK, it can 

· . ~till be done: Begin by holding down 
the Shift and Option keys before 
pulling down the File menu .to choose ~ 



PRINT~. Then, hold down the CAPS 
LOCK-SHIFr-OPI'ION and click OK. 
Nothing will print this time, but the 
next time you choose print, just click 
OK and your document will print 
bidirectionally. 

Image Writer Driver 2.5 Has 
Trouble Producing Draft 
Copy 

When used with the Image Writer 
Driver version 2.5 (it comes with the 
Mae SE), Word 3.0 won't produce 
draft print. Get a copy of the 
Image Writer Driver version 2.3, 
provided with Word 3.0, to get draft 
quality prmting. 

If you can't find Driver 2.3 and want 
to print draft quality now, put the 
Serial Printer Driver and Typewriter 
Driver into your System folder. Then, 
click the Chooser DA, click on the 
SerialPrinter icon, and select 
TypeWriter. This is a quick fix that 
should allow you to get fast Draft 
qwility·with the old Image Writer 
Driver. 

Sca1ing Graphics Down 

You can scale a graphic in this 
program by pressing COMMAND­
SHIFT-Y and choosing a number 
(from 0-9) to scale the graphic down 
according to its corresponding 
number. The best way to leam to use 
this trick is to experiment with it to 
get the feel of how it scales. 
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Placing Graphics Under · 
Text/Filling a Page With a 
Graphic 

Word 3.0has an undocumented 
ability to place a graphic underneath 
next, or even to have a graphic that 
fills the entire page. :First, place the 
graphic in your Scrapbook. Then, 
begin by typing the text you want and 
open the header, then click in the 
zoom box so that the header window 
fills the whole screen. Hit Return a 
few times to position the graphic 
down from the top of the page. Next, 
copy the graphic from the Scrapbook 
and paste it in the header window, 
positioning it as if it would be the only 
item on the page. Then close your 
Header, saving the changes. 
You'll need to change the top margin 
to get to the top of the header. To do 
this, select PAGE SETUP and change 
the top margin to a negative value, 
i.e., -3 inches. Align the graphic. 
exactly usi!lg PAGE PREVIEW, 
which will show the graphic block on 
top of the text, although it will look 
different when you print. The closer 
your margin is to zero, the higher 
your text will print on the.page. 

Converting Formatted 
MacWrite Documents 

There's an easy way to convert 
formatted Mac Write documents into 
Word. First, open a new Word 
document, then close it immediately. 
Choose Open from the File menu, 
insert the disk containing the 
MacWrite document, and then select 
it from the minifinder. This 
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automatically converts the file into a 
Word-readable document 

Returning the Insertion 
Point to Most Recent 
Location 

There~s a fast way to return the 
insertion. point. to its most recent 
location. For·exam.ple, if you notice 
an error several words back while 
typing, correct the error and then 
type COMMAND-OPI'ION-Z. ·The 
cursor will return to where you were 
typing~ This command works for the 
three most recent insertion point 
locations. · · 

Marking Draft,.Copi~s as 
Draft Copies 

When printing on'a LaserWriter, you 
. ·can·.make sure that draft copies will 
never be· -misinterpreted as. completed 
projects~ First, open header; Then, 
type in this .text, exactly as it appears: 
·.;page.~ 
!l'imes-Bold findfont 100 scalefont 
setfont, 
wp$x 2.8 div wp$y 3.5· div translate4f[ 
0 setlinewidth 4f[ · 
52.3 rotate 0 0 moveto (D R A F T) 
true charpath4f[ . 
gsave .95 setgray fill grestore stroke4JI 
Now, select the text you just typed in 
and press COMMAND-SHIFT-S to 
get into the style definition mode. 
Then type POSTSCRIPI' (it will 
appear in the lower left comer) and 
press Return. Close and save your 
header. This makes the word DRAFT 
· apPear·in large, outlined letters 
across every page. 
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Quickly Extending CUrrent 
Selection 

To quickly extend the current 
selection, type COMMAND-OPI'ION­
H and you'll see the words EXTEND 
TO in the page number box. To 
advance to a specific character, just 
type the character, and the selection 
will extend to the next occurrence of 
tl)at character. This command 
differentiates between upper and 
lower case letters. To extend the 
selection to the end of a paragraph, 
press· Return. This technique also 
works for tabs and new line marks 
(SHIFT-RETURN). 
You can continue to extend any . 
.selection as long as··EXTEND.TO 
shows in the page number box. To 
deselect EXTEND TO, type 
COMMAND-period, or choose another 
command, or scroll with the mouse. 

Problems With RAM Caching 

RAM caching with Word 3.0 can cauSe 
a number of printing problems, so try 
not to use it with this version. To 
enhance your printing speed.using 
RAM, tum on both the Program and 
File check boxes in the Preferences 
dialog box (it's fotind under the Edit 
menu). This loads the entire .Word 
application and the current document 
into memory to allow for faster 
printing and operations. 

Exportin~ To Applications 
That Don t Accept 
Formatted Word Documents 

Many page layout applications will 



not accept formatted Word 3.0 
_ documents directly. Work around 
... this, by saving Word· 3.0 files ilrWord . 

l.X or Mac Write formats (using File 
Types in the Save As dialog box), and 
the page layout program Will probably 

·accept either one. For this to work 
correetly. you'll have to stick to Word · 
l.X formats.··· · · · 

For Word 3.0 formats that can't be· 
transferred into Word l~X or · :~ 
MaeWrite documents, select the text 

. and·copy:it··te the Clipboard as a: 
'QuickDr&w graphic by'typing ·-: 
COMMAND-OPI'ION-D. This 
fOnD&tted graphic will be usable in 
tbost page layout p~gralms. 

-J •. r ' ; ::; ' ~ .: . ,: 

Tiling the Active Window 
' ' _, ;7 :J , ~ ~-I~: ~ ., ' ~ • , 0 ~/ ~ 

· When you're working simultaneously 
on a number of documents, use · · · 
OPI'ION-COMMAND-[ Oeft:bracket) 
to· cppckly tile-the aCtive -window. ·The 
.first. two windows wiU each tile half 
'tb:e ·screen vertica11y,· the next-four. 
will tile a quarter of the icreen 
vertically, and the rest will tile from 
the center ofthe screen.· -
·Bypaaidng the·Mouse With a 
N~erlc· KeJboard · 

You: doD't•haw to reach for your 
mouse ifyouhave a numeric keypad. 
Type a period on the keypad to 
· activ·~-~e menu J-.r. Then, you can 
choose.' tile: desired menu by either 
typing a~l~tter, Choosing a number,! or 
using .the arrow keys. Type a l~tter to 
pull down the first menu from the left 

: that;begins witlithit letter (like F for 
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File). ·Or type a number· to pull down ! 
the menu that falls in that. position· (0 . 
for the Apple menu, 1 for ·File, etc~). : 
Once the menu has been chosen, 
select an item by using the up and 
down arrows to move vertically within 
that menu, or type in ·a letter .to- -.. ! 
choose the item that begin·s with ·that 
letter .. If more than one item begins 
with a specific letter, type the letter 
again to move to the next item with , 
that initial. Once the menu item is · 
highlighted, press Return or Enter to 
execute the command. Cancel the 
menu selection by pressing Backspace 
or CO:MMAND-period. ~' ' · 

On theSE ••• 

When using Word 3.0 on the Mac SE, 
once the criteria for your Find 
command. has been ·established, you : 
can close the ·Find dialog and use the 
:::'(eqwd);key ·on the -numeric keypad t 

to ·search ·for the next occurrence;of ; 
the-word. 

Getting an Estimated= Word 
Count · · · · 

· Word 3.0 can't do automatic word 
counts. But there's a way to get an 
estimated word count. Just make 
sure to save the document before 
doing this, because it alters the tile. 
First, bring up the CHANGE dialog 
from under the Search menu and 
Change All occurrences of white · 
spaees to. end-of-line marks. When 
that's done, select SECTION from the 
Format menu, click on the Line · 
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Numbering .check box and the 
Continuous button, then click OK. . 
Then, select PAGE PREVIEW from 
the File menu, drag the scroll box to 
the bottom of the scroll bar, and use 
. the magnifying glass to view the 
number just before the last word 
listed. This number is the 

.. approximate word count for the text 
contained in the main document. 

Creating a Table 

To create a table is easy. First; 
figure out where you want the table 
to fall on the page and insert a blank 
line (hit Return) in that spot. Then 
select the line and choose . 
PARAGRAPH from the Formats 
menu. The:Paragraph dialo.g 
appears with a ruler. Here, choose a 
Border with BOX· and SINGLE 
options and acljust the size .of the 
table using the margin markers on 
the ruler. Then, place the vertical 
line markers in the ruler precisely 
where you want vertical bars to 
appear in your table, and place tab 
markers after the v:erticalline 
markers. You can use any type of 
tab, but make sure no tab markers 
are placed;on top of any vertical line 
marking. ·Now, .click OK and the 
skeleton of your table appears. 
Enter the data, using the tab key to 
place information in each column. 
You can spice.up the table by 
choosing any line and changing 
border thicknesses to emphasize 
entries. You can also press SHIFT­
Return to produce a: double-spaced 
entry line. 
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[]~Works 
Moving a Selected Range of 
Cells in the Spreadsheet · 

While in the spreadsheet, you can : 
quickly move a selected range of cells · 
by holding down COMMAND­
OPI'ION while clicking in.an empty 
cell. The cell that you click in will 
become the upper left cell of the 
moved range. 

.. ::. 

Using a)Wqrd Processor to 
Change Fe>nts in a Block of 
Cells 

Although the spreadsheet has no font 
changing capabilities, you can move a 
block of cells trom a. spre«ldsh~et :to· a 
word processing document via.the 
Clipboard, and then change the font, 
sizes or styles in the new word 
processing document. The only 
problem with this is that you lose the 
display grid, ifyou,had one. Works' 
drawing functions allow you to easily 
reintroduce one·. 

Sorting Colnmns 

The program's sp~sheet can sort 
rows, but there is n·o direct way to 
sort col111Diis. A column sort can be 
performed by. first selecting and 

· copying the range of columns you 
want to sort. Then. paste this 
selection ~to a new spreadsheet, · 
using PASTE WITH QJrl'~ONS 
instead of the.~¢andard Paste. Choose 
BOTH FORMULAS AND VALUES 
and TRANSPOSE ~d click OK. 
Then reselect tl?.e.,-ange (it's .now in a 



row) and use the Sort.command from 
' the. Edit: menu. -Once the sort is 

completed, cut the .data and then , · 
paste it back·into the original range, 
using the PASTE WITH OPI'IONS 
command and with BOTH 
FORMULAS AND VALUES and 
TRANSPOSE options selected. , i 

Avoiding Swaps With 400K 
Version -_ 

If you're using th_e 400K version of 
Works, you,will notice that you have 
to· do a·lot of swaps between your data 
disk and the-program disk while 
loading a data file. An easy cure is to 
create a RA.Mdisk for the Finder, 
Image Writer, and a stripped-down 
System file (with one DA and few 
fonts). Load this RA.Mdisk_-and .p1:ace 
your program cijsk in one driye and 
your data disk in the other.,; and you 
won't have to swap disks. Keep the 
RAMdisk under 180K for greater 
memory availability. 

, .... 
; MicrosCrolling 

~en· horizpntally scrolling,·your 
view usually shifts a tixedJength. 

·:Scrolling in .. the word processor 
·happens one inch at a time, while 
scrolling in the data base or 
spreadsheet moves you one column. 
Hold down SHIFI' while scrolling to 
microscroll, allowing you to position 
all or parts .of a window more exactly. 

Hanging Up Fast in 
ComDtu:Dlcatioaa.Mode 

While in the communications mode, 
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you can quickly hang up the phone or 
modemJ>y typing CO~-
=( equal). 

Pasting In Data Without­
Field Names 

If you have cut or copied.information 
from the data base, hold down 
OPI'ION while pasting it into a word · 
processor to avoid pasting in tile field 
names along with the data. 

Saving Files With Return At 
End of Each Line 

Hold down OPl'ION while saving a 
word processing file as text (Export 
File) to save the file with Return 
characters at the end of each line. 
This will come in handy for · 
transmitting the text files. 

Bringing the Bottommost 
Window to the Front 

When working with multiple 
··documents, type COMMAND-comma 
to bring the bottommost_ windc;nv .-to 
the front. Use this to quickly switch 
between different dQCUments you're 
currently working on. 

Entering Page Breaks From' 
the Keyboard 

Enter a page break withc,ut having to 
go to the Format men.u by hitting 
SHIFI'-ENTER whileyo~'re typing. 
The page. break will .be entered. at that 
point. 
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Quickly Accessing Graph 
Specifications Di&log 

Double-click in a chart window to 
quickly bring up the graph 
specifications dialog box that allows 
you to change the graph. 

~Writ~ Now 
Automatic ScrolliD.g Gets 
Faster As Cursor Gets 
Lower 

Automatic scrolling is proportionately 
faster as you move the pointer further 
away from the text. When you drag 
beyond the bottom of the window, 
scrolling is faster when you mov'e the 
pointer outside the window~ than it is 
if you ·move only to the horizontal 
scroll·bar. 

Finding-A Page In Long 
Documents 

To move quickly through long 
documents to a given page, drag the 
vertical scroll box until the page · · 
number you want is displayed at the 
bottom ·of the document window. 

ChanJin,l Font or ·Style ·of 
Identical Characters 

· Holding SHIFT while making a font 
or style change affects only those 
characters with the identical 
characteristics as the first character 
in the se1ected area. For example, to 
italicize only headlines that are·· -
currently in boldface, select all text 
from the first bold headline to the 

end, then hold down Sm:Ff and, ·. 
select italic from the Style menu. All ; 
bold text becomes bold and italic~ . The: 
selection criteria. are independent ·of 
each other, so a selective size change 
will affect all those characters of the 
same size, regardless of style'.or 
typeface. 

A:p~nding the Main 
Dictionary 

All words currently selected in a 
document will be appended to the 
program's main dictionary when the 
Learn button is pressed. · . 

Those same words will be deleted., 
when the Forget-button is pressed. 

Kee~ Check-Spelling · 
Winilow Active to·Save 
Access:Time 

The dictionary remains in memory,·as 
long as the Check Spelling window is 
on the desktop. If you use the 
dictionary from another disk· because 
of space limitations on your startup 
disk apd you're checking spelling 
intermittently or over several 
documents, keep the Check Spelling 
window on the desktop at all ~es to 
avoid time spent accessing the · . 
dictionary disk. : ,·. . 

Using the Saine Format in 
Header, Footer, or Footnote 
Area 

To use the"&ame format in:. the 
Header, Footer or Footnote area as in 
the rest of your document, use Copy 



Ruler from the Edit menu to copy the 
format before going into 
Header/Footer or Footnote view. . 
Then Paste Ruler in the 
Header/Footer or Footnote view to 
apply the format there. 

Checking Header and 
Footer Marker Locations~-

If you want to check the locations of 
all the header and footer markers in 
the document, click at the beginning 
of the document and then choose View 
Headers/Footers, View Page and Go 
To Selection from the·View menu. 
Each of these selections has a 
keyboard equivalent. 

The same procedure applies to 
footnotes: simply substitute View 
Footnotes for View Headers in the 
procedure described above. 

Set Image Writer Pages as 
Tall Adjusted 

When printing on an Image Writer, . 
set up your pages to be Tall Adjusted. 
Line breaks will be the same as when 
you print on a LaserWriter, more text. 
will fit on the screen horizontally, and 
you'll be able to do Better (medium) 
quality printing in the background. 

Workaround to Print High 
Quality From 128K Mac 

You'll have trouble printing in High 
Quality mode on the original 
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Image Writer if you use a 128K Mac. 
That's due tO the· printer driver on the 
WriteNow disk requiring too much 
memory. ·The solution is to create a 
new disk containing Finder 1.1 and 
the original Image Writer driver on it 
(it's the one with the Mae icon, f.ound 
on the Macintosh Guided Tour disk 
that came with your Mae) .. Now, just 
place the WriteNow application on 
the new disk and reboot with.the 
fmished disk, and you can print in 
High Quality to your heart's content. 

Workitlg With Double-Sized 
Font On-Screen 

Page and ruler reduction lets you 
work on-screen with a much larger 
font than you might want to print 
with. For ~xample, if you want·your 
printed output in 6-point font, and 
you want to work on-screen with-12-
point characters, set the page and 
ruler reduction tO 50% and your 12-
point characters Win print as 6-point 
text. · 

Using th~ Ruler to Change 
Selected ParagraphS 

A ruler change usually affects all 
selected paragraphs. But if you hold 
down SHIFr when making a ruler 
change to several selected 
paragraphs, the· change will be made 
only to paragraphs that h'ave the 
identical ruler settings as those in the 
first selected paragraph. Used in 
conjunction with Copy Ruler and 
Paste Ruler from the Edit menu, this 
feature can simplify formatting of 
complex documents. 
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Controlling Open Spacing 
in ParagraphS 

There's an easy way to control open 
spacing in paragraphs. Just add an 
extra space before the end of each 
paragraph, and then Subscript it. 
The more times you choose subscript, 
the larger the distance will be before 
the next paragraph starts. 

Control spacing from the top of a 
paragraph by adding a space at the 
beginning and then choosing to 
Superscript the space. 

Convert All Mac Write/Word 
Documents At Once 

To save time while translating 
MacWrite or Word documents to 
WriteNow, convert them all in a . 
single operation, rather than 
individually. The Translator has a 
Transfer to WriteNow option that, 
when selected, automatically opens 
WriteNow and all the documents 
which have just been translated. 

With Multiple Documents, 
Use Send Behind to Switch 
Windows 

When working with a lot of 
documents at once, it's handy to use 
the Send Behind command in the 
View menu to switch between 
windows. Even more interesting, if 
the windows have zoom boxes, you 
can use the size box to make each 
window very small and line them up 
along the bottom of the screen, using 
the zoom box to expand a window to 
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full size when you want to work with 
it. When you're finished with the 
document, use the zoom box again to 
shrink it back to its easy-to­
manipulate size. 

'ZBasic 
Easily Making Changes to 
Nonsequential Line 
Numbers 

If you're using the Edit window and 
make a number of changes to 
nonsequential line numbers, press · 
COMMAND-E twice and all lines and 
line numbers will be placed in their 
proper.locations. 
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TRADEMARK INFORMATION 

This book comments on ~any hardware and software products. Many of those 
products are identified by their trade names. In most eases, these designations 
are elaimed·as legally protected trademarks by the companies. which make the 
products. We have made every attempt to credit the appropriate manufacturer or 
publisher in the following list. It is not our intent to use any of these names 
generically, and the reader is cautioned to investigate a claimed trademark before 
using it for any purpose except to refer to the product to which is·attaehed. , . 

Airborne!"', Dark Castle•, and Paint Cutter•. are trademarks of Silicon Beach· 
Software, Incorporated; Apple~ is a registered trademark, and Alarm Clockw, 
AMAZing", AppleTalk•, Finderw ,. Font/DA Moverw, Hard Disk 20w, HFS~~ 
ImageWriterw, LaserWriter'rM, Laser Writer Plusw, Localizer•, MaeDraw•, 
MaePaintw, MacPaseal•, MaeProject111

, MaeTerminal•, MaeWrite211
, Mac/XLw, 

MiniFindet211
, ResEdit211

, Switcher211
, and Through The Looking Glass211 are tr~de­

marks of, and Macintosh~ is a registered trademark licensed to Apple Computer, 
Incorporated; BatteryPakw and DiskToolsw are trademarks of Batteries Inelu4ed; 
Bernoulli" Boxw_is a trademark of IOMEGA Corporation; Cliek0n211 and Write :, . 
Noww are trademarks ofT/Maker Company; ColorPrintw is a trademark ofEsoft 
Enterprises; CompuServe~ is a registered trademark of CompuServe Information 
Service; ConeertWarew is a trademark of the Concert Ware Group; Copy ll Hard 
Diskw, Copy II Mae• and MaeTools211 are trademarks of Central Point Software, 
Incorporated; Courier 2400w is a trademark ofUSRoboties; CrunCh~ is .a registered 
trademark of Crunch Software Corporation licensed to Paladin So~ ware 
Corporation; Deja Vu111 and Dinner At Eight211 are trademarks of Rubicon 
Publishing; Deluxe !'4usie Constr_uetion Setw is a trademark of Electronic Arts, 
Incorporated; Disklnfo~ is a trademark of Maltreya Design; Dollars and $ensew is 
a trademark ofTronix Publishing, Ineorporated;.ExperLispw is a trademark of 
ExperTelligenee; Fedit211 is a trademark of MacMaster Software; Fil~visionw is a 
trademark of Telos Software Products; 1st Basew and 1st Merge211 are tradema:rks 
of Template Systems, Incorporated; FONTastie211 is a trademark of Altsys 
Corporation; Hayden Spellerw and Sargon IIXW are trademarks 9f Hayden 
Software Company, Incorporated; Helixw is. a Q:ademark of Odesta Corporation; 
HFS Baekup211 is a trademar~ of Personal Computer Peripherals Corporation; 
HyperDrivew is· a trademark of General_Computer Company; IBM• is a registered 
trademark and PC-DOS'ZN is a trademark of International Business Machines 
Corporation; Jazzw is a tradema,rk of Lotus Development Corporation; Just Text211 

is a trademark~ of Knowledge Engineering; Mae240w is a trademark of White Pine 
Software, Incorporated; MaeA.dvantage UCSD Pasealw is a trademark of Sofl'eeh 
Mierosystems,.Ineorporated; ~c.Attaekw is a trademark of Miles Computing; 
MACBACJrM is a trademark of Peripheral Land; MaeCharliew is a t~demark of 
Dayna Communications; MaeDraft'rM is a· trademark of Innovative Data Design, 
Incorporated; MaeFortranw is a trademark of Absoft Corporation; MaeNifliesw , 
is a trademark of the Kette Group, Incorporated; MaeServewand XUServew are 



trademarks of Infosphere, Incorporated; MacSpell+ w and MacSpell Right• are 
trademarks of Creighton Develop.ment, Incorporated; MacTablet- is a trademark 
of Summagraphics Corporation; MacType- is a trademark of Palantir Software; 
MacU ser- is a trademark of Ziff-Davis Publishing Company; MegaForm• is a 
trademark of Megahaus Corporation; Microsoft~, MS-DOS~, Multiplan~, Chart-, 
File-, Flight Simulator•, Microsoft Fortran~, MicrOsoft Basic Compile~, Multiplan 
1.1~, Word-, Word 3.0111 and Works- are trademarks of Microsoft Corporation; 
MusicWorks• and Video Works• are trademarks ofMaeroMind; NEOW is a 
trademark of Kriya Systems, Incorporated; OvervtJEDI and OverVUE 2.1• are 
trademarks of Pro VUE Development Corporation; PageMaker- and PageMaker 
2.0- are trademarks of Aldus Corporation; Paradise MAC 10 & 20- are 
trademarks of Paradise Systems, Incorporated; PostScript• is a trademark of 
Adobe Systems, Incorporated; Rags to .Riches'DI is a trademark of Chang Labs; 
Ramstart• is a trademark of' George Nelson; Red Ryder'DI is a trademark·ofThe 
FreeSoft Company; SideKick~ is a registered trademark of Borland International, 
Incorporated; Smartcom I~ is a trademark of Hayes Microcomputer Products, 
Incorporated; Sound Cap• is a trademark of Fractal Software; Straight Talk• is a 
trademark of Dow Jones & Company, Incorporated; Tempo• is a trademark of 
Affinity Microsystems, Limited; ThinkTank•, More•, and More 1.1'111 are 
trademarks of Living Videotext, Incorporated; ThunderScan• is a trademark of 
Thunderware, Inoorporated; L Pascal• is a trademark of L Systems; 
TurboCharger111 is a trademark ofNevins Microsystems, Incorporated; tntima I~ 
is a trademark of Sierra On-Line, Incorporated; VAX~ is a registered trademark, 
and REGIS Graphics Editor•, and VMSW are trademarks of Digital Equipment 
Corporation;'VersaTerm• is a trademark of Peripherals, Supplies & Computers; 
WordStar" is a registered trademark ofMicroPro lnternational·Corporation; 
Ancient Art ofWar111 is a trademark of Broderbund; Cricket Draw- is a trademark 
of Cricket Software; Disk EXJ)ress111 is a trademark of Alsoft; Disk Top• is a 
trademark ofCE Software; Filemaker Plus111 is a trademark of Nashoba; Full 
Paint111 is a trademark of Ann Arbor Software; Graphics Works 1.1111 is a trademark 
ofMindScape; MaeGolr' is a trademark of Practical Computer Applications; Mac 
In Tax111 is a trademark of Soft View; MacMoney111·is a trademark of Survivor 
Software; Cyborg" is a trademark of A Company; Mac Publisher nr- is a 
trademark of Boston Software; Mae 3D111 and Mac 3D 2.0111 are trademarks of 
Challenger Software; Make Millions• is a trademark of Scarborough; MindWrite• 
is a trademark of MindWork Software; Packit IIr- is a trademark of Harry R. 
Chesley; Parameter Manager• is a trademark of SMS; Professional Composer111 is 
a trademark ofMark ofthe Unicorn; Quick & Dirty Utilities• Vol. 2 is a 
trademark of Dreams of the Phoenix; Ready, Set, Go! 2.1- and Ready Set Go! 3.0111 

are trademarks of Letraset; Rogu.ew is a trademark of Epyx; Shadowgate111 is a 
trademark ofMindscape; Studio Session• is a trademark ofBogas; SuperPaint• is 
a trademark of Silicon Beach Software; Wizardryw is a trademark of Sir Tech; 
Z Basic• is a trademark ofZedcor. 



Mao user 
Ziff-Davis Publishing Company 
One Park Avenue 
New York, NY 10016 
ISSN: 0884-0997 

The most 
comprehensive 
compilation of 
hints, tips and 
trouble-shooting 
routines for 
the Macintosh 
ever published! 
~ 

I~ 

~: 

1-f 

~ULK. KAII: 
U.S. POSTAGE 

PAID 
Ziff-Davis 
Publishing 
Company ''.1 

~ 
~~ 

MHAT 


